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1 Introduction

The document is designed for MELD administrators, graphic leads, and programmers to configure and maintain a MELD
project, SCO interfaces, and SCO source structure.

2 Administration

Login > Projects > Administration >

Administration

User Administration

Security Configuration Contract Number:

Menu Configuration Delivery Order Number:

External Types Admin Task Description: System Administration
Discipline

Administration

Add New Project

Delete Project

Site Settings
PKI Hits Report

Rework Administration

Change Password

Administration Screen

Administration is the central control area for MELD. Administration is where the MELD administrator will set up users,
create and assign users’ security levels, attach users to a project, create menus for each project, control security levels
for each module, and create new projects.
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2.1 User Administration

Login > Projects > Administration > User Administration >

Add User

POC Agreement Forms
Company/Command

Administration * A Privileged Access Agreement (PAA) must be submitted for MELD administrators.
* A System Authorization Access Request (SAAR) must be submitted for all accounts.

In accordance with DOD and Navy Information Assurance (IA)/Cybersecurity policies, please ensure required forms are
complete and on file prior to unlocking accounts, resetting passwords, or changing account permissions.

This is the central page for creating and managing users, and assigning them rights to various projects. To add a user, click on
the "Add User" option to the right.

A list of existing users is displayed below. You may modify their user rights and information by clicking on the edit button next
to each name:

[Show Enabled Only] [Show Inactive = 35 Days]

All user accounts are displayed below:

(view ]+ Js I (o ] (= I 0 B0 A< JC X - M (M L B e R

:54; di isabl ! i
admin ADMIN Account admin@email.com gﬁlgﬁon 4:54:50 lD'sa e] lDE ste Sesmns]
ga Graphic Artist ga@email.com g,li115/2021 3:47:00

:48: di ! isabl
qcr Quality Control qcr@email.com g£115/2021 3:48:59

User Administration - Main Screen

The main User Administration screen is the starting point for adding, editing, and deleting users. It lists all users
currently set up in MELD alphabetically by Last Name, then First Name. The list can be controlled by using the buttons
(View All, A-Z) along the top to limit the display by last name or show all names.

2.1.1 Agreement Forms

e DOD and Navy Information Assurance (IA)/Cybersecurity policies require the Privileged Access Agreement (PAA)
to be submitted by a MELD Administrator for all operating system administrator accounts and MELD application
administrator accounts.

e DOD and Navy Information Assurance (IA)/Cybersecurity policies require the System Authorization Access
Request (SAAR) to be submitted by a MELD Administrator for all MELD user accounts.

e DOD and Navy Information Assurance (IA)/Cybersecurity policies do not allow the user of temporary or
emergency user accounts.

e The established location for these agreement forms is located on the MELD web server within the MELD
application folder in a sub-folder titled “Agreement_Forms”. It is recommend to share this folder for easy access.

2.1.1.1 Agreement Form Downloads

To download the agreement form templates, use the following links:
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System Authorization Access Request (SAAR): Open the following web site and search for: SAAR Form
https://www.disa.mil/

Privileged Access Agreement (PAA): Open the following website and search for

5239 https://www.secnav.navy.mil/doni/NFOL/Forms/Allltems.aspx?Paged=TRUE&PagedPrev=TRUE&p SortBehavior=
0&p FileLeafRef=%5FSECNAV%5F5305%5F1%5F1814%2Epdf&p 1D=887&RootFolder=%2Fdoni%2FNFOL%2FSECNAV%2F
SECNAV%20Forms&PageFirstRow=601&&View=%7BB4E89F14-5AE1-4D83-B85E-
C63169BF9E34%7D#InplviewHashb4e89f14-5ae1-4d83-h85e-
¢63169bf9e34=RootFolder%3D%252Fdoni%252FNFOL%252FSECNAV%252FSECNAV%2520Forms

2.1.2 Add/Edit Users

2.1.2.1 Show Enabled Only

Show Enabled Only - filters the list of users to only those who are currently enabled on the system
Show All Users - shows all the users in the system

2.1.2.2 Show Inactive > 35 Days

Show Inactive - filters the list of users to only show those who have not logged into the system within the last 35 days.
Excluding the system account, accounts which have been inactive for more than 35 days will be disabled. The Last Access
field on this screen shows the last time each account has been successfully logged into.

2.1.2.3 Add a User

Open the PAA or SAAR agreement form located on the MELD web server within MELD\Agreement_Formes. If an
agreement form is not present then do not continue. MELD Administrators must have both a PAA and SAAR form.

To add a new user to MELD, click on the Add User link from the User Administration screen. The following screen will be
displayed.

Login > Projects > Administration > User Administration > Add/Edit Users >

Add/Edit Users

User Name: | |
PKI:
Email: |

First Name: |
Last Name:

Address:

Phone: (| D |-l | %
Title: | |
Company/Command:
System Admin:
Security Officer:
System Account:

Update User

The User Name will be used as a temporary password.

Add/Edit Users - Main Screen
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https://www.secnav.navy.mil/doni/NFOL/Forms/AllItems.aspx?Paged=TRUE&PagedPrev=TRUE&p_SortBehavior=0&p_FileLeafRef=%5FSECNAV%5F5305%5F1%5F1814%2Epdf&p_ID=887&RootFolder=%2Fdoni%2FNFOL%2FSECNAV%2FSECNAV%20Forms&PageFirstRow=601&&View=%7BB4E89F14-5AE1-4D83-B85E-C63169BF9E34%7D#InplviewHashb4e89f14-5ae1-4d83-b85e-c63169bf9e34=RootFolder%3D%252Fdoni%252FNFOL%252FSECNAV%252FSECNAV%2520Forms
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The following fields are available:

e User Name - This is the unique id given to the user. Many times this is a combination of their first initial and last
name. For example John Doe would be given a user name of jdoe.

e PKI-The user's unique PKI id if using CAC/ECA cards to access MELD, which is available on the PKI Site Hits

report. This is typically displayed on the back of the CAC/ECA card.

Email - the user's email address

First Name - the user's first name. On a PKI/PKE system this must match the information on their CAC/ECA

Last Name - the user's last name. On a PKI/PKE system, this must match the information on their CAC/ECA.

Address - the user's work address

Phone - the user's work phone number

Title - the user's title or rank (SME, ID, QC, PM, SGT, MJR, etc.)

Company/Command - A drop down listing the available company / commands to assign a user to.

System Admin - A system administrator will receive an email each time a user's account is changed or a new

account is added to the system.

e Security Officer - A security officer will receive an email each time a user's account is changed or a new account
is added to the system.

e System Account - The system account is an account used only by MELD, and cannot be used to log into the
system. It is usually your sites CMATT account. Only one system account is allowed per MELD instance, if an
account has already been set up, this field will not appear on the screen.

After entering in all the information, click the Update User button to create a new user. The user name will be the
temporary password for the new account.

An email notification for the new account will be sent to any MELD user assigned to a Security Officer or System Admin
(dropdown on MELD user form).

2.1.2.4 Edit a User

To edit an existing user, click the Edit button on the User Administration screen for the user you wish to edit. The Add
User screen will appear, along with the sections Add Permissions, User Discipline, and Commenting Permissions in the
screen below. Deleting any of these permission fields will end any current sessions the user has, requiring them to log
back into the system so the new permissions can take effect.

Open the PAA or SAAR agreement form located within MELD\Agreement_Forms. If an agreement form is not present
then do not continue. Ensure any permissions that are changed match the desired user role within the agreement
forms.
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Add Permissions User Discipline

Current Permissions: Current Disciplines:

Project Right Type
Sample Project Internal Subject Matter Expert (SME)

|Administratian V|| Government/External (4) V| | Graphic Department (ART) "|

Commenting Permissions

Rights Type [Project Delete/Add
Internal Acceptance - Rework [Sample Project]
| Internal Review [MELD Support Team] V| lﬁdd Commenting Rights]

Edit User - Permissions Section

An email notification for the edited account will be sent to any MELD user assigned to a Security Officer or System Admin
(dropdown on MELD user form).

2.1.2.5 Add Permissions

Permissions are used to determine what project(s) a user has rights to access, and their level of access inside the various
modules of that project. If the user has no permissions on a project, the project will not appear in the Project List of the
Project Selection Screen. For more information on permissions, see the Security Configuration section in this document.
To add permissions to a user, select the project from the left column dropdown and the rights type from the right side
dropdown. Then click the Add Rights to User button. The screen will be refreshed and it will show the new permissions.

An email notification for the new permission will be sent to any active MELD user assigned to a Security Officer or System
Admin (dropdown on MELD user form).

2.1.2.6 Delete Permissions

To delete the permissions from a user, click the corresponding Delete Permission button. The system will prompt for
confirmation of the delete with the following popup.

Microsoft Internet Explorer x|

@ You have choosen ko delete a record,  Are ywou sure?

Cancel

Record Deletion Confirmation
If the user selects OK, the permission will be deleted. Cancel will abort the deletion. If the user has any active sessions,

they will be logged out of MELD and required to log back in.

An email notification for the removed permission will be sent to any active MELD user assigned to a Security Officer or
System Admin (dropdown on MELD user form).
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2.1.2.7 User Discipline

A User Discipline is used to indicate what discipline(s) (SME, QC, PM, etc.) a user belongs to. This setting controls the
look and functionality of the interface during the online review and workflow processes. Disciplines are set up in the
Administration - Discipline Administration module, and assigned to a project in the Project Administration - Project
Discipline Administration module.

2.1.2.7.1 Add a User Discipline

To add a discipline to a user, select the discipline from the dropdown. Then click the Add Discipline button. The screen
will be refreshed and it will show the new discipline.

An email notification for the new discipline will be sent to any active MELD user assigned to a Security Officer or System
Admin (dropdown on MELD user form).

2.1.2.7.2 Delete a User Discipline

To delete a discipline from a user, click the corresponding Delete Discipline button. The system will prompt for
confirmation of the delete and the discipline will be deleted. If the user has any active sessions, they will be logged out
of MELD and required to log back in.

An email notification for the removed discipline will be sent to any active MELD user assigned to a Security Officer or
System Admin (dropdown on MELD user form).

2.1.2.8 Commenting Permissions

Commenting Permissions control the project(s) and level(s) of review a user has access to during the online review
process. Only one Commenting Permission level can be assigned to a user per project. For more information about how
the Commenting Permissions affects the online review, read section “Configure Comments Rights Types”. To add
permissions to a user, select the Rights Type from the dropdown. If there is no dropdown, the user already has
commenting permissions on all projects available. In this case, the current commenting permission must be deleted for
the project before a new one can be assigned. The project the rights type is attached to is shown inside the []'s in the
drop down. Click the Add Commenting Rights button. The screen will be refreshed and it will show the new permissions.
Note: When setting up Commenting Permissions, a user must also have regular Permissions to the project or they will
not be able to access the Online Review module to be commenting.

An email notification for the new commenting permission will be sent to any active MELD user assigned to a Security
Officer or System Admin (dropdown on MELD user form).

2.1.2.9 Delete Commenting Permissions

To delete the permissions from a user, click the corresponding Delete button. The system will prompt for confirmation
of the delete and the permission will be deleted. If the user has any active sessions, they will be logged out of MELD and
required to log back in.

An email notification for the removed commenting permission will be sent to any active MELD user assigned to a Security
Officer or System Admin (dropdown on MELD user form).

2.1.3 Delete a User

To delete a user from MELD, open the main User Administration screen, find the user, and click the Delete button on the
right hand side of the row. The system will prompt for confirmation of the delete and the permission will be deleted.
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Only users who have not made, completed, or verified a comment in online review can be deleted from the system, for
historical reporting purposes. To remove a user from the system who has participated in online review, use the disable
function.

Note: When deleting a user, this removes the user from the entire system, including all projects. To remove a user from
a specific project, delete their Permissions to the project. If the user is currently in the system, they will be logged out
and unable to log back in.

An email notification for the deleted user will be sent to any active MELD user assigned to a Security Officer or System
Admin (dropdown on MELD user form).

2.1.4 Disable / Enable a User

After a user has created, completed, or verified a comment in online review, their record needs to remain for reporting
purposes. To remove this user from the system, use the Disable function. This will remove all rights and disciplines,
change their email address to nolongerworks@Example.com, and assign a new randomized password to the account.
Commenting permissions need to be left assigned to the user for QUANTM purposes.

2.1.4.1 Manual Disable
To manually disable a user, locate the user account that will be removed and select the “Disable” button. Refer to
project personnel termination procedures to properly terminate the user from the system as well as archive the
agreement forms.

An email notification for the disabled user will be sent to any active MELD user assigned to a Security Officer or System
Admin (drop down on MELD user form).

2.1.4.2 Automatic Disable

A user will become automatically disabled after they login after an established period of inactivity. This period is typically
35 days. Refer to the MELD setup guide for specific site configuration.

2.1.4.3 Enable User

To reactivate / enable a user, follow the below process:

e Open the PAA or SAAR agreement form located within MELD\Agreement_Forms. If an agreement form is not
present then do not continue. MELD Administrators must have both a PAA and SAAR form.

e Locate the account record and select the “Edit” button.

e If the “Unlock” button is present, then select the “Unlock” button.

e Enter the correct email address.

e Assign permissions to reflect their intended use of the application within the agreement forms. Users with MELD
administrator permissions must have a PAA.

e Select the “Reset Password” link.

An email notification for the enabled user will be sent to any active MELD user assigned to a Security Officer or System
Admin (dropdown on MELD user form).
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2.1.5 Delete Sessions

Users are limited to two active MELD sessions at a time. On occasion, due to issues such as a computer or software
crash, or other unusual exiting from the website, an account may end up in a situation where it is recorded as having
two active sessions when it does not. This button will delete all active session records for the user from the database,
allowing them to log in again. If they do have a valid active session at the time, that session will be logged out during this
process.

2.1.6 Unlock

After 3 unsuccessful login attempts within a 15 minute time period, a user's account will be locked. Follow the below
procedure to unlock the account.

1. Open the PAA or SAAR agreement form located within MELD\Agreement_Forms. If an agreement form is not
present then do not continue. MELD Administrators must have both a PAA and SAAR form.
2. Locate the user. If the account is locked from entering an incorrect password more than 3 times then an
“Unlock” button is available
e Select the “Unlock” button
e Select the “Edit” button to edit the user record

e Select the “Reset Password” link

2.1.7 Reset Password

Passwords are encrypted and cannot be edited via the admin screens. To reset a user's password, edit the user's record
in Add/Edit User's and click the Reset Password link in the left hand menu bar. The password will be set to the user's
login id. They will be required to change it the next time they log in via the Change Password screen.

Open the PAA or SAAR agreement form located within MELD\Agreement_Forms. If an agreement form is not present
then do not continue. MELD Administrators must have both a PAA and SAAR form.

An email notification for the password reset will be sent to any active MELD user assigned to a Security Officer or System
Admin (dropdown on MELD user form).

2.1.8 POC Company/Command Administration

The Point of Contact Company/Command Administration screen allows the user to add, edit, and delete company and
command entries from the Company/Command dropdown on the Add/Edit User screen.
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Login > Projects > Administration > User Administration > POC Company/Command Administration >

To edit a Company or Command, make the changes to one record at a tin|

Company/Command
|Com pany 1 | External ¥ | | Submit Change| | Delete
|Com pany 2 | External ¥ | | Submit Change| | Delete

Add Company/Command:

Description: |
Internal fExternal: internal v
| Add Company/Command |

POC Company/Command Administration

2.1.8.1 Add a Company/Command

To add a new company or command name, type the information into the description field and click the Add
Company/Command button. The new company/command will be displayed on the screen and will be available in the
Company/Command dropdown data window on the Add/Edit User screen.

2.1.8.2 Edit a Company/Command

To edit a company or command, click on the company/command in the list. Alter the text and location as needed and
click the Submit Change button. The screen will be refreshed to display the updated information.

2.1.8.3 Delete a Company/Command

To delete a company or command, click on the Delete button on the corresponding row. The system will prompt for
confirmation of the delete, and then delete the record. Any users who are currently attached to that
company/command will have their company/command information removed.

2.1.9 Annual Account Review

An annual review, performed by a user with appropriate permissions, is required to review all MELD application
accounts to ensure only authorized users continue to access MELD. The review also ensures that all accounts are running
with their intended roles.

2.1.9.1 MELD Application Account Review Process
1. Locate all SAAR and PAA agreement forms within the established location: MELD\Agreement_Forms
2. Launch MELD and select the Administration project
e Select the User Administration module
e Select the Show Inactive > 35 Days button
e [finactive accounts are available, select the “Disable All Inactive Accounts” button
e Select the Show All Users button and then the Show Enabled Only button
e Select the View All button to return all enabled users
3. Foreach user listed above, follow the below process:
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e For MELD administrators, ensure a PAA and a SAAR agreement form exists
e For MELD users, ensure a SAAR agreement form exists
e Select the Edit button for each user and compare the MELD application permissions with the SAAR form.
Ensure the permissions authorized within MELD represent what was intended within the SAAR form.
4. For any accounts that do not contain an agreement form:
e Disable the account by selecting the “Disable” button
e Report the account to the ISSO
5. Forany accounts that are running without their intended roles:
e Adjust the permissions to included only the intended roles
6. Archive any agreement forms that currently do not have MELD accounts by moving to the “Archived” sub-folder.
7. Refer to project documentation to perform an operating system review for any MELD accounts that have also
had an operating system account created.

2.2 Security Configuration

Security Configuration is the main screen for the MELD Security module. From this screen the user can add/edit/delete
Modules, Rights Types, and link the two together to create security settings for each module in the application. Security
can be as minimal as desired, allowing every user into every module, or as strict as desired, putting strict limitations on
the areas a user can access. Before configuring Security, Modules and Rights Types must be created.

Login > Projects > Administration > Security Configuration >

Configure Security

Module This is the central page for setting up Security Levels
Administration

Rights Type

Configuration

Security Configuration Screen

2.2.1 Module Administration

Module Administration is the central location for adding, editing, and deleting modules for security purposes. This
screen does not affect the existence of a module. It is used to allow the user to set up a module, to limit access to it. Due
to the size of the security grid, it is recommend that only modules that need to have security levels assigned be set up in
Module Administration.

The IME - Curriculum Outline Movement,Renames, and the IME — Lock/UnLock SCO cannot be edited or deleted.
These modules are used within IME and cannot be altered.

Note: The default module setup is adequate for most MELD projects. Most projects would not need to modify or add
modules to this setup. Only experienced MELD administrators should modify this section.
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Description Path

Delete

Delete

Admin - Discipline Administration (Review) /MELD/review/disciplineadmin.asp Edit

Admin - Discipline By Project (Review) /MELD/review/disciplinebyproject.asp Edit

Admin - Menu Button Add/Edit /MELD/admin/configuration/editmenubutton.asp Edit

Admin - Menu Configuration /MELD/admin/configuration/default.asp Edit

Admin - Project Administration /MELD/Admin/default.asp Edit ||| Delete

Admin - User Administration (via MELD admin) /MELD/admin/usermanagement/default.asp Edit ||| Delete

Admin - User Administration (via project admin) /MELD/admin/usermanagement/byproject.asp Edit ||| Delete

Delete

Delete

Admin - Users Add/Edit (via MELD admin) /MELD/admin/usermanagement/edituser.asp Edit

Admin - Users Add/Edit (via project Admin) /MELD/admin/usermanagement/edituserbyproject.asp || edit

CMATT - Global CRs /MELD/CMATT_SNC/CR_inputForm_All.asp Edit

CMATT - Place in Work /MELD/CMATT_SNC/admin/begin_cycle.asp Edit

Delete

CMATT - Place in Work Refresh /MELD/CMATT_SNC/admin/begin_restart_cycle.asp Edit

CMATT - Update Pri, Complexity, IsValid CR Summary Page | /MELD/CMATT_SNC/_updateCRSummary.asp Edit

IME - Curriculum Outline Movement,Renames,and Deletion

IME - Lock / UnLock SCO

Issue Tracker /MELD/tracker/default.asp Edit ||| Delete

Delete

Delete

Delete

Issue Tracker - Edit Item /MELD/tracker/edit_item.asp Edit

QUANTM /MELD/QUANTM_SNC/default.asp Edit

HHd 78

RIMM /MELD/rimm/default.asp Edit

RIMM Edit Risk /MELD/rimm/editrisk.asp Edit

RIMM View Details /MELD/rimm/viewdetails.asp Edit

TS5R /MELD/TSSR/default.asp Edit

Workflow - Reports /MELD/workflow/reporting.asp Edit

Module Administration Screen

2.2.1.1 Add Module

To add a new module, click the Add Module link on the Module Configuration main screen. The following screen will be
displayed.

Legin > Projects > Administration > Security Configuration > Module Administration > Add/Edit Modules >

Add/Edit Modules

When creating the path for your module, your server information is /MELD. This information is placed in front of the folder/file name of
the asp file.

For Example, this module is located in the Admin directory and is called editModule.asp. Therefore path would be
J/MELD/Admin/editModule.asp.

NOTE: Path names are case sensitive, default.asp is not the same as Default.asp

Description:
Path:

Enter Data

Add/Edit Modules
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Description - Enter a short but specific title for the module. For example, EVALs Admin is more useful than just EVALs.
Also note that the modules are sorted by description on the Configure Security grid, so group modules together by
description. IE RIMM Admin, RIMM Add/Edit is better than RIMM Admin and Add/Edit RIMM.

Path - Path is the path to the actual asp file that controls the module. This is determined by the name of the server,
which is listed in the informational section of the Add/Edit screen, combined with the directory and file structure of the
asp file. The path can also be found on the address bar of MELD.

& C | O localhost/MELD/TSSR/default.asp
Sample Module Path

The path for TSSR module is shown above. When a path does not end in *.asp, for example when on the main Online
Review screen /MELD/Review/ is displayed in the address bar, end the path with default.asp. To save the new module
record, click the Enter Data button

Note: Path names are case sensitive and must be entered exactly as they will appear in the address bar of the browser.

2.2.1.2 Edit Module

To edit a module, on the Module Administration screen click on the edit button for the corresponding module.
Edit the Description and Path information as needed, and click the Enter Data button to save. To abort any changes, click
the back button on the browser.

2.2.1.3 Delete Module

To delete a Module, on the Module Administration screen click on the Delete button for the corresponding Module. The
system will ask for confirmation of the delete, and then delete the Module and any associated security settings.

2.2.2 Rights Type Configuration

The Rights Type screen is the main screen for adding, editing, and deleting Rights for MELD Security. Rights are the
security levels a user can be assigned to. The main screen for rights, the Rights Type Configuration screen, lists all
available Rights. The MELD Admin and Project Admin (names may have been changed) rights types cannot be edited or
deleted.

Note: The default rights type setup is adequate for most MELD projects. Most projects would not need to modify or
add modules to this setup. Only experienced MELD administrators should modify this section.
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Login > Projects > Administration > Security Configuration > Rights Type Configuration >

Add Rights Type
This is the central page for Rights Type setup.

Government/External Edit Delete

Internal Edit Delete
Internal {Curriculum Outline Edits) | edit Delete

MELD Admin

8000E
BaEEE

Project Admin

Rights Type Configuration - Main Screen

2.2.2.1 Add Rights Type
To create a new Rights Type, click on the Add Rights Type link on the Rights Type Configuration screen.

Login > Projects > Administration > Security Configuration > Rights Type Configuration >

Rights Type

Description:

Enter Data

Rights Type Configuration - Add/Edit Rights Type

Description - A description of the Rights Type. The preferred format for the description is the module name then the
activity being performed. For Example RIMM Edit or Lesson Review columns will be sorted alphabetically on the Security
screen by Rights Type; therefore logical groupings should be created.

Click the Enter Data button to save the new Rights Type. Use the browsers back button to abort any changes.

2.2.2.2 Edit Rights Type
To Edit a Rights Type, click on the Edit button of the corresponding Rights Type. The Rights Type screen will be displayed.

Click the Enter Data button to save the altered Rights Type. Use the browsers back button to abort any changes.

2.2.2.3 Delete Rights Type

To delete a Rights Type, on the Rights Type Configuration screen click on the Delete button for the corresponding Rights
Type. The system will ask for confirmation of the delete, and then delete the Rights Type and any associated security
settings.
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2.2.3 Configure Security

Configure Security is the main screen for the security setup. This screen is a grid listing all the modules that have been
set up in the left hand column, and the rights types that have been created across the top. A checkmark, or security
level, is a combination of module and rights type. A module without any checkmarks, or a module that has not been set
up via the Module Administration screen, is available to all users who have a MELD login and access to the project(s)
that contains the module. Access to the module is limited by checking one or more security levels. If a security level is
checked, only users with that rights type for the current project can access the module. It is recommended that MELD
Admin and Project Admin have access to all modules that have security settings, to prevent accidentally locking the
users out of a module and being unable to go back and unlock that module.

Caution: Ensure the MELD Admin is checked for each module in the security listing. This allows the MELD Admin the
opportunity to fix any problems created by incorrect or overly restrictive security settings.

Government / External Internal Internal (Curriculum Outline Edits) MELD Admin Project Admin

Admin - Discipline Administration (Review) O O O ] ]
Admin - Discipline By Project (Review) O O O
Admin - Menu Button Add/Edit )] ] [l
Admin - Menu Configuration [l I [l
Admin - Project Administration [l | [l
Admin - User Administration (via MELD admin) [l | [l
Admin - User Administration (via project admin) [l I [l
Admin - Users Add/Edit (via MELD admin) [l | [l
Admin - Users Add/Edit {via project Admin) O O O

MELD Admin Project Admin
CMATT - Global CRs [l | [l
CMATT - Place in Work O O O
CMATT - Place in Work Refresh O O O
CMATT - Update Pri, Complexity, IsValid CR Summary Page O O O
IME - Curriculum Outline Movement,Renames,and Deletion [l |
IME - Lock / UnLock SCO ] O ]
Issue Tracker )]
Issue Tracker - Edit Item )]
QUANTM ]
RIMM O

Internal Internal {Curriculum Outline Edits) MELD Admin Project Admin

RIMM Edit Risk 0
RIMM View Details 0
TsSR O
Workflow - Reports [l

[ Submit Security] [ Cancel ]

Configure Security Screen

Note: You MUST click the Submit Security button at the bottom of the screen to save your changes.

2.3 Menu Configuration

The Menu Configuration module allows the user to add, edit, or delete menus from the main Project menu screen. To
adhere to basic GUI standards, it is recommended that the text on the menu buttons match the title of the
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corresponding module. When a menu option is deleted, the button no longer is displayed on the Project menu screen;
however, the directory and files for the module remain.

To see a list of existing menus, select the project from the drop down data window on the first page.
The screen will refresh and display a list of available menus for the project. Included in the display is:

e Project Name - The project the menu is attached to

e Title - The text that will be displayed on the button in the menu bar

e Location - The asp file or directory that the menu button will access. If a file name is not specified, the menu
runs the default.asp file in the directory named. The root directory for the Location path is the MELD directory.

e Sequence - The order the menu item will appear in the menu bar. It is suggested that when first setting up
menus, these numbers be organized in large increments, for example 1, 10, 20, 30, 40, etc. This will allow the
insertion of other menu items at a later date without forcing the user to renumber all the menu items.

e Edit and Delete Buttons - Allows the user to edit or delete a menu item.

Add a Menu Button

LULPAS NS U This is the central page for creating and modifying project menu buttons.

To see a given project's menu button options, select a project:

v

Project Name Title Location Sequence

E-2D CMATT Jcmatt_snc/default.asp 60
E-2D Workflow Jworkflow/default.asp 80
E-2D Online Review |./review/default.asp 170
E-2D COI Editor  |COIEditor.asp 200
E-2D TSSR JTSSR/default.asp 225
E-2D QUANTM JQUANTM_SNC/default.asp |235
E-2D Calendar Jcalendar/default.asp 250
E-2D Contact List  |./POC/default.asp 300
E-2D EPSS /MELD/EPSS/default.asp  [350 [ edt || | elete |

Menu Configuration - Menu List

2.3.1 Add a Menu Button

To add a new menu button, click on the Add a Menu Button option on the Menu Configuration screen. The Add/Edit a
Menu Button screen will be displayed.

Note: All the main modules are available to Add / Remove from the Project Administration>Modify Project screen.
Most projects would not typically add a menu button within this area.
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Login > Projects > Administration > Menu Configuration >

Add/Edit a Menu Button

Project: | Administration v

Menu Button Title: |Custom Menu

Link Location: |./Lessons/CDs/

Sequence: 22 |

Enter Data

Add/Edit a Menu Button

The following fields are available:

e Project - Select the project for the new menu button

¢ Menu Button Title - Enter a title for the button

e Link Location - The asp file, directory, or URL that the menu button will access. The root directory for the
Location path is the MELD directory. Enter the location with a ./ beginning such as ./Admin/default.asp. For an
outside website enter the full path, i.e. http://www.google.com

e Sequence - Enter a sequence number. It is suggested that when first setting up menus these numbers be
organized in large increments, for example 10, 20, 30, 40, etc. to allow for later menu item insertion.

After all data has been entered click the Enter Data to save the new menu item.

Any menu item added that is not a supported module will appear in the menu with a peach asterisk. This allows the
menu item to stand out from the supported modules.

IME

Points of Contact
Custom Menu *
Reports *
Deliverables *
RIMM

TSSR

Issue Tracker
Change Password
My Profile

Project Administration

2.3.2 Edit a Menu Button

To edit a menu button, click on the corresponding Edit button from the Menu Configuration menu list. The Add/Edit a
Menu Button screen will be displayed. Edit the necessary information and click the Enter Data button to save the
changes. NOTE: Editing the Project creates a new record; see the next section for more information. To abort the
changes, use the back button on the browser to return to the Menu Configuration screen.
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2.3.3 Duplicate a Menu Button

Menu Buttons can be duplicated from one project to another, to prevent the user from having to re-enter the
information when setting up a new project. To duplicate a button, choose the project that contains the menu button
from the project selection drop down on the Menu Configuration screen. Click on Edit for the menu button. On the
Add/Edit a Menu Button screen, change the project to the target project. Make any other changes necessary and click
on the Enter Data button to save the new button.

2.3.4 Delete a Menu Button

To delete a button, choose the project that contains the menu button from the project selection drop down on the
Menu Configuration screen. Click on the Delete button for the corresponding menu button. The system will ask for
confirmation of the delete, and then delete the menu button.

2.3.5 Add/Edit Sub Menus

The add/edit sub menus module has similar functionality and screens as the main menu configuration modules.
However, the main menu configuration module only affects menu options when the user first enters the project. The
sub menus are menu options that appear in the various modules of that project, such as Workflow, CMATT, Review, etc.
This function allows sites to add custom menu options to their modules, without running the risk of those menu options
being overwritten by future updates. All sub-menus will appear with a peach asterisk to allow them to stand-out from
the supported menu items.

Login > Projects > AV-8B Curriculum Revision and Maintenance > EPSS >
References

Job Aids

Control Documents

Instructor Guided
Reviews ¥

Accepted Courseware
*

Custom Sub Menu

To add a sub menu click the Add a Sub Menu Button option in the left hand menu navigation links. To edit an existing
module menu, select the project from the drop down then click Edit for the menu item you wish to edit. The Add/Edit a
Sub Menu Button page will be displayed.
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Add/Edit a Sub-Menu Button

Project ID - Selecting the Administration project will make the sub-menu button a global button for all projects

Page - the URL for the page the sub-menu link will appear on, EX /MELD/cmatt_snc/default.asp

Menu Title - The title for the menu option

URL - the url for the link, EX using the above Page example, report.asp would access the report at /MELD/cmatt_snc/report.asp
../report.asp would access the file at /MELD/report.asp

Sort - The sort order for the sub-menu items, all sub-menus will appear below the standard menu items.

Page: |/MELD/EPSS/default.asp

Menu Title: |[Instructor Guided Reviews
URL: |/MELD/avEE_EPPS_sub_menu/quided_review/default.asp
Sort: |1 |

Enter Data

Add/Edit a Sub-Menu Button

To save the changes click Enter Data. To abort, use the navigation menu to return to the previous screen.

2.4 Discipline Administration

User Disciplines are used in the Online Review to control the display and status of comments. For example, if a comment
has been assigned to a discipline, only users who are also assigned to that discipline can check off the addressed field for
the comment. The internal user can filter comments by discipline to reduce the entries on the screen. Reports can also
be run filtered by discipline.

2.4.1 Add a Discipline

To add a new Discipline, select Add A New Discipline from the discipline drop down and click on Add/Edit. The Discipline
Name, QC Discipline, and Save button will appear.

Login > Projects > Administration > Discipline Administration >

This is the screen where you will add, edit, and delete disciplines.

| Graphic Artist v| | add/edit | | elete |

Discipline Name: |Graphic Artist

Save

Discipline Administration - Add a Discipline

Discipline Name - the name of the discipline, such as Subject Matter Expert (SME)

Save - Click the save button to save the new record.

2.4.2 Edit a Discipline

To edit a Discipline, select the Discipline from the drop down and click on Add/Edit. The Discipline Name, QC Discipline
and Save button will appear. Edit the data as needed, and click the Save button.
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2.4.3 Delete a Discipline

To delete a Discipline, select the Discipline from the drop down. Once the discipline has been selected, the Delete
button will appear. Click on the button and the record will be deleted.

Note: if a discipline has been assigned to a project, the delete button will not be available.
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2.5 Add a Project

To create a new project, open Administration - Add Project.

Login > Projects > Administration > Add Project >

Project Name: |

Copy Project

Project Code: |

Charge Code:[ |

Description:

Delivery Order: | \
Contract Number: | \
Parent Project: | No Parent Project Selected Or Needed v |

Standard Module Title Sequence Add

Contact List 10
Resources 30 (]
CMATT 60 O
Workflow 80 ]
RIMM 100 O
QUANTM 120 (]
Issue Tracker 130 O
Calendar 140 ]
Online Review 170 O
TSSR 190 O
CR Review 210 (]
EPSS 250 O

Create Project

Add Project Screen

The following fields are available:

e Project Name - The name of the project, this will be displayed in the header section throughout MELD.
e Project Code - The code for the project, can be the same as the name or different.

e Description - A description of the project.

e Delivery Order - The delivery order for the project.

e Contract Number - The contract number for the project.

e Parent Project - If desired, the newly created project will be created as a child of the selected project.

Standard Modules — The bottom of the screen contains a list of standard modules. By checking the Add checkbox, a
menu option will be created for that module for the project. Other menu options can be set up using the Menu
Configuration module within the Administration project.
After entering all the necessary information, click on the Create Project button to save the new project.
Following the remaining steps to setup the new project:

1. Give yourself MELD Admin permissions to the new project using the User Management module within the

Administration project. This will allow access to the new project.
2. Setup Comments Rights: Navigate to the new project and select the Project Administration module.
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a. Select “Configure Comments Rights Type” from the drop down menu and follow section Configure
Comments Rights Types to add commenting rights to the project.

b. Navigate back to the Administration project and select the User Management module. Locate the
CMATT external reviewer account. This may be titled “ExXtCMATT” in newer installations. If an ExtCMATT
account is not available, refer to any existing projects and locate a generic external account. Grant this
external account, external commenting permissions for the new project.

3. Setup Project Disciplines: Navigate to the new project and select the Project Administration module. Select
“Project Discipline Administration” from the drop down menu and select the Add button for each discipline
needed for the new project.

4. Configure CMATT: Navigate to the new project and select the Project Administration module. Select Configure
CMATT from the drop down menu.

a. Select Project Setup from the left menu.

i. Select the external user account that was updated in the above step to have external
commenting rights. This external account allows the change requests to transfer from CMATT to
Online Review.
b. Select Complexities Administration from the left menu. Enter the following complexities.

i. ASimple
ii. B Basic
iii. CMedium
iv. D High
v. EVery High

5. Configure Workflow: Navigate to the new project and select the Project Administration module. Select
Configure Workflow from the drop down menu.

a. Select Copy Process from the left menu.

b. Select an existing Lesson Revision process from another project and then select the Copy button.

c. Rename the process and click Save.

d. Select Create Activities for a Process and verify each step has a discipline assigned. If a discipline used in
the original process was not added to the new project then the activity will have an unassigned
discipline. Select an appropriate discipline for any missing assignments.

e. Select Create Charge Codes and Create Project Tags to enter desired values. If the project will produce
new production courseware, a project tag that matches the text “Prod”, e.g. “Production” is necessary
for QUANTM 6 Sigma reporting.

6. User Administration: Navigate to the User Administration module within the Administration project and add
permissions and commenting permissions to the new project for all necessary users.

Note: The above setups the basic modules used for courseware development and review. For additional information
refer to documentation for each module.

2.5.1 Copy Project

Copy Project allows a MELD administrator to create a new project record with the same project settings, users, menu
items, and commenting permissions as the project being copied. Copy Project does not copy curriculum data.

Project Name: | |
Project to Copy: [PCATEST v|

Copy Project

Project Name: Enter the name of the new project

Project to Copy: Select the project you wish to copy from the drop down
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Click Copy Project.
The following information is copied to the new project:

CMATT Administration>Project Setup values

CMATT Administration>Priorities

CMATT Administration>Complexities

Project Administration>User Management>User Permissions and Commenting Permissions for all users assigned
to the original project.

Project Menu (modules)

Project Administration>Comments Rights Type Configuration
Project Administration>Group Permissions

Project Administration>Project Discipline Administration
Project Administration>Configure Lookups

Project Administration>Workflow Admin> Charge Codes
Project Administration>Workflow Admin> Project Tags
Project Administration>Workflow Admin>External Types

2.6 External Types Administration

This is the screen used to set up External Types for the Workflow module.

Login > Projects > Administration > External Types Administration >

This is the screen where you will add, edit, and delete external types.

External Type Name: [rroc

Save

External Types Edit Screen

To add a new external type select Add a new External Type from the drop down and click the Add/Edit button. Enter the
External Type Name and click Save.

To edit an existing external type, select it from the drop down and click Add/Edit, make the required changes and click
Save.

To delete an External Type click the Delete button.

2.7 Rework Administration

Each MELD installation comes with a set of standardized, pre-loaded, Rework Codes.

1 - Technical Inaccuracy B - Hardcopy (Paper) Graphic

A - Graphic _ S _ 1 - Nonstandard Labeling
1 - Animation depicting inaccurate procedure/ action 2 - Incorrect Color
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2 - Incorrectly displayed
3 - Incorrectly highlighted
4 - Digital Format Display in error (project specific)
5 - Classification Inaccurate
6 - Classification Missing
B - Navigation
1 - Incorrect (Doesn't match req'd action)
2 - Inappropriate (doesn't match SG)
3 - Unclear (Needs additional information / expansion
4 - Missing
C - Audio
1 - Information stated incorrectly
2 - Doesn't match text when it's supposed to
D - Text
1 - Text information inaccurate
2 - Remediation/feedback incorrect/inaccurate
2 - Functional Errors
A - Links
1 - References not linked
2 - Incorrect references linked
3 - Inappropriately branched
B - Navigation
1 - Interface incomplete/ missing functions
2 - Functions don't work correctly
3 - Navigation Bar doesn't work
4 - Menu buttons don't work
C - Graphics/Sound
1 - AVIs/ videos animations / don't play
2 - Poor / inconsistent quality
3 - Animation plays too fast/slow
D - Text
1 - Overlapping
2 - Showing through to overlaying layers
3 - Writing/Editorial Errors
A - Hardcopy (Paper) Text
1 - Spelling
2 - Grammar/ Punctuation
3 - Poorly written (unclear)
B - Hardcopy (Paper) Graphic
1 - Spelling
2 - Grammar/ Punctuation
3 - Poorly written (unclear)
C - Onscreen Text
1 - Spelling
2 - Grammar/ Punctuation
3 - Poorly written (unclear)
D - Onscreen Graphic
1 - Spelling
2 - Grammar/ Punctuation

3 - Poorly written (unclear)
4 - Format Errors

A - Hardcopy (Paper) Text
1 - Spacing
2 - Font size/color
3 - Bullets
4 - Titles Inaccurate / Missing
5 - Missing Text
6 - ILG text does not match on-screen

3 - Poor Quality

4 - Missing Graphic

5 - Missing Graphic Text

6 - Graphic text does not match onscreen
C - Onscreen Text

1 - Spacing

2 - Font size/color

3 - Bullets

4 - Titles Inaccurate / Missing

5 - Missing Onscreen text

6 - Onscreen text does not match graphic
D - Onscreen Graphic/Audio

1 - Nonstandard Labeling

2 - Incorrect Color

3 - Highlight wrong color

4 - Poor Quality Graphic

5 - Poor Quality Audio

6 - Missing Graphic

7 - Missing Audio

5 - Instructional Integrity Errors

A - Hardcopy (Paper) Text
1 - New concepts/ acronyms not defined/explained
2 - Test question does not test LO
3 - Test question content is not covered in lesson content
4 - No question for specific LO
5 - Answer Sheet incorrect
B - Hardcopy (Paper) Graphic
1 - Graphic fails to adequately illustrate content
2 - Graphic inappropriately gives answer to question
C - Onscreen Text
1 - New concepts/ acronyms not defined/explained
2 - Practice/end of lesson/SCO question does not test LO
3 - Question content is not covered in lesson/SCO content
4 - Remediation/feedback not related to question
5 - Feedback and / or answer are incorrect
6 - No question for specific LO
7 - Lesson Test doesn't score correctly
D - Onscreen Graphic/Audio
1 - Graphic fails to adequately illustrate content
2 - Graphic inappropriately gives answer to question

6 - Quality Assurance Errors

A - Self-check Error
1 - Missed Error
2 - Induced Error
B - Reviewer Error
1 - Missed Error
2 - Induced Error

7 - Customer Induced Rework/Externally Required Modification

A - Data Change
1 - Inaccurate GFI

2 - TPOC generated information different from GFI (after the fact)

3 - Technical System change (ECP/Tech Pub change)
B - Specification Change
1 - Change in Scope
2 - Change in Previously Approved Flow / Organization
3 - Change in Format/Specification Requirement
C - Preference
1 - Expressed Preference
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D - Other
1 - Not Defined

Standard Rework Codes

Additional custom codes can be added through the Rework Administration > Configure Rework screens. Only custom
codes can be added, edited, and deleted.

Login > Projects > Administration > Rework Administration >

Rework Listing Configure Rework Tvpe

This is the screen where you will add Rework Types.

Add A New Rework Type v

Description: |Lesson Plan | Code:

Configure Rework Type

To add a new Rework Type, click on Add Type, enter the description and Code, and click Save.

To edit a custom Rework Type, select it from the drop down, click Edit, change the Description and Code as needed, then
click Save.

To add/edit the Rework Category or Code for a Rework Type, select the Type from the drop down and click Add/Edit
Rework Category.

Login > Projects > Administration > Rework Administration > Rework Category >

Configure Rework Category

This is the screen where you will add Rework Categories.

Add A Mew Rework Category ¥

Description: [objectives | Code:

Configure Rework Category

To add a new Rework Category, click on Add Category, enter the description and Code, and click Save.

To edit a custom Rework Category, select it from the drop down, click Edit, change the Description and Code as needed,
then click Save.

To add/edit the Rework Code for a Rework Category, select the Category from the drop down and click Add/Edit Rework
Code.
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Login > Projects > Administration > Rework Administration > Rework Category > Rework Code >

Configure Rework Code

This is the screen where you will add Rework Codes.

Add A MNew Rework Code ¥

Description: [speliing | Code:

Configure Rework Code

To add a new Rework Code, click on Add Code, enter the description and Code, and click Save
To edit a custom Rework Code, select it from the drop down, click Edit, change the Description and Code as needed,
then click Save.

2.8 PKI Hits Report

The PKI Hits Report is used to capture the CAC/ECA information for each user that makes an unsuccessful attempt to log
into MELD using their CAC or ECA credentials. This information can be used to set up the user in User Administration for
automatic logging into the MELD site. For users that cannot login successfully with their CAC, copy the id listed within
the CAC/ECA Information column to the PKI field in the Edit User form within the User Administration module for the
Administration project.

First Name | Last Name | Hit Date ~ CAC/ECA Information
KADI THINGVALL | 8/26/2013 9:47:45 AM 123456789
CHRISTOPHER | BLASCHAK | 7/15/2013 10:21:11 AM | 123456789
JOSEPH BRADFIELD | 7/15/2013 8:50:01 AM 123456789
MARK LEWIS 7/12/2013 8:24:47 AM 123456789
PETER DITULLIO 7/12/2013 7:03:31 AM 123456789
RICHARD HIATT 7/12/2013 6:41:56 AM 123456789
JOHN SCHAFER 7/12/2013 6:38:29 AM 123456789

3 Project Administration

This is the central location for managing users and specific project modules. Each link in the left hand menu will take the
user to separate section of the Project Administration.
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Login > Projects > MELD Support Team > Project Administration >

Configure Comments Rights Types
Configure Group Permissions
Configure Lookups

Configure Resource Page
Configure RIMM Module
Configure TSSR

Configure Workflow

Configure CMATT

Issue Tracker Configuration

Modify Project

Project Discipline Administration
User Administration

This is the central location for man
and administering the MELD Suppd

Project Administration

3.1 Configure Comments Rights Types

Comment Rights Types are the review and approval levels for Online Review. Each project may have a unique set of
Comment Rights Types. These must be set up and assigned to users before the Online Review module can be used.
When first entering the screen, a setup wizard is displayed. Enter the desired number of external reviewer approval
levels. This is typically only one or two levels. Next select Submit and these approval levels are automatically created.
The comments rights type setup is now complete. You do not need to edit these types unless a new description / name
is desired.

Login > Projects > MELD Support Team > Project Administration > Comments Rights Type Configuration >

Edit Comment Rights
Type
This is the central page for Comment Rights Type setup.

The project has 0 external comment right types.

To change the number of comment right types, enter the number of external review levels in the box below.

NOTE: if the new number is lower than the existing number, all users assigned to a higher right type level will need to be re-
assigned a new level in user management.

External Comment Right Types: [ ]

Comments Rights Type Configuration Wizard

To edit comments rights type that were created by the wizard or manually created by a project administrator, click on
the Edit Comments Rights Type menu item. The Comments Rights Type Configuration screen is displayed.

To delete a record, click on the Delete button. The user is prompted to confirm the deletion. Upon confirmation, the
record is deleted. Note: The Delete button will become disabled when a commenting right is assigned to a user.
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Add Comment Rights
Type

This is the central page for Comment Rights Type setup.

Description (Value)
Internal (0)

External 1 (1)
External 2 (2)

Comments Rights Type Configuration

3.1.1 Add/Edit Comment Rights Types

Comment Rights Types consist of four pieces of information.
Description - A description of the Comment Rights Type.

Value - A numeric value for the review/approval level. This value reflects the position in the review process of the right
type.

The SCO approval level lifecycle is defined below.

1. When a SCO enters Online Review, either by initial creation in IME or when a user passes a workflow activity
with the “Enable Work” option selected, the value starts at “-1”. All internal users will have permissions to
comment on the SCO within Online Review.

2. When a user passes the workflow activity with the “External Customer Notification / Release” option selected,
the SCO approval level gets assigned “0” and is made available on the customer online review page. Only users
with a higher approval level (customer review) can comment on the SCO at this point.

3. Single Customer Review:

a. When the customer approves the SCO within online review, the SCO approval level changes to “1” and
the SCO is no longer available for commenting.

b. When the customer rejects the SCO within online review, the SCO approval will change back to -1. This
will allow the approval level to be set back to “In work” status and commenting is now available for
internal users.

4. Multiple Customer Review:

a. When the first customer approves the SCO within online review, the SCO approval level changes to “1”.
At this point the SCO is only available for customer commenting for the second customer review.

Note: “Accept” is the only option for first level customer reviewers.

b. When the second customer approves the SCO within online review, the SCO approval level changes to
“2”. At this point, the SCO is not available for commenting.

c. When the second customer rejects the SCO within online review, the SCO approval will change back to -
1. This will allow the approval level to be set back to “In work” status and commenting is now available
for internal users.

Note: If the first customer reviewer is not available or not needed, the second customer reviewer can approve the
SCO as they typically would do.

5. When a user passes the workflow activity with the “Disable Work” option selected, the approval level is set to 2

for single customer review and 3 for multiple; the SCO is locked in IME and removed from all online review

pages.
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Location - Internal or external, this value indicates if the reviewer will be an internal user or external (Gov) user.
SCO Approval - Indicates whether users with this comment right type have the ability to approve or respond to SCOs.

Rework Selection - Indicates whether users with this comment right type have the ability to enter or edit the rework
information for a comment.

Add or Edit the data as needed, and click on the Enter Data button to save the information.

3.1.2 Workflow Assign/Reassign

The ability to assign/reassign an item in workflow to a specific person is controlled by the description entered in the
Comments Rights Type. To turn off this assign/reassign functionality, put "no reassign", with or without capital letters, in
the Comments Rights Type description field.

3.1.3 New Project

When a new project is created in MELD this module will contain no commenting rights.

Login > Projects > Final Project By Melanie > Project Administration > Comments Rights Type Configuration >

Add Comment Rights
Type

This is the central page for Comment Rights Type setup.
Description (Value)
Mo Comments Rights Types in Database

New rights will need to be created by following the below steps.

1. Create Internal Acceptance right.
a. Description: Enter “Internal Acceptance”, “Internal Review”, or similar text.
Value: Enter: 0
Location: Internal
SCO Approval: False
Rework Selection: True

PaoyT

Comments Rights Type

Description: |Internal Acceptance
Value: |0

Location: |Internal /|

SCO Approval: False v
Rework Selection: Trus v

Enter Data
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Determine the number of sequential customer reviews. This will most likely be a single customer review or 2
customer reviews.

a. For asingle customer review:
i. Description: Enter “Customer Acceptance”, “Government Review”, or similar text.
ii. Value: Enter 1
iii. Location: External
iv. SCO Approval: True
v. Rework Selection: False

Comments Rights Type

Description: |[Customer Acceptance
Value: |1

Location: |External V|

SCO Approval: Trus v
Rework Selection: |False v

Enter Data

b. For multiple customer reviews:
i. Description: Enter “Customer Acceptance Initial”, “Government Review Initial”, or similar text.
ii. Value: Enter: 1
iii. Location: External
iv. SCO Approval: True
v. Rework Selection: False

Comments Rights Type

Description: |mer Acceptance Initial
Value: |1

Location: |External V|

SCO Approval: Trus v
Rework Selection: |False v

Enter Data

vi. Description: Enter “Customer Acceptance Final”, “Government Review Final”, or similar text.
vii. Value: Enter: 2

viii. Location: External
ix. SCO Approval: True
Xx. Rework Selection: False
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Comments Rights Type

Description: [omer Acceptance Final
Value: |2

Location: |External V|

SCO Approval: Truz v
Rework Selection: |False v

Enter Data

3.2 Configure Group Permissions

Group Permissions allow the administrator to grant a group of permissions to a user, instead of having to attach each
discipline and rights type individually. After users are set up with permissions groups, it will also allow the administrator
the ability to change the permissions of an entire group of individuals all at once, by changing the permissions group,
instead of having to edit each individual user’s record.

3.2.1 Add Group Permissions
Add Permissions Group

Description: | |

mave

Add Permissions Group

To create a new Permissions Group on the Configure Group Permission screen, click the Add Permissions Group menu
item. Enter a description for the new group and click the Save button.

3.2.2 Edit Group Permissions

To edit a Group Permission, on the Configure Group Permission screen click the corresponding Edit button.
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Mew Permission Group

No Disciplines i

Internal Edit
Internal Review

Edit Permissions Group
Description: To change the description of the permissions group, alter the Description field and click the Save button.

Disciplines: Each Discipline available to the project is displayed in either the left or right box, depending on if it has been
attached to the group. To add a value to a permissions group, select the value from the list on the left and add it to the
list on the right using the >> button. To remove a value from a permissions group, select it from the list on the right and
remove it using the << button. When a value is added and removed from a permission group, the group is updated as
soon as the << or >> button is clicked.

Rights Type: Each Rights Type available to the project is displayed in either the left or right box, depending on if it has
been attached to the group. To add a value to a permissions group, select the value from the list on the left and add it to
the list on the right using the >> button. To remove a value from a permissions group, select it from the list on the right
and remove it using the << button. When a value is added and removed from a permission group, the group is updated
as soon as the << or >> button is clicked.
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3.3 Configure Lookups

Lookup Type

Issue Effects

Issue Tracker - Status Categories

RIMM Control Type

RIMM Risk - Combined Levels

RIMM Risk - Probability

RIMM Risk - Severity

RIMM Risk Areas

RIMM Risk Results

Configure Lookups
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Administration Select a Project

KC-130J_Pilot EAC R and M
MATSS Cherry Point

K.C-130J Pilot R and M
KC-130J Crewmaster R and M

List Order Description Control

Not Selected: A value has not yet been selected
from those available

Low Likelihood

Likely

Highly Likely

2K 2L 2| 2]]|€£ 2>
O[] 22| [€>

Near Certainty

Configure Lookups — Management Screen

3.3.1 Copy Lookup Values

Lookup values that exist in another project can be copied to prevent having to manually type the values for each project.

To copy a value from an existing project, select the project list. A list of values found for the selected lookup type will
displayed to the right of the project list.

Select the items (or select All items by using the Shift key). Select the Add Lookup Values button to copy the values to
the current project.
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Administration
KC-130J_PFilot EAC R and M
MATSS Cherry Point
KC-130J Pilot R and M

Mew Project (4) Highly Likely
(5) Near Certain

List Order Description Control
1 Not Selected: A walue has not yet been selected ”~
from those available W

Configure Lookups — Copy from Project

3.4 Configure Resource Page

The resource page is a custom page that can be used to provide links to other web site or messages specific to the
project.

Login > Projects > AV-8B Curriculum Revision and Maintenance > Project Administration >

Configure Resource Page '

Add Page Heading

Add URL

Add Information Block

Configure Resource Page
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3.4.1 Add Page Heading

Login > Projects > AV-8B Curriculum Revision and Maintenance > Project Administration > Configure Resource Page > Add Page Heading >

Add a heading under which to place resource links and information blocks

Heading:

Order:[ ]| add |

Existing headings

Heading ID Heading Order of Appearance Actions

9 Contractor 1 Edit|Delete

10 Student Links |5 Edit|Delete

Add/Edit/Delete Page Headings

Enter the page heading for the resource.
Enter the order in which it should appear.
Click the Add button.

Select the Back to Configure Resource Page.
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3.4.2 Add URL

Login > Projects > AV-8B Curriculum Revision and Maintenance > Project Administration > Configure Resource Page > Add URL >

Add a resource link to the Project Resource and Information page for this project

URL: |http://company-sharepoint.com |
Link Text:|Company SharePoint Site |

SharePoint site used to store important employee

documents.

Description:

Order:

Open link in new window: M
Heading: |Contractor V|IA_dd|

Existing resource links for this project

Topic URL Order of Appearance Actions

Contractor

Company home page |http://company.com 5 Edit| Delete

Company Webmail https://company-web-mail.com |10 Edit| Delete

Employee Training http://company-training.com/ |15 Edit| Delete
Student Links

0GS https://www.ogs.com 5 Edit| Delete

LMS https://www.Ims.com 10 Edit| Delete

Add/Edit/Delete URLs

Enter the URL for the resource.

Enter the text for the link associated with the URL.

Enter a description for that link.

Select the page heading from the drop-down menu.

Select the check box if you want to resource to open in a new window.
Click the Add button.

Select the Back to Configure Resource Page.
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3.4.3 Add Information Block

Login > Projects > AV-8B Curriculum Revision and Maintenance > Project Administration > Configure Resource Page > Add Information Block >

Add an information block to the Project Resource and Information page for this project

Topic:

Timesheets |

Please make sure to sign your timesheets daily!

Information:

Order:[1 |
Heading: |Contractor VI| Add |

Existing information blocks for this project

Topic Information Order of Appearance Actions

Contractor
Student Links

Add/Edit/Delete Information Blocks

Enter the resource page topic.

Enter the text associated with the topic.

Select the page heading from the drop-down menu.
Click the Add button.

The final product is shown within the Resources module.

Login > Projects > AV-8B Curriculum Revision and Maintenance > Resource and Information Page >

Back to Project Main

Menu AV-8B Curriculum Revision and Maintenance linked resources and key information

Contractor

Linked resource Description
Company home page (Corporate home page.
Company Webmail Internet-based access to email.
Employee Training SharePoint site contains the Employee training courses

Key information:

ITimesheets Please make sure to sign your timesheets daily!
Student Links

Linked resource Description
0GS (Online Grading System currently used for students and instructors.
LMS Learning Management System for students and instructors to view and complete Computer Based

[Training lessons.

Resources Module
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3.5 Configure RIMM Module

The Risk Identification and Mitigation Matrix, or RIMM, is the identification, assessment, and tracking of Risk as it relates
to a project. Risks are events that, if they occur, can jeopardize the successful completion of a project.

The RIMM module will need to be configured before a project can start adding risks. To begin, select “Configure RIMM
module” from the Project Administration screen.

Risk Level
Configuration

Current Configuration
Risk Results Risk Area Tracking
DEFAULT YES (DEFAULT)

Risk Level Configuration

COMBINED

Probability Level Tracking Severity Level Tracking

Risk Results
Configuration

Risk Area
Configuration

Default Configure RIMM Module Screen

The default RIMM module contains the following settings:

1. Combined Risk Level containing the default values. This will not include tracking
probability and severity separately.

2. Default Risk Results values.

3. Default Risk Area Tracking values.

A sample data entry screen for a Risk Item from the RIMM module will look as followed:
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Add Risk Item: New Project

Date: [7/19/2018 | B

Title: Mandatory Program-wide Windows 10
Migration

Owner: [Program Manager

Description: |In Februsry of 2016 the Navy issued
NAVADMIN 026/16 - Guidance for %
Migration from all legacy versions of
Windows Operating Systems to Windows 10
and in May of 2016 the Marine Corps

Control Type: |NDt Selected: A value has not yet been selected from those available V|

Risk Level:

Mone
Enter Risk Data E Low

Medium
High

Sample Insert Risk Item Screen Using the Default Setting (Risk Level Combined)

3.5.1 Customizing RIMM module

Refer to the below sections to change the default RIMM setup as well as default lookup values.

3.5.1.1 Risk Level Configuration

The Risk Level Configuration screen allows the user to setup the Probability and Severity Risk levels for RIMM.
Probability is the likelihood of occurrence, which is the ratio of the number of chances by which an event may happen
(or not happen) to the sum of the chances of both happening and not happening. Severity is the potential impact or
damage to the project if the event occurs.

There are 6 possible configurations for Risk Levels:
e Tracking Probability and Severity separately with the default values for each
e Tracking Probability and Severity separately with the default values for Probability and custom values for
Severity

e Tracking Probability and Severity separately with the default values for Severity and custom values for
Probability

e Tracking Probability and Severity separately with custom values for both
e Tracking Probability and Severity as a combined level with the default values
e Tracking Probability and Severity as a combined level with custom values

When first entering this screen, the default setting is a combined risk level. To allow a separate value for probability and
severity, select the Track Probability and Severity Levels button.
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Configure Separate Values for Severity and Probability

After the levels are separated, you will have an option of keeping the default values or enter custom values. The screens
below show the default lookup values.

Default Lookup Values for Severity and Probability
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3/8/2019

Mandatory Program-Wide Windows 10
Migration

Microsoft Office 2013, Microsoft
SharePoint 2013, Exchange 2013, and

Internet Explorer 11 directing the
mandatory migration of informaticon
SysStems.

Mot Selected: A value has not yet been selected from those available v

Mot Selected: A value has not yet been selected from those available
Mot Likely

Low Likelihood

Likely

Highly Likely

Mear Certai

Sample Insert Risk Item Screen Using the Separate Probability / Severity Setting with Default Lookup
Values

To setup a custom lookup menu for probability or severity, select either the Use Custom Probability Levels or Use
Custom Severity Levels button. The screen will change to allow data entry for the lookup values for probability or

severity levels. Enter a numeric value and description, and then select the Add Probability Risk Level or Add Severity
Risk Level button.

Entering Custom Lookup Values
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You can also enter these values from the Configure Lookups module within Project Administration. This is helpful when

you would like to copy lookup values from another project. Refer to section Configure Lookups for more information
concerning the Configure Lookups module.

Lookup Type
Issue Effects

Issue Tracker - Status Categories

RIMM Control Type

RIMM Risk - Combined Levels

RIMM Risk - Probability

RIMM Risk - Severity

RIMM Risk Areas

RIMM Risk Results

Entering Custom Lookup Values from Configure Lookups module

Sample Custom Lookup Values

To revert back to the default values, select either Use Default Probability Levels or Use Default Severity Levels.
Caution: When reverting back to default values, all custom lookup values entered will be removed.

3.5.1.2 Risk Results Configuration

When first entering this screen, the default lookup values are shown. To setup custom lookup values, select the Use
Custom Results button.
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Default Risk Results Lookup Values

After clicking on the User Custom Results button, the following screen will be opened. Enter a numeric value and
description, and then select the Add Custom Results button. You can also enter these values from the Configure
Lookups module within Project Administration. This is helpful when you would like to copy lookup values from another
project. Refer to section Configure Lookups for more information concerning the Configure Lookups module.

Risk Results Configuration - Custom Results
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Sample Custom Lookup Values

To revert back to the default values select Use Default Results.
Caution: When reverting back to default values, all custom lookup values entered will be removed.

3.5.1.3 Risk Area Configuration

Risk Area is the area the risk can occur in. The default lookup values for a risk area are Schedule, Performance, and Cost.

The user can choose to use the default lookup values or create a custom values. To create custom values, select the Use
Custom Areas button.

Risk Area Configuration — Default Lookup values

When a new risk is created from the RIMM module, the risk area location is displayed below.
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3/8/2019

Not Selected: A value has not yet been selected from those available W

INVALID: Using Combined Tracking v

e
W

Location of Risk Area selection when a new Risk is created
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3.5.1.4 Add Control Types

Controllers for a risk item will need to be added as lookup values from the Configure Lookups module within Project
Administration. These values will populate the “Control Type” dropdown when a new risk item is created from within
the RIMM module.

Lookup Type
Issue Effects

Issue Tracker - Status Categories

RIMM Control Type

RIMM Risk - Combined Levels

RIMM Risk - Probability

RIMM Risk - Severity

RIMM Risk Areas

RIMM Risk Results

Control Type Lookup Values
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Administration Select a Project
KC-130J_Pilot EAC R and M

MATSS Cherry Point
KC-130J Pilot R and M
KC-130J Crewmaster R and M

List Order Description Control

Not Selected: A walue has not yet been =zelected
from those available

Contractor

Sample Control Type Lookup Values

3.6 Configure TSSR

TSSR Project Administration is the central area for the project’s TSSR equipment and service actions configuration.
Access begins by navigating to Project Administration > Configure TSSR. In order for the project to start adding
equipment and record service actions, these administration sections need to be populated for the project.

Note: Changes to Status and Rework are global, not project specific.
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Login > Projects > Sample Project > Project Administration > TSSR Administration >

site Administration This is the central area for the Sample Project TSSR Equipment Configuration.

Location
Administration

Type Administration

Status
Administration

Manufacturer
Administration

Model
Administration

Action
Administration

Rework
Administration

TSSR Project Administration Main Menu

3.6.1 Equipment Site Administration

The site administration menu item will take you to a screen that will allow you to view, edit, and add sites specific to the
project that you have logged in under. These sites are used to specify where the equipment is located. Equipment can
then be searched and grouped by this site value in reports and forms within the TSSR module. Records that are archived
will display with a gray background.

Login > Projects > Sample Project > Project Administration > TSSR Administration > Equipment Site Administration >

Add Equipment Site
This is the central page for Equipment Site setup.

Site Coast Is Archived

Cherry Point East Edit
MAG-13 West Edit

MAG-14 East Edit

MAWTS-1 West Edit @
e - =

Offsite Storage East Edit

Retailer N/A Edit @

Equipment Site Administration Screen

Delete

Delete

3.6.1.1 Edit Equipment Site

To edit an equipment site, select the Edit button. When finished editing, select the Save Changes button.
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The following fields are available:

e Site: The text that is displayed in the drop-down menus and reports used within the TSSR module.

e Coast: The east or west coast where the site is located. This value is used in certain reports that group results by
coast.

e |s Archived: This value prevents the site from being displayed in menu selections and report filters. In order to
protect the current equipment selections, the Is Archived value will not become editable if the site is selected
for an active equipment item. An active equipment item is an equipment item that is not in the archived status.
If you need to archive a site, first ensure the site displays no results in the GFP Inventory.

Login > Projects > Sample Project > Project Administration > TSSR Administration > Equipment Site Administration > Add/Edit Equipment Site >

Add/Edit Record

Site: [Cherry Point

Coast:
Is Archived?: True
False

Save Changes

Equipment Site Add / Edit Screen

3.6.1.2 Add Equipment Site

To add an equipment site, select the Add Equipment Site link within the left column. When finished entering the data,
select the Save Changes button.

3.6.1.3 Delete Equipment Site

To delete an equipment site, click the Delete button on the main Administration screen. You will be prompted to

confirm the deletion. Click Yes to delete the record. This button will only be available for records that have never been
used.

3.6.2 Equipment Location Administration

The location administration menu item will take you to a screen that will allow you to view, edit, and add locations
specific to the project that you have logged in under. These locations are used to specify where the equipment is
located. Equipment can then be searched and grouped by this location value in reports and forms within the TSSR
module. Records that are archived will display with a gray background.
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Login > Projects > Sample Project > Project Administration > TSSR Administration > Equipment Location Administration >

Add Equipment

Loeation This is the central page for Equipment Location setup.

Description Abbreviation Is Archived

Alpha Briefing Room/A1 BRA-1 Edit
Alpha Briefing Room/A2 BRA-2 Edit
Alpha Briefing Room/A3 BRA-3 Edit
Bravo Briefing Room/B1 BRB-1 Edit
Bravo Briefing Room/B2 BRB-2 Edit
Bravo Briefing Room/B3 BRB-3 Edit
Briefing Room BR Edit

Briefing Room 2 Briefing Room 2 Edit

Charlie Briefing Room/C1  BRC-1 Edit

Equipment Location Administration Screen

3.6.2.1 Edit Equipment Location
To edit an equipment location, select the Edit button. When finished editing select the Save Changes button.

The following fields are available:

e Location: The text that is displayed in the drop-down menus and reports used within the TSSR module.

e Abbreviation: Is not currently used, but may be used in future reporting to conserve space within the report.

e Is Archived: This value prevents the location from being displayed in menu selections and report filters. In order
to protect the current equipment selections, the Is Archived value will not become editable if the location is
selected for an active equipment item. An active equipment item is an equipment item that is not in the
archived status. If you need to archive a location, first ensure the location displays no results in the GFP
Inventory.

Login > Projects > Sample Project > Project Administration > TSSR Administration > Equipment Location Administration > Add/Edit Equipment

Location >
Add/Edit Record

Location: |Alpha Briefing Room/A1 |
Abbreviation: [BRA-1 |
Is Archived?: True

False
Save Changes

Equipment Location Add / Edit Screen

3.6.2.2 Add Equipment Location

To add an equipment location, select the Add Equipment Location link within the left column. When finished entering
the data, select the Save Changes button.
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3.6.2.3 Delete Equipment Location

To delete an equipment location, click the Delete button on the main Administration screen. You will be prompted to

confirm the deletion. Click Yes to delete the record. This button will only be available for records that have never been
used.

3.6.3 Equipment Type Administration

The type administration menu item will take you to a screen that will allow you to view, edit, and add equipment types
specific to the project that you have logged in under. These types are used to categorize equipment by a certain type.
Equipment can then be searched and grouped by this type value in reports and forms within the TSSR module. Examples
of type values are: Audio-Video, Computer, VTR, Hardware, Monitor, and Notebook Computer. Records that are
archived will display with a gray background.

Login > Projects > Sample Project > Project Administration > TSSR Administration > Equipment Type Administration >

Add Equipment Type

This is the central page for Equipment Type setup.

Type Is Archived

v Edit
Binder Edit
Computer Edit
Docking Station Edit
DVD/VCR Edit
External Hard Drive Edit
Firewall Edit

Furniture Edit

Hardware Edit

Equipment Type Administration Screen

3.6.3.1 Edit Equipment Type
To edit an equipment type, select the Edit button. When finished editing select the Save Changes button.

The following fields are available:

e Type: The text that is displayed in the drop-down menus and reports used within the TSSR module.

e Is Archived: This value prevents the type from being displayed in menu selections and report filters. In order to
protect the current equipment selections, the Is Archived value will not become editable if the type is selected
for an active equipment item. An active equipment item is an equipment item that is not in the archived status.
If you need to archive a location, first ensure the type displays no results in the GFP Inventory.
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Login > Projects > Sample Project > Project Administration > TSSR Administration > Equipment Type Administration > Add/Edit Equipment Type >

Add/Edit Record

Type: |Computer
Is Archived?: True

False
Save Changes

Equipment Type Add / Edit Screen

3.6.3.2 Add Equipment Type

To add an equipment type, select the Add Equipment Type link within the red column. When finished entering the data
select the Save Changes button.

3.6.3.3 Delete Equipment Type

To delete an equipment type, click the Delete button on the main Administration screen. You will be prompted to
confirm the deletion. Click Yes to delete the record. This button will only be available for records that have never been
used.

3.6.4 Equipment Status Administration

The status administration menu item will take you to a screen that will allow you to view, edit, and add equipment
statuses. These statuses are used to categorize equipment by a certain status. Equipment can then be searched and
grouped by this status value in reports and forms within the TSSR module. Examples of status values are: active,
delivered, disposed, loaned, and transferred.

Note: These status values are global to all projects using TSSR within your MELD instance. Please consider all projects
before making changes to these values.

Login > Projects > Sample Project > Project Administration > TSSR Administration > Equipment Status Administration >

Add Equipment

ST This is the central page for Equipment Status setup.

Status Operable

active v Edit

delivered v Edit
disposed Edit
other Edit
loaned Edit Delete
transferred Edit

missing Edit Delete

broken Edit
inactive v Edit

Awaiting DRMO v Edit
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Equipment Status Administration Screen

3.6.4.1 Edit Equipment Status

To edit an equipment status, select the Edit button. When finished editing select the Save Changes button.

The following fields are available:

e Status: The text that is displayed in the drop down menus and reports used within the TSSR module.

e Operable: This value determines if the equipment assigned to this status should be considered operable. For
example, an active and delivered status would be considered operable, but a broken or missing status would not
be considered operable.

Login > Projects > Sample Project > Project Administration > TSSR Administration > Equipment Sta

=
Add/Edit Record

Status: |active
Operable?: ® Trye
. False

Save Changes

Equipment Status Add / Edit Screen

3.6.4.2 Add Equipment Status

To add an equipment status, select the Add Equipment Status link within the left column. When finished entering the
data, select the Save Changes button.

3.6.4.3 Delete Equipment Status

To delete an equipment status, click the Delete button on the main Administration screen. You will be prompted to
confirm the deletion. Click Yes to delete the record. This button will only be available for records that have never been
used.

3.6.5 Manufacturer Administration

The manufacturer administration menu item will take you to a screen that will allow you to view, edit, and add
manufacturers specific to the project that you have logged in under. These manufacturers are used to specify the
manufacturer the equipment was purchased from. Equipment can then be searched and grouped by this manufacturer
value in reports and forms within the TSSR module. Records that are archived will display with a gray background.
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Login > Projects > Sample Project > Project Administration > TSSR Administration > Equipment Manufacturer Administration >

Add Equipment

Manufacturer This is the central page for Equipment Manufacturer setup.

Manufacturer Is Archived

3Com Edit
ACDSee Edit
ActivID Edit
Adobe Edit
Ambir Edit
AMD Edit
AQC Edit
APC Edit
Apple Edit
Autodesk Edit

Avocent Edit

Balt Edit

Manufacturer Administration Screen

3.6.5.1 Edit Equipment Manufacturer
To edit an equipment manufacturer, select the Edit button. When finished editing, select the Save Changes button.

The following fields are available:

e Manufacturer: The text that is displayed in the drop-down menus and reports used within the TSSR module.

e Is Archived: This value prevents the manufacturer from being displayed in menu selections and report filters. In
order to protect the current equipment selections, the Is Archived value will not become editable if the
manufacturer is selected for an active equipment item. An active equipment item is an equipment item that is
not in the archived status. If you need to archive a manufacturer, first ensure the manufacturer displays no
results in the GFP Inventory.

Login > Projects > Sample Project > Project Administration > TSSR Administration > Equipment Manufacturer Administration > Add/Edit Equi]

Manufacturer >
Add/Edit Record

Manufacturer: [Adobe
Is Archived?: True

False
Save Changes

Manufacturer Add / Edit Screen
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3.6.5.2 Add Equipment Manufacturer

To add an equipment manufacturer, select the Add Equipment Manufacturer link within the left column. When finished
entering the data, select the Save Changes button.

Note: Manufacturers can also be added from TSSR>GFP Inventory>Add New Asset form. This will allow site support
personnel to enter the new information if the equipment came from a new manufacturer without having to visit the
project administration section.

3.6.5.3 Delete Equipment Manufacturer

To delete an equipment manufacturer, click the Delete button on the main Administration screen. You will be prompted
to confirm the deletion. Click Yes to delete the record. This button will only be available for records that have never
been used.

3.6.6 Manufacturer Model Administration

The manufacturer model administration menu item will take you to a screen that will allow you to view, edit, and add
manufacturer models specific to the project that you have logged in under. These manufacturer models are used to
specify the model that was purchased. Equipment can then be sorted by this manufacturer model value in reports and
forms within the TSSR module. Records that are archived will display with a gray background.

Login > Projects > Sample Project > Project Administration > TSSR Administration > Manufacturer Model Administration >

Add Manufacturer Select a Manufacturer
Model

| Adobe v

Edit Models
Model Is Archived

Acrobat 5 Edit

Acrobat Professional 11 Edit
Acrobat Standard 6 Edit
Acrobat Standard 7 Edit
Acrobat Standard 8 Edit
Acrobat Standard 8 Upgrade Edit

Acrobat Standard 9 Edit

Animate CC Edit

Manufacturer Model Administration Screen

3.6.6.1 Edit Manufacturer Model

To edit a manufacturer model, select the Manufacturer from the top drop-down list. A list of all available models for the
manufacturer will display. Select the Edit button for the desired model. When finished editing, select the Save Changes
button.

The following fields are available:
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e Model: The text that is displayed in the drop-down menus and reports used within the TSSR module.

e Is Archived: This value prevents the model from being displayed in menu selections and report filters. In order
to protect the current equipment selections, the Is Archived value will not become editable if the model is
selected for an active equipment item. An active equipment item is an equipment item that is not in the
archived status. If you need to archive a model, first ensure the model displays no results in the GFP Inventory.

o Additional system specifications can be entered that will populate the TSSR>Reports>System Specifications
Tables report.

Login > Projects > Sample Project > Project Administration > TSSR Administration > Model Administration > Add/Edit Model >

Add/Edit Record

Model: [4crobat Standard 2 |
Is Archived?: . True
® False

Workstation PDF Development

Specifications:

IA Enabled?: = Yes
"' No

NSA-Approved Process Status: |

Server Only Fields:

Firmware Version: |
Virtual Server?: _ Yes
. No

Software Only Fields:

DADMS ID: | \
DADMS Approval Status: [ |
DADMS Network Approval: | |

DADMS Last Date Allowed: | [:::

Yes
No
Externally Assessed or Authorized?: ' Yes

Save Changes

FAM Accepted:

Add / Edit Manufacturer Model Screen

3.6.6.2 Add Manufacturer Model

To add a manufacturer model, select the Add Manufacturer Model link within the left column. When finished entering
the data, select the Save Changes button.

Note: Manufacturer models can also be added from TSSR>GFP Inventory>Add New Asset form. This will allow site
support personnel to enter the new information to reflect any new models received without having to visit the project
administration section.

3.6.6.3 Delete Manufacturer Model

To delete a model, select the manufacturer from the dropdown. Click the Delete button for the model to delete. You will
be prompted to confirm the deletion. Click Yes to delete the record. This button will only be available for records that
have never been used.
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3.6.7 Action Administration

The action administration menu item will take you to a screen that will allow you to view, edit, and add service actions
for account, print, and equipment specific to the project that you have logged in under. These actions are used to record
work performed by site support. These actions can then be filtered based on a date range to display all work performed
via service record reports.

3.6.7.1 Add Action

To create a new action, you will need to select a service to assign these actions to. The account service has additional
action selections that cover issuing / returning equipment, issuing print items, and groups. These do not apply and are
not available selections for print and equipment actions.

Select the Add Action link within the left column after a service was selected. When finished entering the data, select
the Save Changes button.

Add/Edit Record

Action: |

Issue / Return Equipment: False v
Equipment Type:

Issue Print Items: False v

Available Group: |False v

Require Inspection: False v

Include Trouble Ticket: |False v

Sequence: |:|

Header Type: | Standard White Text Action (No Header) (0) v

Is Archived?: ¢ True
& False

Save Changes

Account Service Action Add / Edit Screen

Add/Edit Record

Action: [

Require Inspection: Fal;e v

Include Trouble Ticket: |False v

Sequence: :

Header Type: Standard White Text Action (No Header) (0) v

Is Archived?: ¢ True
# False

Save Changes

Print / Assemble and Equipment Service Action Add / Edit Screen

The following fields are available:

e Action: The text that is displayed in the action menu for the TSSR module.
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e Issue / Return Equipment: Select True if you are issuing or receiving equipment to / from this customer account.
An example would be if you are issuing a training laptop to a student. Selecting True will display a drop down
menu after the action was started that will allow site support to select the equipment that was issued or
returned for the customer account.

e Equipment Type: If you selected True for “Issue / Return Equipment”, then you would need to specify the type
of equipment that is being issued or returned. An example would be a notebook computer.

Issue Student LMS Training Laptop

Select

27 [ Dell | Latitude EG540 / 4LQ21G12
143/ Dell f Precisicn 3570/ DEGQVWWE2
144 [ Dell f Precision 35107 7SKYWEF2
145 / Dell / Precisicn 3510/ 6BGVWE2
146 [ Dell / Precision 3510 / 95PP2G2
147 / Dell / Precision 3510/ CBPP2G2

Account Services Action Form Example with Issue Equipment Selection

e Issue Print Items: Select True if you are issuing print items for this customer account. An example would be if
you printed a Flight Syllabus Guide for the student. Selecting True will display a drop-down menu after the
action was started that will allow site support to select the document that was issued for the customer account.

Issue Stage Handout / Pnnted Matenal

Select

1i-07 Instructor Guide P
1i-07 JMPS Intro to Joint Mission Planning

1i-08 Instructor Guide

1i-08 JMPS Intro to AV-8B Unigue Planning Component

Account Services Action Form Example with Issue Print Item Selection

e Available Group: Select True if this action can apply to a group as well as a single account. An example would be
allowing an issue print item action to display for groups. This will allow site support to record a single action for
a group of students (class) instead of recording for each student.

e Require Inspection: Select True if this action would require a QCR inspection. This would apply to actions that
occur before release to the student. For example, the “Assemble Binder” action and the “Build / Configure
Student LMS Training Laptops” would require inspection.

e Include Trouble Tickets: Select True if this action is addressing a trouble ticket. This would be done for a
“Correct” action. For example, “Correct Account Errors”, “Correct Print / Assemble Errors”, “Equipment Repair”.

o Note: Itis the project’s responsibility to assign a “Correct” action for each of the three services in order
to address trouble tickets.

e Sequence: The order the action will appear in the action list. The action will be grouped by regular actions, then
by trouble ticket actions.

e Header Type: Provides a selection to display the action as standard white text (no header), Header Only, or
Header that is also a clickable action.
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Select an Action from the list to START

Create MATSS Account
Issue Binder
Conduct MCALMS Access Brief

First Day of Class

Create LM5 Class

Create OGS Account

Conduct Student Inbrief

Issue Student LMS Training Laptop
Select:

Miscellaneous Requests

Issue Courseware Disk

Issue Stage Handout / Prnnted Matenal
Select:

Issue training laptop

Return training laptop

Modify OGS Gradeshest

Reset OGS Progress Review

Modify LMS / OGS Account

Unlock Web Server

Deliver Quarterly Courseware Package

Graduate Student|

Capture Gradesheets / Graduate OGS and LMS Accounts
Inspect / Accept Student LMS Training Laptop upon Turm-in
Miscellaneous

Select a Trouble Ticket Action from the list to
START

Cormect Account Ermors

Services Action Form Example

e Is Archived: Selecting True will remove the action from the action list. It does not remove the action from the
current activity listing, completed activity history, or reports.

3.6.7.2 Delete an Action

To delete an action, click the Delete button on the main Administration screen. You will be prompted to confirm the
deletion. Click Yes to delete the record. This button will only be available for records that have never been used.

3.6.7.3 Edit Action

To edit an existing action, you will need to select the service the action belongs to. A list of all available actions for the
service will display. Select the Edit button for the desired action. When finished editing, select the Save Changes button.
Records that are archived will display with a gray background.

Note: After an action is created, you will only be able to edit the action text, sequence, header type, and is archived
status.
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Actions for Account

Action Issue / Return Equipment Equipment Type Issue Print Items Available to Group Reguire Inspectic

Student Check-In

Create MATSS Account

Issue Binder v Binder o
Conduct LMS Access Brief

Create LMS Class

7

H

Standard White Text Action
. .

Standard White Text Action

Account Service Record Display Screen

Is Archived

Actions for Print / Assemble

Action Require Inspection Trouble Ticket Seq Header Type Is Archived

Print ] Standard White Text Action
Assemble v 1 Standard White Text Action
Print for User Request 2 Standard White Text Action

Edit

Edit

8(8]8

Edit

Print / Assemble Service Record Display Screen
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Actions for Equipment

Action Require Inspection Trouble Ticket Seq Header Type Is Archived
Receipt and Delivery 0 Header Plus Action| Delete

Research and Purchase Equipment 1 Standard White Text Action Delete

Receive Equipment 2 Standard White Text Action Delete

Inventory Equipment-Initial 3 Standard White Text Action Edit Delete

Build Equipment {Computers) v 4 Standard White Text Action Delete

Build / Configure Student LMS Training Laptops v 5 Standard White Text Action

Build / Configure Student Training Desktops v [ Standard White Text Action Edit Delete

Build / Configure Fleet Unclassified Computer systems v 7 Standard White Text Action Delete

Build / Configure Classified Laptops v 8 Standard White Text Action Delete

Deliver Equipment-Initial g Standard White Text Action Delete

Equipment Maintenance 10 |Header Plus Action|

Delete

Windows / Settings Configuration 6B Standard White Text Action Edit Delete

Window Server / Network Configuration il Standard White Text Action

Delete

Change Weekly Backup Disks kI Standard White Text Action Delete

Equipment Service Record Display Screen

3.6.8 Rework Administration

The TSSR Rework Administration module is used to add, edit, and delete rework information. This module works the
same as the online review Rework Administration. The main difference between the modules is that all records can be
edited and deleted in the TSSR module.

Note: These rework values are global to all projects using TSSR within your MELD instance. Please consider all projects
before making changes to these values.

3.7 Configure Workflow

Before the Workflow module can be utilized, a person with project administration rights must properly configure the
Workflow module. To access the Workflow Administration screens, click the “Project Administration” button on the
project main menu page. This displays the Project Administration menu page.

On the Project Administration menu, click the “Configure Workflow” text to display the administration menu.

The Workflow Administration page provides seven options: Create / Edit Process, Copy Process, Create Activities for a
Process, Create Charge Codes, Create Project Tags, Add External Types, and Edit / Create Production Cycle.
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3.7.1 Administration Overview
A brief overview of each of the Administration screens is provided in the following paragraphs.

3.7.1.1 Create / Edit Process

The Create / Edit Process screen provides the ability to name, edit the name, and select a SCO used for testing a process
within Workflow. Once created, this named process is then defined using the create Activities screen.

3.7.1.2 Copy Process

The Copy Process screen allows the user to copy an existing process from the existing project or any project within the
MELD instance to use as a starting point for creating a new process.

3.7.1.3 Create Activities for a Process

The Create Activities screen provides the ability to define the component Activities, sequence, dependencies, and
handling / interface rules of a process.

3.7.1.4 Create Charge Codes

The Create Charge Codes screen provides the ability to create, edit, or delete project charge codes in the database. Once
created, a charge code can then be assigned to a job within the Edit / Create Prod Cycle screen.

3.7.1.5 Create Project Tags

The Create Project Tags screen provides a means to enter project tags into the database. These project tags provide a
means to delineate between different SCOs within a project. Once created, a project tag can then be assigned to a job
within the Edit / Create Prod Cycle screen.

3.7.1.6 Add External Types

External types are defined in the Administration module. The Add External Types screen provides a means of defining
which of the external types apply to a particular project for the purpose of the Workflow module.

3.7.1.7 Edit/ Create Prod Cycle

The Edit / Create Prod Cycle screen provides the ability to define and edit job related data such as: priority, charge code,
project tag, and points of contact. In addition, this screen provides the ability to assign a job to a process and then induct
it for work.

3.7.2 Create /Edit Process

Before a process can be defined, a unique name for the process must be created. This is done using the Create Process
option within Configure Workflow. With “Add a New Project Process” showing in the pulldown, click on the Add / Edit
button. Enter a unique process name in the provided space, then click Save.

To hide the process from the process selection drop-down menus, uncheck the box “Display in process menus”.

Note: Processes can only be deleted if they have not yet been placed into work. If a process has already been placed
into work, it can only be hidden from drop down menus by unchecking the box “Display in process menus”.

Selecting a SCO from the “SCO used for testing purposes” drop-down menu will allow the project to induct the selected
SCO for testing purposes and continue to allow editing of the process until a SCO other than the test SCO was inducted.

This feature can also be used to edit an existing process name. This is done by selecting a previously named process
from the pull-down menu, then clicking on the Add / Edit button.
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The Create Process screen is shown below:

Lesson Revision

Lasson Revision

]

Select a SCO W

Create/Edit Process

3.7.3 Copy Process

The copy process screen allows the user to select a process from any project in the system and make a copy of it to be
used as-is or as a base for creating a new process for the current project.

Select a process to co

(KC-130J Crewmaster R and M) DVD Delivery
(KC-130J Crewmaster R and M) Lesson Revision
(KC-130J Crewmaster R and M) Project Deliverables
(KC-130J Crewmaster B and M) Reference Manuals

Copy Process

After copying the process, you will be taken to the Create/Edit Process screen where you can edit the newly created
process.

Important: Navigate to the Create Activities for a Process screen and verify each activity has a discipline assigned. If a
discipline used in the original process was not added to the current project then the activity will have an unassigned
discipline. The process will not be available to place into work until all activities have a valid discipline assignment.
Select an appropriate discipline for any missing assignments.

3.7.4 Create Activities for a Process

Once a process name has been created, the steps that comprise the process and the rules that will govern Workflow’s
control of the process must be defined. This is done using the Create Activities option. First use the “For Process”
pulldown (under the Filter title) to select the process you wish to work with and click the filter button.

A newly established process will not have any Activities and will look like the screen presented below:
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Filter Lesson Revision

For Process:

q
Lesson Ravision hd

Create Activities (New Process)

After activities have been added, before the process was inducted into a workflow cycle, then the screen will look similar
to the following:

ilter Lesson Revision

For Process:

Lesson Revision A

Activity Name On Complete ai Insert Remove
Start

Days Allowed 1 .
DA second pass 1 Activity Dependency
SME Revisions Assign Discipline .
1 Discipline Assigned (P;ﬁ)ECt Manager Edit | | Insert | | Remove
Enable Work v
VAT Code 2 - NVA
SME Revisions Assign Discipline
Days Allowed 3 Activity Dependency
DA d 3 s
Discipline Assigned Expert (SME)
VAT Code 2 - NVA

Create Activities

The following fields are presented on the screen:

e Sequence - the activity’s numerical sequence in the process. The actual order of execution may vary depending
on the application of dependencies, rules, and QC results.

e Activity Name - the name of the activity to be performed and the settings for the activity

e On Complete - the activity that should follow successful completion of this activity and any dependencies it may
have

e On Fail - the activity that should follow a failure of the activity

e Insert, Remove — these buttons are available only if the workflow process is in use by the “SCO used for testing
purposes” or not placed into work at all. Once it's been put into work by a SCO other than the test SCO, inserts
and removals are no longer available.

e Edit - this button is always available; however, only certain edit values are allowed after the process has been
placed into work by a SCO other than the test SCO. These values are listed in the image below. If the process has
not been placed into work or only placed into work by the “SCO used for testing purposes”, all edit fields are
available.
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Workflow Options:
[ |
L

Online Review / IME Options:

"
||

Update Activity

Add QCR Checklist

Edit Activity (Safe to Edit Values)

3.7.4.1 Edit

The Edit Activity screen appears when an existing activity is selected for editing. The Edit Activity screen is where the
user defines the key attributes of the activity that will govern how Workflow manages the job progression through the
production process. A typical Edit Activity screen for a new process is presented below:
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GA Revisions

GA Revisions
kflow Options:

s
g

Graphic Department (ART)  w

nable Intelligent Routing Options:

[+ |
[+ ]
| Grapnic Depariment (ART) v |
| ]

|

|

|

| ]

|

| ]

|

|

| ]

L]

O

L]

Update Activity

Add QCR Checklist

Create Activities

The following data entry fields are provided. Items in red are required. Checking one or more of these boxes applies the
described Workflow rule or interaction. To see online documentation on each item, roll the mouse over the item and a
description will appear in the blue box to the right.

e Sequence - the activity’s numerical sequence in the process. The actual order of execution may vary depending
on the application of dependencies, rules, and QC results.

o Name - the activity name that will appear in the various Workflow views

e Description - a short description of what the activity does or provides

Workflow Options

e Days Allowed - number of elapsed days typically allotted for this activity. Used by workflow to populate the
"is due" column. The due date is created by adding the number of “Days Allowed” for this activity to the
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date the user started the activity in workflow. A red arrow will display if the activity has not been completed
and the current date is greater than the date listed in the "is due" column.

Days Allowed second pass - number of elapsed days typically allotted for anticipated rework. If a number is
entered for Days Allowed Second Pass, workflow will use this number to determine the "is due" date if the
activity is sent back to the user for rework

Discipline Assigned - a pulldown which permits selection of the discipline responsible for the
accomplishment of the activity from the project’s available disciplines. Used within the Workflow>Discipline
View pages to assign a discipline to this activity.

Final - This last activity marks the end of the process and is not included in the workflow project overview
and discipline pages. Do not select FINAL if work is performed during this activity. The user will not be
presented with a start or complete button in workflow. This activity simply marks the end of the process for
reporting purposes.

Background Color - Sets the background color for the activity row on the Discipline View page.

Supports Multiple - Allows a user within discipline view to check multiple SCOs for the same activity and
start / pass them all at once.

Enable Intelligent Routing Options:

Intelligent Router First Pass- Workflow will not stop at this activity unless there is an unaddressed Online
Review comment to the activity’s assigned discipline.

Intelligent Router Second Pass - Workflow will always stop at this activity on first occurrence of the activity
but work will not stop at this activity on subsequent occurrences of the activity unless there is an
unaddressed Online Review comment to the activity’s assigned discipline.

Intelligent Router Discipline Review - Must be used with either IR 1st or IR 2nd pass. Workflow will not stop
at this activity unless there is an unverified Online Review comment associated with the drop-down
discipline selected with this Intelligent Router option.

Note: Intelligent Router rules do not apply if the activity resulted from an On Fail selection.

Online Review / IME Options:

Enable Work - On complete of this activity in workflow, sets the commenting approval level to -1, ensures
that the SCO is editable from IME and removed from the customer review page. These values are available
for manual edit on the IME Settings tab for a SCO.

Disable Work - On complete of this activity in workflow, sets the commenting approval level to 1 level
higher than the maximum approval level, ensures that the SCO is not editable in IME, and ensures the SCO is
removed from the customer review page. These values are available for manual edit on the IME Settings tab
for a SCO.

Reporting Requirements:

Quality Control - Identifies this activity as the final "Quality Control" activity for the process and is displayed
in the Workflow>Reports>Records Report. The data displayed in the report is the last signed off date and
the QCR who PASSED in workflow for the "Quality Control" activity.

External Customer Notification / Release - Identifies this activity as the "Release to Customer" (for Review)
activity for the process.
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o Thisvalue is used in the Workflow>Reports>Records Report. The data displayed in the report is
the last signed off date and the last signed off user who completed the SCO in workflow for the
"External Customer Notification / Release" activity.

o This activity is also used in the Workflow>Reports>Month Summary Report to identify SCOs that
have been delivered to the customer for review. All SCOs that have been completed in workflow
for the "External Customer Notification / Release" activity for the selected month will display in
the report.

o On completion of this activity in workflow, the SCO is made available for customer review, is not
editable in IME, and the approval level is set at the highest internal review level. These values
are available for manual edit on the IME Settings tab for a SCO.

External Customer Review - Identifies this activity as the "Customer Acceptance" activity for the process
and is used throughout MELD reporting where a SCO / customer acceptance date is returned.

o On PASS of this activity in workflow, updates the acceptance date for the current production
cycle and updates the customer acceptance date for all CRs if the SCO was placed into work
from CMATT.

o QUANTM Six Sigma Metrics will provide DPMO, %Defective and First Pass Yield for the column
marked as "External Customer Review". The "External Customer Review" activity should only be
assigned ONCE in the process and should represent the final on-screen customer review.

SCORM Conformance - Identifies this activity as the final "SCORM Conformance" activity for the process and
is displayed in the Workflow>Reports>Records Report. The data displayed in the report is the last signed off
date and the user who PASSED in workflow for the "SCORM Conformance" activity.
Delivery — Identifies the activity as the customer “delivery” activity for the process.

o On complete of this activity in workflow, updates the delivery date for the CR and removes the
CR from the CMATT>CR Summary and CMATT>Errata Summary pages if the SCO was placed into
work from CMATT.

o Used in the Workflow>Reports>Records Report and Workflow>Reports>Fiscal Year Report to
identify delivery date. The delivery date is the completion date for "Delivery" activity.

Non-Value Added Activity - This activity is crucial to the process but adds no user specified value to the SCO.
These values are reserved for future reporting.

Value Added Activity - This activity adds user specified value to the SCO. These values are reserved for
future reporting.

Attachments — Displays shortcut links to activity related files (e.g. work instructions, job aids, checklists) after the START
button in workflow is selected. The shortcut link can also be a website that is helpful during the process activity.

Attachments:

Sequence: [ | Name: | | Path: | | Auto Load: [
Sequence: Name: [self-Check | Path: |/MELD/projects/KC-1303_Pilot EAC R and M/Job Ai|l Auto Load: VI
Sequence: Name: [w1 | Path: |/MELD/projects/Kc-130]_pilot EAC R and M/contrd Auto Load: [vi
Sequence: Name: [1ob Aid | Path: |/MELD/projects/KC-130J_Pilot EAC R and M/Job Ai| Auto Load: [
Sequence: El Name: |COI | Path: |ﬁMELD;’EPSS,J‘Repor'tstesson,x'Graphic Comparision| Auto Load: []
Sequence: Name: [LMs | Path: [/MELD/EPSS/Activities/SME/KC-130] SME Checklis] Auto Load: [ ]

Activity Attachments — Edit Activity View
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CAI 9l06 Combat Thrust Vectar Control a3 Melanie Clark SME - 5CO 4/12/2013 Self-Check - |
s ons History | POC OLR
On 2/26/2013 5:50:32 Job aid
FM

Col

LMS

Complete

Hold

Activity Attachments — Workflow Discipline View

e Sequence — the order the link appears in the workflow discipline view.

e Name - the name of the link. It is recommended to keep the name short as it appears in the Sign Off column in
the workflow discipline view page.

e Path —the web URL for the file. If the document is a pdf file, you can specify the exact page to load by typing
“#page=pdfpagenumber” For example to bring up page 15 of a work instruction, enter:
WorklInstruction.pdf?#page=15 “

e Auto Load — check this box if in addition to the file link, you wish the file to automatically load when the user
selects the START button in workflow.

o Add, Edit, Remove — select Add to enter the new file link after the fields have been entered, Edit to modify an
existing link after the modifications have been made, and Delete to remove the link.

e Add QCR Checklist — Refer to section Insert QCR Checklist for more information.

On Complete / Pass - designates which activity should be executed when this activity is completed successfully

e  Activity - pull down is used to select the name of the activity

o Dependency — the activity will not move to the next step until all dependencies are complete. Dependencies are
ONLY used when parallel activities are being executed, and the process is moving from a parallel path to a linear
path. Do NOT use dependencies for linear processes. A dependency would not typically be used.

On Fail - designates which activity should be executed when a review indicates a failure. The designated activity is the
point at which rework of the job must logically begin.

e Activity - pulldown is used to select the name of the activity
e Pull down name - assign a short name which will appear in a pull down on the Discipline View

3.7.4.2 Insert

When the Insert button is clicked, a new activity will be added to the process and the Edit Activity window will be
presented for completion. (See Edit Activity)

3.7.4.3 Remove

When the Remove button is clicked, a confirmation window will appear asking you if you are sure that you want to
remove the activity. If OK is clicked, the activity is permanently deleted from the process.
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Message from webpage E|

) T S
M_..\]_‘j Are wou sure you wank bo remove the Activiby

| Ok | [ Cancel

Removal Confirmation

3.7.4.4 Insert QCR Checklist

If the verified checklist in Online Review is used by a different discipline than the QCR, a checklist will need to be
available in order for the QCR to verify all work has been completed each revision cycle.

To add the QCR checklist to an existing activity, edit the QCR Review activity within the Create Activities page.

Attachments:

Sequence:[  |Name:[ ] Path:] | Auto Load: [ @

Add QCR Checklist

Insert QCR Checklist

Select the Add QCR Checklist button.

The checklist will now be available for the activity within workflow discipline view as shown below. All items that have
not been checked by the QCR will appear with a yellow background. The QCR will check the “ISD / QCR Verified”
checkbox next to each comment and then select the Submit Checklist button at the bottom of the checklist to update
the comments.
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Induction CPSMR CPSMR Sign Off Histon|
n e

QCR.
Checklist

] 5C0 Title Parent Media  Assigned To
o=
: http://192168.40.32/ME O = & l & Comment Report - IS0 Veri .
Errata Induction Date: 4/16/2018 1:04:13 PM
Comment Report
P1-21-11 Traffic Alert and Collision Avoidance System (TCAS)
Sequence# ISD /
. Customer . N
Frame# |Originator/Name . Corrective Action QCR
. Comment/Recommendation -
| Identifier Verified
Date Submitted: (CR # 17-1836) Please convert all Notes, .
Frame # 1 4/16/2018 Cautions, Warnings and all graphic text using g°_"‘£’:§f Aﬁ:ar‘es;::e'.ﬁr‘ewzm 3
ID- 169600 Submitted By: TPOC |smart text formatting throughout the entire y: hyberg, »
Response - Converted WCAN to hypertext.
UsG lesson
(CR # 18-228) Please update the Cenclusion
frame text from: If you select NEXT you will
enter the Lesson Test. Once the test is
entered it must be completed and submitted
i . for grading
S D pmittad: Comment Addressed: True
il Submittad By: TPOG |S¥=¢t NEXT to begin the Lesson Test By: Ryberg, Neal Date: 4/17/2018
. UsG y: To the following statement: Response - Changed text to forward vice next.
If you select Forward you will enter the Lesson
Test. Once the test is entered it must be
completed and submitted for grading.
Select Forward to begin the Lesson Test.
Date Submitted: .
Frame # 1 4/16/2018 (CR # 18-750) Please add spaces before and g;_";::;':g"::;fs;:&m‘f? 2018
ID: 169600 Sg%mltted By: TPOC |after the slash. Check all frames. Response - Spaces added before and after the slashes
Date Submitted:
Frame # 12 417/2018 Converted flash WCAN to hypertext, remove |Comment Addressed: True 0
ID: 169611 Submitted By: Neal (flash WCAN. By: Wheatly, Charles Date: 4/17/2018
Ryberg
Date Submitted:
Frame # 15 41712018 Converted flash WCAN to hypertext, remove |Comment Addressed: True O
ID: 169614 Submitted By: Neal  |flash WCAN By: Wheatly, Charles Date: 4/17/2018
Ryberg
Date Submitted:

Sample QCR Checklist

3.7.5 Sample Process

The following is a sample workflow flow chart and the corresponding activities set up in Workflow.
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Inflow from CR f CCB
Process

discipline

Walid
Fail

SME revisions

Assign rework et
discipline

GA revisions

*

PGM revisions

Fail
IS0} revisions
OCR review
PM review Govt Fail
comments =
New comments

Intelligent Router
Enabled

Prepare SCORM
packages

'

Archive — LM5 delivery

Sample Process
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On Fail

EditInsert

Start Activity Dependency
SME Revisions
Days Allowed 1 Assign Discipline
Discipline Assigned PM / PC
Enable Work v
VAT Code 2 - NVA
Bg Color
SME Revisions Assign Discipline Activity Dependency
GA Revisions
Days Allowed 3
DA second pass 3
Discipline Assigned SME
VAT Code 3-VA
GA Revisions Activity Dependency
PGM Revisions
Days Allowed 5
DA second pass 5
Discipline Assigned Graphic Artist
Intelligent Router v
VAT Code 3-VA
PGM Revisions Activity Dependency
ISD Revisions
Days Allowed 2
DA second pass 2
Discipline Assigned Programmer
Intelligent Router v
VAT Code 3-VA
Bg Color
ISD Revisions Activity Dependency
SME Review
Days Allowed 2
DA second pass 2
Discipline Assigned ISD
Intelligent Router v
VAT Code 3-VA
Bg Color
SME Review Activity Dependency SME: SME
QCR Review Revisions
Days Allowed 1 Assign
DA second pass 1 Discipline
Discipline Assigned SME
VAT Code 2 - NVA
Bg Color
QCR Review Activity Dependency SME: SME
PM Review for Revisions
Days Allowed 2 Release to GOVT Assign
DA second pass 2 Discipline
Discipline Assigned QCR
Quality Control v
VAT Code 2 - NVA
Bg Color
PM Review for Release to GOVT Activity Dependency SME: SME
GOVT Review Revisions
Days Allowed 1 Assign
DA second pass 1 Discipline
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Discipline Assigned PM / PC
External Customer v
Notification / Release
VAT Code 2 - NVA
Bg Color
9 GOVT Review Activity Dependency PM / PC: PM
Prepare SCORM Review GOVT
Days Allowed 14 Packages Comments
DA second pass 14
Discipline Assigned PM / PC
External Customer v
Review
VAT Code 2 - NVA
Bg Color
10 PM Review GOVT Comments Activity Dependency PM / PC: GOVT
SME Revisions Review
Days Allowed 2 Assign Discipline
DA second pass 2
Discipline Assigned PM / PC
External Customer v
Notification / Release
Enable Work v
VAT Code 2 - NVA
Bg Color
11 Prepare SCORM Packages Activity Dependency
Archive - LMS
Days Allowed 1 Delivery
Discipline Assigned Programmer
SCORM Conformance v
VAT Code 2 - NVA
Bg Color
12 Archive - LMS Delivery Activity Dependency
END
Days Allowed 1
Discipline Assigned Programmer
Disable Work v
Delivery v
VAT Code 2 - NVA
Bg Color
13 END Activity |Dependency
Days Allowed 1
Discipline Assigned Programmer
VAT Code 2 - NVA
Final v

Sample Create Activities Screen

3.7.6 Create Charge Codes

Create Charge Codes is used to establish project unique charge codes. These codes appear in the user views as charging
guidance - an important capability for sites that work and charge on numerous projects. With “Add a New Project
Charge Code” showing in the pulldown, click on the Add / Edit button. Enter a unique charge code in the provided space,
then click Save. This feature can also be used to edit an existing charge code or delete a charge code entirely. This is
done by selecting an existing charge code from the pull-down menu, then clicking on the Add / Edit or Delete button.
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The Delete button does not appear until a charge code has been selected. The Create Charge Code screen is shown
below:

Login > Projects >> AV-8B Curriculum Revision and Maintenance > Project Administration > Workflow Admin > Configure Charge Codes >

This is the screen where you will add, edit, and delete project charge codes.

|Cumpany Charge Code V| | Add/Edit | | Delete |

Project Charge Code Name: [Company Charge Code

Save

Create Charge Codes

3.7.7 Create Project Tags

Create Project Tags is used to establish project unique descriptive labels. These labels appear in the user views as filter
options. With “Add a New Project Tag” showing in the pull down, click on the Add / Edit button. Enter a unique Project
Tag in the provided space, then click Save. This feature can also be used to edit an existing Project Tag or delete a Project
Tag entirely. This is done by selecting an existing Project Tag from the pull down menu, then clicking on the Add / Edit or
Delete button. The Delete button does not appear until a Project Tag has been selected. The Create Project Tags screen
is shown below:

Note: New production projects MUST have a project tag created that matches the text “Prod”, e.g. “Production”. This is
necessary for QUANTM 6 Sigma reporting.

Login > Projects > AV-8B Curriculum Revision and Maintenance > Project Administration > Workflow Admin > Configure Project Tags >

This is the screen where you will add, edit, and delete project tags.

|F’r0ducti0n V| | Add/Edit | | Delete |

Project Tag Name: [production

Save

Create Project Tags

3.7.8 Add External Types

External discipline types are defined in the Administration module. The Add External Types screen provides a means of
defining which of the external disciplines apply to a particular project for the purpose of the Workflow module. Press the
Add button to include the external type or the Delete button to exclude the external type. External points of contact can
only be defined for the included external types.
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Login > Projects > AV-8B Curriculum Revision and Maintenance > Project Administration > Workflow Admin > Project External Type Administration >

This is the screen where you will add and delete external types to and from a project.

External Type Name Add/Delete

GSME Delete
TPOC Delete
GISD

PTO

Approval Authority

President

Add External Types

3.8 Configure CMATT

Before the CMATT module can be utilized, a person with project administration rights must properly configure the
CMATT module. To access the CMATT Administration screens, click the “Project Administration” button on the project
main menu page. This displays the Project Administration menu page.

On the Project Administration menu, click the “Configure CMATT” text to display the administration menu.

The CMATT Administration page provides seven options: Project Setup, Delivery Method Administration, Complexities
Administration, Checklist Types Administration, and Leading Products Administration.

3.8.1 Project Setup

The project setup screen allows setup of necessary data for the project such as external user accounts and customizable
reporting options.

Login > Projects > Sample Project > Project Administration > CMATT Administration > Project Setup Administration >

CMATT Project Setup
Auto Id: | True +

External User Account: |User, Sample v

Enter Data

CMATT Project Setup Screen

Auto Id —determines whether the project would like CMATT to automatically create a change request id based on the
fiscal year and a unique sequence number, or allow the user to create their own id when change requests are submitted.
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| 13-020 Melanie AV-8B  [Courseware aa
Clarl;

| 13-019 Melanie AN-8B  [Courseware aa
Clarlk

| 13-017 Melanie AV-8B  [Courseware aa
Clarl;

CMATT - Sample Auto Id Label

External User Account: identifies the external account used for the project when comments are transferred from

CMATT to Online Review. This external account should be an account created specifically for this purpose and not
belong to a particular external reviewer.

Comment Assigned Toe Comment Date Comment By

(TSDR # 12-1074) Have this animaiton start when the frame is 3/5/2013
called up. Have the animation play as long as the student is an

he frame. Have anscreen instructions change to "WHEN READY,
SELECT MEXT FRAME" after three rotations,

CMATT - Sample CMATT to Online Review comment

Generic USG SME

3.8.2 Delivery Method Administration

The delivery method administration menu item will take you to a screen that will allow you to view, edit, and add
delivery methods. These delivery methods are used to categorize change requests by a specific delivery method.

Records that are archived will display with a gray background. Delivery methods are global to the MELD instance. Please
consider other projects before renaming or archiving a delivery method.

Login > Projects > Sample Project > Project Administration > CMATT Administration > Delivery Method Administration >
Add Delivery Method

This is the central page for CMATT Delivery Method setup.

NOTE: All changes made on this screen are global, not project specific.

Delivery Method 1Is Archived

Learning Center
bomsen s
CD ROM
MELD

Delivery Method Administration Screen

3.8.2.1 Edit Delivery Method
To edit a delivery method, select the Edit button. When finished editing, select the Enter Data button.
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The following fields are available:

e Delivery Method: The text that is displayed in the drop down menus and screens used within the CMATT
module.

e Is Archived: This value prevents the delivery method from being displayed in menu selections used for change
request input.

Login > Projects > Sample Project > Project Administration > CMATT Administration > Delivery Method Administration > Add / Edit Delivery Method >

Add/Edit Record

Delivery Method: [Learning Center
Is Archived: |False v

Enter Data

Delivery Method Add / Edit Screen

3.8.2.2 Add Delivery Method

To add a delivery method, select the Add Delivery Method link within the left column. When finished entering the data,
select the Enter Data button.

3.8.2.3 Delete Delivery Method

To delete a delivery method, click on the Delete button on the central CMATT Delivery Method Setup page. This button
will only show up on records that have not yet been used.

3.8.3 Priorities Administration

The priorities administration menu item will take you to a screen that will allow you to view, edit, and add priorities.
These priorities are used to categorize change requests by a specific priority. Records that are archived will display with
a gray background.

MELD sites setup to use the QASP option 1 reporting, would need the priorities screen to exactly match what is provided
in the first screen snap.

MELD sites setup to use the QASP option 2 reporting, would need the priorities screen to exactly match what is provided
in the second screen snap.
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Login > Projects > Sample Project > Project Administration > CMATT Administration > Priority Administration >

Add Priority

This is the central page for CMATT Priorities setup.

Priority Scale Priority Description All Projects? Is Archived
1 Urgent v
2 Priority v
3 CAT 1 Text-Based Intermediate Products v
4 CAT 2 Digital Arts Graphics and Text v
5 CAT 3 Digital Arts Video Audio Photography v
6 CAT 4 Design Changes v
7 CAT 5 Content Insertion v
| 8 CAT 6 Software and Architecture v
9 Other v

Priorities Administration Screen — QASP Option 1

Login > Projects > Sample Project > Project Administration >> CMATT Administration > Priority Administration >

Add Priority
This is the central page for CMATT Priorities setup.

Priority Scale Priority Description All Projects? Is Archived

1 Urgent v Edit
2 Priority v Edit
3 Level 2 v Edit
4 Level 3 v Edit
5 Level 4 v Edit
6 Level 5 v Edit

7 Other v Edit

Priorities Administration Screen — QASP Option 2

3.8.3.1 Edit Priority
To edit a priority, select the Edit button. When finished editing, select the Enter Data button.

The following fields are available:
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e Priority Scale: The scale for the priority, 1 being the highest priority item. Every project, unless the project is
using the All Projects selection, needs to have a priority item with a priority scale of 1 for safety of flight
functionality to work properly during change request input and screen displays. If the project is using the All
Projects selection, then a priority one item should be assigned to the All Projects selection as well.

e  Priority Description: The priority description text that is displayed in the drop-down menus and screens used
within the CMATT module.

e All Projects: If a priority has not been assigned to the project, then the project will use all priorities that have
been assigned to “All Projects”

e Is Archived: This value prevents the priority from being displayed in menu selections used for change request
validation and QUANTM and CMATT reports.

Add/Edit Record
Priority Scale: |1

Priority Description: |Urgent
All Projects: True v
Is Archived: False v

Enter Data

Priorities Add / Edit Screen

3.8.3.2 Add Priority

To add a priority, select the Add Priority link within the left column. When finished entering the data, select the Enter
Data button.

3.8.3.3 Delete Priority

To delete a priority, click on the Delete button on the central CMATT Priorities Setup page. This button will only show up
on records that have not yet been used.

3.8.4 Complexity Administration

The complexity administration menu item will take you to a screen that will allow you to view, edit, and add
complexities. These complexities are used to categorize change requests by a specific complexity. Records that are
archived will display with a gray background.

MELD sites setup to use the QASP option 1 reporting, would need the complexities to screen to exactly match what is
provided in the below screen snap.

MELD sites setup to use the QASP option 2 reporting, can use any complexity name since the report does not reference
these values.
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Login > Projects > Sample Project > Project Administration > CMATT Administration > Complexity Administration >

Add Complexity
This is the central page for CMATT Complexity setup.

A Simple
B Basic
C Medium
D High
E Very High

Complexity Administration Screen

3.8.4.1 Edit Complexity
To edit a complexity, select the Edit button. When finished editing, select the Enter Data button.

The following fields are available:

o Complexity: The text that is displayed in the drop-down menus and screens used within the CMATT module.

e Is Archived: This value prevents the complexity from being displayed in menu selections used for change
request validation and reporting.

Add/Edit Record

Complexity: & Simple
Is Archived: False v

Enter Data

Complexity Add / Edit Screen

3.8.4.2 Add Complexity
To add a complexity, select the Add Complexity link within the left column. When finished entering the data, select the
Save Changes button.

3.8.4.3 Delete Complexity

To delete a complexity, click on the Delete button on the central CMATT Complexity setup page. This button will only
show up on records that have not yet been used.
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3.8.5 Checklist Types Administration

The checklist type administration menu item will take you to a screen that will allow you to view, edit, and add checklist
types. These checklist types are used to customize the checklist form when creating sub change requests.

Login > Projects > Sample Project > Project Administration > CMATT Administration > Checklist Types Administration >

Add Checklist Type
This is the central page for CMATT Checklist Types setup.

Checklist Type Name Is Archived
SIM / Flight

ELO
Skill
Curriculum
Style

Checklist Types Administration Screen

3.8.5.1 Edit Checklist Type
To edit a checklist type, select the Edit button. When finished editing, select the Save Changes button.

The following fields are available:

o Checklist Type Name: The text that is displayed in the checklist drop-down menu for sub change request input.
The checklist dropdown appears on the Errata page for the leading product.

e Is Archived: This value prevents the checklist type from being displayed in menu selections used for sub change
request input.

Login > Projects > Sample Project > Project Administration > CMATT Administration > Checklist Types Administration > Add /

Edit Checklist Type >
Add/Edit Record

IChe':kl'5t|51rw / Flight
Type Name:

Is Archived:

Enter Data

Checklist Type Add / Edit Screen

3.8.5.2 Add Checklist Type

To add a checklist type, select the Add Checklist Type link within the left column. When finished entering the data,
select the Enter Data button.
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3.8.6 Leading Products Administration

The leading products administration menu item will take you to a screen that will allow you to view, edit, and add
leading products. A leading product is a SCO that allows sub change request input. Records that are archived will display
with a gray background.

Login > Projects > Sample Project > Project Administration > CMATT Administration > Leading Products Administration >

Add Leading Product
This is the central page for CMATT Leading Products setup.

Leading Product Name Leading Product CI Company / Command Delivery Method Is Archived

PRD-01 CTI MELD

Leading Products Administration Screen

3.8.6.1 Edit Leading Product
To edit a leading product, select the Edit button. When finished editing, select the Enter Data button.

The following fields are available:

e Leading Product Name: The label for the leading product displayed within the “Delivered Parent CR” filter as
well as the name of the checklist for sub change request input.

e Leading Product Cl: The SCO record for the leading product.

e Company / Command: The company / command that sub change requests for this leading product will be
assigned to.

e Delivery Method: The delivery method that sub change requests for this leading product will be assigned to.

e Is Archived: This value, if True, removes the ability for the product to allow sub change request input.

Login > Projects > Sample Project > Project Administration > CMATT Administration > Leading Products Administration > Add / Edit Leading Products

=
Add/Edit Record

Leading Product Name: |COI

Leading Product CI: | (Project Report Deliverables) PRD-01 - Curriculum Outline of Instruction v
Company / Command: [CTI ~ |
Delivery Method: | MELD v|

Is Archived: |False v|

Enter Data

Leading Product Add / Edit Screen

3.8.6.2 Add Leading Product

To add a leading product, select the Add Leading Product link within the left column. When finished entering the data,
select the Enter Data button.

3.8.7 Leading Products Checklist Administration

The leading products checklist button will take you to a screen that will allow you to build the checklist. This checklist
will allow sub change request input for the leading product.
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Login > Projects > Sample Project > Project Administration > CMATT Administration > Leading Products Administration > COI Checklist Administration >

rerre e =sea COI Checklist Administration

Group Display Checklist

7 Sequence
Name e Type Type

Checklist Ttem Name Checklist Item CI

SIM / Flight

Gradesheet and Curriculum OGS Curriculum Applications 1 Textbox  Skill

SCO Admin , Filesystem, DVD, and SCO Admin Filesystem DVD and LMS

B Curriculum . -
LMS Curriculum Curriculum Updates Applications 4 Textbox

Skill

. DropDown Curriculum . -
Lesson List DropDown List of all CIs Lesson 100 List ELO

SIM / Flight

- . Reference .
Flight Syllabus Guide 1r02 Books 1 Textbox  Skill
SIM / Flight
. DropDown :
AA-1-00-L AA-1-00-L Stage Briefs 0 List Curriculum

SIM / Flight

. DropDown :
AAH-1-00-L AAH-1-00-L Stage Briefs 5 List Curriculum

Leading Products Checklist Administration Screen

3.8.7.1 Edit Checklist Item
To edit a checklist item, select the Edit button. When finished editing, select the Enter Data button.

The following fields are available:

e  Checklist tem Name: The name for the item that appears on the checklist
e Checklist Item Cl: The SCO record for the checklist item.

o ---Contains a Dropdown Listing of All CIs-----: Allows a complete drop down listing of all Cls (documents
and SCOs) when selected for the Checklist Item Cl. The Group By Name must be unique for every ---
Contains a Dropdown Listing of All Cls----- instance.

e Group By Name: The name to group the checklist items by.

e Sequence: The order the checklist items appear within the group by name.

e Display Type: The display type for the checklist item, either Textbox or Drop-Down List. Only one display type
can be selected for a group by name.

e Checklist Type: The type of checklist the item relates to. The checklist item will display in red if the checklist type
was selected during sub change request input.
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Login > Projects > Sample Project >> Project Administration > CMATT Administration > Leading Products Administration > COI Checklist Administra’

Item Administration >
Add/Edit Record

Checklist Item Name: |Flight Syllabus Guide \
Checklist Item CI: | (Courseware Supporting Documents) 1r02 - Flight Syllabus Guide -
Group By Name: |Reference Books \

Sequence: |1
Display Type: | Textbox v

Enter Data

Checklist Types:

SIM / Flight

Add
Leading Product Checklist Add / Edit Screen

3.8.7.2 Add Checklist Iltem

To add a checklist item, select the Add Checklist Item link within the left column. When finished entering the data,
select the Enter Data button.

3.9 Issue Tracker Configuration

Issue Tracker allows the user to create and track any issues that might arise during the course of a project. These can be
minor issues that need a quick answer or major issues with the potential to affect the deadline of the project or the
ability to even finish work on the project. Before tracking issues, Issue Tracker must be configured for each project that
will be using it. To configure Issue Tracker, open the Project Administration screen and select Issue Tracker
Configuration.

Login > Projects > AV-8B Curriculum Revision and Maintenance > Project Administration >

Issue Tracker Configuration

Configure Responsible This is the central location for managing user rights, configuring manuals, and administering the AV-8B
Organizations Curriculum Revision and Maintenance project.

Issue Tracker Configuration

3.9.1 Configure Responsibilities

Responsibilities are the organization(s) or individual(s) that may be responsible for a specific issue. These must be set up
prior to using the Issue Tracker module so they can be attached to an issue at creation time. To create Responsibilities or
attach them to a project, click on the Configure Responsible Organizations link from the Issue Tracker Configuration
screen. The Configure Responsible Organizations screen will appear.
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Login > Projects > AV-8B Curriculum Revision and Maintenance > Project Administration > Issue Tracker Configuration > Configure Responsible
Organizations >

Configure the 'Responsibility’ selections that will be available to this project's Issue Tracker.

Select from available organizations
H46FST
HMM-365 ~
HMMT-164

cTI

MALS-16
MALS-26
MALS-29
MALS-36

NATEC v

NADEP

Add Company/Command:

Description: | | Internal/External:
| Add Company/Command |

Responsible Organizations available to this project
Responsible Organization Control

JSSA Delete

MAG-14 Delete

MAWTS-1 Delete

MAG-13 Delete

VMAT-203 Delete

CTI Delete

Configure Responsible Organizations

The screen is divided into three sections. The first section contains a list of organizations that have not yet been assigned
to the project. The second section allows the user to create new organizations, and the third section contains a list of
organizations attached to the project and allows the user to remove an organization from a project.

3.9.1.1 Adding an Organization to the Project

To add an organization to the current project, scroll through the list box until you find it. Select the record, then click the
Add button. The screen will refresh and the organization will be attached to the project.

3.9.1.2 Creating an Organization

To create a new organization, enter the Description and select either Internal or External. Internal means the contractor;
external is the government or other customer.

3.9.1.3 Removing an Organization from the Project

To remove an organization from the project, click the Delete button for the corresponding record. A prompt will come
up confirming the deletion, and the record will be removed. If an organization has already been attached to an issue and
is then deleted from the project, that issue will be marked as "unassigned".

3.9.2 Configure Effect Types

An Effect Type is the type of effect an issue may have on the project. The default values “Schedule, Performance, and
Cost” within the Administration project can be copied to the selected project. To create effect types or assigh them to a
project, open the Issue Effects screen via the Project Administration>Configure Lookups module.
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Login > Projects > USN USMC Curriculum Revision and Maintenance Program Management > Project Administration > Configure Lookups > Config
Values >

Issue Effects

Configure the Lookup Values that will be available to this project.

Select from available projects

Administration

(-1) Not Selected: A value has not yet been selected from those available

KC-130J Curriculum Revision and Maintenance (1) Schedule
AV-8B Curriculum Revision and Maintenance (2) Performance
MATSS Cherry Point (3) Cost NOTE: Entries w

Pilot Curriculum . '
Crewmaster Curriculum duplicate value will

copied to the curren

Add Lookup Value Unique to this Project:

Value: | | Description: | || Add Lookup Value |

Lookup Values available to this project

Description Control

Hot Selected: A value has not yet been selected ~ -
R Delete Update
from those available W -

Configure Issue Effect Types

The Configure Issue Effect Types screen is divided into three sections. The first section lists available projects with Effect
Types configurations that can be copied to the current project. The second section allows the user to add new effect
types to the current project. The third section allows the user to organize the effect types, and edit their information.

3.9.2.1 Copy Effect Types

Many projects use a similar list of effect types or the same list. To prevent the user from having to enter the same effect
types repeatedly, the system allows one project to copy the effect types of another project. To view the effect types
associated with a project, click on the project in the "Select from Available Projects" list box. The effect types will appear
in the box to the right. If no effect types exist for the project, the system will indicate so with a message, "No Values
found". To copy the effect types from a project to the current project, select the effect types to copy, and then click the
Add Lookup Values button.

3.9.2.2 Add Effect Type Unique to the Project

To create a new effect type and attach it to the current project, enter the Label and Description for the effect type and
click the Add Lookup Value button. The new effect type will be added at the end of the list of existing effect types.

3.9.2.3 Edit Existing Effect Types

This section of the screen allows the user to do 3 things.
e Organize the effect types by moving them up / down the list
e Edit the label and description of the effect type
e Delete an effect type from the current project

To organize the effect types list, click on the up and down arrows next to each record to move them up or down in the
list.

To edit the label or description of the effect type, make the desired changes then click the corresponding Update button.
If the button is not clicked, all changes made will be ignored.
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To remove an effect type from the project, click the corresponding Delete button. The system will prompt for
confirmation of the deletion, and then delete the record.

3.9.3 Configure Status Categories

A Status Category reflects the current status of a task assigned to an issue. The default values “Unassigned, Assigned,
Awaiting GFl, and Closed” within the Administration project can be copied to the selected project. To create status
categories or assign them to a project, open the Issue Tracker - Status Categories screen via the Project
Administration>Configure Lookups module.

Login > Projects > USN USMC Curriculum Revision and Maintenance Program Management > Project Administration > Configure Lookups > Configure
Lookup Values >

Issue Tracker - Status Categories

Configure the Lookup Values that will be available to this project.

Select from available projects
Administration

(-1) Not Selected: A value has not yet been selected from those available

KC-130J Curriculum Revision and Maintenance

! ev i (1) Unassigned

AV-8B Curriculum Rewslcm and Maintenance (2) Assigned NOTE: Entries
MATSS Cherry Point (3) Awaiting GFI with a duplicate
Pilot Curriculum (3) Closed ’

value will not be
copied to the current

Crewmaster Curriculum

project
Add Lookup Value Unique to this Project:
Value: | | Description: | || Add Lookup Value |

Lookup Values available to this project

Value Description Control
-1 Not Selected: A wvalue has not yet been selected ~ d
1 from those a'.-’a‘;'_ab'_e v‘ 2EES | Urifs |ﬂ
Configure Status Types

The Configure Status Categories screen is divided into three sections. The first section lists available projects with Status
Categories configurations that can be copied to the current project. The second section allows the user to add new
status categories to the current project. The third section allows the user to organize the status categories and edit their
information.

3.9.3.1 Copy Status Categories

Many projects use a similar list of status categories, or the same list. To prevent the user from having to enter the same
status categories repeatedly, the system allows one project to copy the status categories of another project. To view the
status categories associated with a project, click on the project in the "Select from Available Projects" list box. The status
categories will appear in the box to the right. If no status categories exist for the project, the system will indicate so with
a message, "No Values found". To copy the status categories from a project to the current project, select the status
categories to copy, and then click the Add Lookup Values button.

3.9.3.2 Add Status Category Unique to the Project

To create a new status category and attach it to the current project, enter the Value and Description for the status
category and click the Add Lookup Value button. The new status category will be added at the end of the list of existing
status categories.
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3.9.3.3 Edit Existing Status Categories
This section of the screen allows the user to do three things.

e Organize the status categories buy moving them up / down the list
e Edit the label and description of the status category
e Delete a status category from the current project

To organize the status categories list, click on the up and down arrows next to each record to move them up or down in
the list.

To edit the label or description of the status category, make the desired changes then click the corresponding Update
button. If the button is not clicked, all changes made will be ignored.

To remove a status category from the project, click the corresponding Delete button. The system will prompt for
confirmation of the deletion, and then delete the record.

3.10 Modify Project

To modify a project's information, select the Modify Project menu option.
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Login > Projects > AV-8B Curriculum Revision and Maintenance > Project Administration > Modify Project >

Project Name: [2v-8B Curriculum Revision and Maintenance

Project Code: |

Charge Code:

Curriculum R&M contract at the MCAS Cherry Point, NC site.
[IUT])

in the Fleet. The courseware system contains over 200 courseware elem
workbooks, and reference books hosted both online and in portable DVD
DESCI'iIJtiOI'I: house training system includes three classrooms, two electronic classroo
and twelve brief / debrief / study facilities.
the Marine Corps Aviation Learning Management System (MCALMS), Online Grading System
provides extensive cn-site customer support in the form of infrastructure management,
delivery, and service support for VMAT- 203 FRS students and instructors.

ts, including

The AV-8B R&M effort is supported by Crew Training International (CTI) under the USN / USMC
AV-8B R&M supports revision of the
curricula used for training pilots (CAT I, CAT III, CAT IV, CAT V, and Instructor Under Training
in the Night Attack, Radar Attack, and Training variants of the AV-8B aircraft.
includes support of courseware for V5TOL Landing Signal Officers and V5TOL cepable ship’s personnel
CAI, ICW,

mat. The VMAT 203 school

, two learning centers,
CTI also facilitates student and instructor use of
{(0GS5), and
service

Treining

Delivery Order: [N61340-17-F-00590 |
Contract Number: [n51240-12-D-7208 |
Parent Project: No Parent Project Selected Or Needed v

Logo: i

Browse...

Contact List 10 Add

Resources Resources 1 Edit | Delete
CMATT CMATT 10 Edit | Delete
Workflow Workflow 12 Edit | Delete
RIMM RIMM (5] Edit | Delete
QUANTM QUANTM 16 Edit | Delete
Issue Tracker Issue Tracker 5 Edit | Delete
Calendar Calendar 4 Edit | Delete
Online Review Online Review 14 Edit | Delete
TSSR TSSR 17 Edit | Delete
COI Editor COI Editor 8 Edit | Delete
CR Review CR Review 15 Edit | Delete
EPSS EPSS 9 Edit | Delete

|Update Project Datal | Hide Project |

Project Name: The name of the project. This name is displayed throughout MELD, and also used in the underlying folder
structure. For this reason the name should be reasonably short, and not contain any special characterssuchas\/.! @ #
S% N & * () etc. If the project name is modified, the underlying MELD/projects/<projectname> folder will be renamed

to reflect the new project name.

Modify Project

Project Code: The project code, usually assigned by the government.

Charge Code: The charge code for the project. Valid codes may be up to seven characters in length. If this code is left

blank, it defaults to X100.

Description: A description of the project, this field will allow for a very long description.

Delivery Order: The delivery order number for the project.

Contract Number: The contract number for the project.




MELD Administrator Guide 3.1

August 1, 2021

Parent Project: Allows you to change or select a parent project if desired.

Logo: Displays the current logo if one was assigned. Select the Browse button to select a new logo. Supported file
formats are jpg, gif, and png.

Click the Update Project Data button to save all changes.

3.10.1 Menu Configuration

The menu configuration portion of the screen allows you to modify the menu options for the standard modules.
Modules already attached to your project are indicated highlighted; available modules are indicated in white.

To edit an existing menu option, click the Edit button. The Add/Edit a Menu Button screen appears. This screen is
documented in the Menu Configuration portion of this documentation.

To remove a module from the project menu, click Delete. You will be asked to verify the deletion.

To add a new standard module to the project, click the Add button to the right of the module name and location.
To add custom modules, use the Administration Menu Configuration module.

3.10.2 Hide Project

To hide an entire project from MELD, click the Hide Project button at the bottom of the screen. The user will be
prompted for confirmation. This marks the project as hidden and it will not appear in MELD; however, the project and all
its related data still exist in the database. To permanently delete a project from the database, use the delete project
option in Administration.

3.11 Project Discipline Administration

The Project Discipline Administration Screen allows you to add and delete Disciplines from the project for Online Review
and Workflow purposes. Disciplines must be attached to a project before they are available for assignment in Online
Review and Workflow.
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This is the screen where you will add and delete disciplines to and from a project.
QAR Delete
Programmer Delete
SME Delete
Graphic Artist Delete
QCR Delete
PM / PC Delete
IsD Delete
SM [/ OM Delete
IT Delete
CM Delete
Test Add Discipline add

Project Discipline Administration

When the screen is first opened, it displays a list of all the Disciplines set up in MELD. Next to each is an Add or Delete
Button.

Add - indicates the discipline is not yet attached to the project, clicking the Add button adds a discipline to a project.

Delete - indicates the discipline is already attached to the project, clicking the Delete button removes a discipline to a
project.

All changes are saved immediately when a button is clicked.

Note: If a discipline has been assigned to a comment or workflow activity, the Delete button will be disabled.

3.12 User Administration

The Project Administration -> User Administration screen is the central page for creating, managing, and assigning rights
to users by project. This screen functions similar to the Administration User Administration screen. The difference is that
the Project Administration User Admin screen only allows the user to control permissions for the current project and
does not allow the user to set up disciplines.

Upon entry to the screen, the user sees two buttons, a text box, and a drop-down data window.

e Text Box - used for entering data to limit the contents of the drop-down data window
e Limit List - button used to control the enforcement of the limitations entered in the Text Box.



MELD Administrator Guide 3.1

August 1, 2021

e Drop Down - this contains a list of users currently set up in the MELD system. The display can be modified by
using the Text Box and Limit List button.
e Add/Edit User - allows the user to add a new user or edit an existing user.

3.12.1 Limit User List

The list of users displayed in the dropdown can be limited by last name using the wild card *. The * character only works
at the beginning and end of the word, not in the middle. For example, *son would return Greyson, Johnson, and
Williamson. Joh* would return Johan, Johns, and Johnson. And *ohn* would return Johns, and Johnson. Searching
without a wild card results in exact matches only.

To create a search, enter the desired characters into the Text Box, and click on the Limit List button.

3.12.2 Add a New User

To add a new user, select the Add a New User option from the dropdown, and click on the Add/Edit User button. The
User Administration screen will be displayed. For more information on this screen, see Section “User Administration” of
this manual.

3.12.3 Edit an Existing User

To edit a user, select the user from the dropdown, and click on the Add/Edit User button. The User Administration
screen will be displayed. For more information on this screen. See Section 2.1 of this manual.

Open the PAA or SAAR agreement form located within MELD\Agreement_Forms. If an agreement form is not present
then do not continue. MELD Administrators must have both a PAA and SAAR form. Ensure any permissions that are
changed match the desired user role within the agreement forms.

3.12.4 Reset Password

Passwords are encrypted, and cannot be edited via the admin screens. To reset a user's password, edit the user's record
in Add/Edit User's and click the Reset Password link in the left hand menu bar. The password will be set to the user's
username. They will be required to change it the next time they log in via the Change Password screen.

Open the PAA or SAAR agreement form located within MELD\Agreement_Forms. If an agreement form is not present
then do not continue. MELD Administrators must have both a PAA and SAAR form.

An email notification for the password reset will be sent to any active MELD user assigned to a Security Officer or System
Admin (dropdown on MELD user form) .

4 IME Administration

Users that have “MELD Admin” rights for a given project will have access to the following tabs within IME when the
project is selected.

4.1 Settings

The settings tab controls the asset and error check reporting settings for the project.
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4.1.1 Asset Settings

4.1.1.1 Closed File System

The recommended filesystem is a closed file system, which is the default file system when MELD is installed. The closed
file system ensures all the MELD files are inaccessible which prevents accidental overwrites, movement, or deletion of
files that can occur when users have full control to a file system. A browse button is available from the asset tab to
upload or update assets within the closed file system.

|:Conlent‘ |:Instru|:lion‘ |: [ — |:Scripts‘ |:Error Checks | IZvaiew‘

- Filename Template Object Object Name Div Name Action
C1_23_04_179913.swf |[Primary Asset GRAPHICBOX I
Browse...
Open in new window Keyword Action

KC-130J
G

- .
— Static_Image

G
Aircraft Front View
G
Thunder
G

Aircraft Flyinn

Browse for Asset Location

The alternative to a closed file system is an open file system. Under an open file system, the IME folder structure starting
with the top most curriculum item would be shared by a server administrator. Users would then copy and replace assets
into this media folder. All media files that are available within the media folder for the SCO are shown in a drop-down
menu on the asset tab. The drop-down menu is used to link the desired asset to the template object.
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(Content) (Gnstrocion) (EReference) QR (Script) (Ervor Chrecis) (Preview)

Filename

Template Object

Object Name

Div Name

Action

C1_23_04_179913.swf

Primary Asset

GRAPHICBOX

A

’

! %. >

IG

Open in new window

—-Select

L1 Ul

C1-23-04 208929.swf »g
C1-23-04_208930.swf A

C1-23-04_208931.swf
C1-23-04_208932.swf
C1-23-04_208934 swf
C1-23-04_208935.swf
C1-23-04_208936.swf

"|C1-23-04_208937 swf

C1-23-04_208938.swf
C1-23-04_208940.swf

"|C1-23-04_208941.swf

C1-23-04_208942 swf
C1-23-04_208944 swf
C1-23-04_208946.swf
C1-23-04_209008.swf
¢1-23-04_209009.swf

"|C1_23 04_179911 jpg

C1_23_04_179912.swf
C1.23704_179917.swf

"|c1-23_04_179918 jpg

C1_23_04_179919.swf
C1_23_04_179920.swf

"|C1_23_04_ 179921 swf

C1_23_04_179922.swf
C1.23_04_179923.swf
C1.23704_179924 swf
C1_23_04_179925.swf
C1.23_04_179926.swf
C1_23_04_179927.swf
C1723 04_179928.swf

=3
)
3

2

2

2 |2

2

2 |

O,

o

v

Asset Drop-Down Menu Location

Caution: Using the open file system is only recommended for established projects.

4.1.1.2 Force Asset Tag within Asset Filename

When using a closed file system with the “Force Asset Tag within Asset Filename” checked, an error will display if a file is

uploaded that does not contain the asset tag within its filename.

|: Cnntent] |' Instruct'mnjl |: E—Referem:ejl @ |:Sl:ripl'5 :| |: Error Checks] |: Preview]

he filename selected does not include an AssetTag of 178913, The frame object was not updatad.

Filename

Template Object

Object Name

Div Name

Action

C1_23_04_179913.swf

Primary Asset

GRAPHICBOX

Browse...

Sample “Force Asset Tag within Asset Filename” error message

When using an open file system with the “Force Asset Tag within Asset Filename” checked, the only files available within
the drop-down menu are the files that contain the asset tag within the filename. Most likely the drop-down menu will

contain a single asset.
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|: Cnntenljl |:In5trudiun:| |: E—Referencejl Asset |:5|:ripts:| |:Error Checksjl |: Previewjl

Filename Template Object Object Name Div Name Action
Primary Asset GRAPHICBOX 1 23 04 209687 swf ,@

4.1.1.3 Allow Div Name Edits

Asset Drop Down Menu Location

If “Allow Div Name Edits” is checked, the Div Name field for the template object is open for editing. If a value does not
exist, the div name selected for the template object during template setup (Profiles tab) is used.

|: Content :I |: Instruction :I |: E-Reference :I Asset |: Scripts :I |: Error Checks :l |: Preview :I

Filename

Template Object Object Name

Div Name

Action

C1_23 04 _179913.swf

Primary Asset

GRAPHICBOX

[No Assets Available. |

Open in new window

Keyword Action

KC-1303
&

Div Name Location for Editing

If “Allow Div Name Edits” is unchecked, the div name entered for the template object during template setup is used.

4.1.1.4 Allow Export With Asset Errors

If “Allow Export With Asset Errors” is checked, export will still continue if an asset error is detected. An asset error will
occur if the export cannot locate as asset that is attached to the frame, either directly posted within the Asset tab or
referenced within a posted .htm / js file. This setting is only to be checked if the export is in error and the assets do exist.
This will allow a project to continue to export, while the support team troubleshoots the asset error. Asset errors will
still report within the Error Checks tab regardless of this setting value.

4.1.2 Optional Error Check Reporting Settings

4.1.2.1 Question Settings
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Question Settings

] Missing Feedback Self-Check,Lesson Test
] Missing Correct Answer Self-Check,Lesson Test
Wl Missing Topic Title Lesson Test

] Missing Remediation Frames Self-Check,Lesson Test
Wl Missing ELO Selection Lesson Test

Il Topic Title Does Mot Match Existing Menu or Frame Title  Lesson Test

Sample Question Settings Values

4.1.2.1.1 Missing Feedback

If the “Missing Feedback” checkbox is selected, an error will show on the error report for any question frames containing
a matching title listed within the frame or menu title field, that contain missing question feedback.

Enter comma-separated values for every frame / menu title applicable.

h| Frame Title: Lesson Test 2

[emms]
—

Menu Title:

Menu Title Font: Default (white) v

Enabling Objective:
Question Text: No ELO Selected v

Which aircrew member states "Complete" when the engine start

procedure is completed? Remediation Frame: 23. No. 1 Engine W
Topic Title: No. 1 Engine Start

Feedback Text:

The CP states "Complete” upon completion of the engine start Image Question:
procedure.

Shuffle Distractors: O

Feedback Text Location

4.1.2.1.2 Missing Correct Answer
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If the “Missing Correct Answer” checkbox is selected, an error will show on the error report for any question frames
containing a matching title listed within the frame or menu title field that do not have a correct answer selected.

Enter comma separated values for every frame / menu title applicable.

Sequence Distractor Text Is Correct? Action

0 cp ™
G

1 ACM u
G

2 P O
&

3 cM U
&

O

Correct Answer Location

4.1.2.1.3 Missing Topic Title

If the “Missing Topic Title” checkbox is selected, an error will show on the error report for any question frames
containing a matching title listed within the frame or menu title field that do not have a topic title entered.

Enter comma separated values for every frame / menu title applicable.

Enabling Objective:

|No ELO Selected v
Remediation Frame: |23 No. 1 Engine S V|
Topic Title: Mo. 1 Engine Start

Image Question:

Shuffle Distractors: ]

Topic Title Location
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4.1.2.1.4 Missing Remediation Frames

If the “Missing Remediation Frames” checkbox is selected, an error will show on the error report for any question
frames containing a matching title listed within the frame or menu title field that do not have a remediation frame
selected.

Enabling Objective:

[No ELO Selected V]
Remediation Frame: [23. No. 1 Engine S V|
Topic Title: Mo. 1 Engine Start

Image Question:

Shuffle Distractors: ]

Remediation Frame Location

4.1.2.1.5 Missing ELO Selection

If the “Missing ELO Selection” checkbox is selected, an error will show on the error report for any question frames
containing a matching title listed within the frame or menu title field that do not have an ELO selected.

Enabling Objective:

| Describe the steps of the before start checklist. hd
Remediation Frame: [23. No. 1 Engine S V|
Topic Title: Mo. 1 Engine Start

Image Question:

Shuffle Distractors: L]

Enabling Objective Location
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4.1.2.1.6 Topic Title Does Not Match Existing Menu or Frame Title

If the “Topic Title Does Not Match Existing Menu or Frame Title” checkbox is selected, an error will show on the error
report for any question frames containing a matching title listed within the frame title field that have a Topic entered
that does not match an existing menu or frame title.

4.1.2.1.7 Duplicate Question

If the “Duplicate Question” checkbox is selected, an error will show on the error report any question frames that contain
duplicate question text.

4.1.2.2 COI Settings

4.1.2.2.1 ELOs Not Linked to Question Frames

If the “ELOs Not Linked to Question Frames” checkbox is selected, all ELOs that belong to the linked COI lesson that are
not linked to a question frame containing a matching title listed within the frame or menu title field will show on the
error report.

4.1.2.3 Asset Settings

4.1.2.3.1 Assets Not Matching Asset Tag

If the “Assets Not Matching Asset Tag” checkbox is selected, all assets linked to template objects that do not include the
Asset Tag as part of the filename will show on the error report. The asset tag is an automatically generated value that
matches the frame_id value from the database. When a lesson is imported, the original Asset Tag value remains and
does not get changed to the new imported frame_id value.

Crewmaster_1000 > C1-23-04 > 50. Minimums

GRAPHIC
ID: 179926 Back: Last Modified: e

Sequence: 50 Asset Tag: 179926 Next: Template: Landscape (2) TEXT

Asset Tag Location

4.2 Profiles

The Profiles tab identifies the profiles available for the project.

4.2.1 Profile Settings

The profile settings control the output of the SCO and can be changed at any time throughout SCO development. To
save a change simply click anywhere within the white area of the form.
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Profile Settings

Profile Name:
Crewmaster_Template

ADL Version:

| xAPI v

W Use Frame ID for HTML Filenames
| Export Prompt Text

W] Export Frame Numbers in Menu
W] Export All Menu Items

Menu Font List:

gold

Sample Profile Settings

4.2.1.1 Profile Name

The Profile Name text area displays the profile name shown in a drop-down menus.

4.2.1.2 ADL Version

The ADL SCORM version determines how the lesson will display within a Learning Management System. This value is also
dependent on the SCORM and xAPI calls used within the selected interface for a given SCO.

4.2.1.2.1 ADL SCORM 1.2 — Proctored Exam
This is a MCALMS specific setting and creates the required test xml files for MCALMS proctored testing input.

4,2.1.2.2 ADL SCORM 1.2 — Proctored Lesson Plus Remediation Exam

This is a MCALMS specific setting and creates the required test xml files for MCALMS proctored testing input. This
setting requires a lesson SCO containing and end of lesson test with an additional SCO containing a remediation test. The
additional SCO must include “RT” in the title.

4.2.1.2.3 ADL SCORM 1.2
Produces a SCORM 1.2 package.

4.2.1.2.4 ADL SCORM 2004

Produces a SCORM 2004 package. This is the most common package and should be the one selected when in doubt.

4.2.1.2.5 XAPI
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Produces an xAPI packaged used for the MELD LMS.

4.2.1.3 Use Frame ID for HTML Filenames

If no value exists for the Filename text area for a frame, the frame ID is used to create the HTML filename for the frame.
This setting is recommended because it ensures a unique filename is created per frame.

|‘ CnntenlJ |_Instrudinnl| LE—IleferenceJ |_nsset‘| Scripts |‘Error ChecksJ |_Preview‘

Filename: ‘U

Filename Location

4.2.1.4 Export Prompt Text
If this setting is checked, the prompt text variable will be exported within the HTML page.

Graphic Artist General Instructions: Graphic On-Screen Instructions:

Programmer General Instructions:

Asset Search References: Saved Typical Prompt Text Listing:

Mo asset search references found. Asset search references can be added to this frame - +
from the asset search. [Select each hypertext item to learn V| o G

+

o

Instructional / Prompt Text:

Select PLAY to view the animation.

Prompt Text Location
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var frame_1d=208935;
var asset_tag=208935;
var graphic_1="c1-23-04_208935.swf";
var akKeywords="* 3-D_Render,* Add_Info,* Animated_Graphic,* Audio
var remediationPage="";
var nextPage="2090080.htm";
var prevPage="2089340.htm";
var thisPage="2089350.htm";
var menuTitle="";
var frameTitle="No. 3 Engine Start";
var sequence="18";
var totalFrames="98";
var manifestName="Ground and Flight Checks":
var instructText="Select PLAY to view the animation."”;
var tempiateName="Landscape (Z) ;
var referenceHTML="<span onclick="open_Reference_window(\'../..

Sample Prompt Text Export

4.2.1.5 Export Frame Numbers in Menu

If this value is checked and the interface selected for the SCO is using the form menu within the control.htm template
file, frame numbers will be included in the menu title.

Note: If the interface selected for the SCO generates a custom menu (as displayed in the sample lessons), then this setting
is ignored.

4.2.1.6 Export All Menu Items

If this value is checked, all frames will be listed in the form menu within the control.htm template as well as the
exported_frame_variables.js file. If a menu title is not available, the frame title will be used.

4.2.1.7 Menu Font List

The menu font list includes a list of comma separated values of font colors to produce a drop-down menu listed on the
content tab. If no values are present, then a text area is available on the content tab.

Note: If the interface selected for the SCO generates a custom menu (as displayed in the sample lessons), then these font
colors will need to be compatible with the interface menu.

»| Frame Title: Considerations

Menu Title: \L

Menu Title Font:

Frame Text / Smar| Tex

Sample Menu Font List
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4.2.3 Profile Templates

The profile templates control what templates are available for the SCO. When a project is initially created, a default set
of templates is available. These templates were designed to display correctly within the interface
“Sample_SCO_SCORM_2004". These templates can be removed or edited and new templates can be added.

Profile Settings Profile Templates

Profile Name: » Full Screen Asset

Profile 1 - 174 » Full Screen Text
ADL SCORM Version: » Landscape

| ADL SCORM 2004 hd » Portrait

] Use Frame ID for HTML Filenames » Question

| Export Prompt Text

[] Use Legacy Flash Objects

¥l Export Frame Numbers in Menu
vl Export All Menu Items

Menu Font List:

Sample Profile Templates

4.2.3.1 Edit Template
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Template Name: Landscape

Object Name: Frame Text G
Object Type: |Text hd
Top: 420
Left: 10
Width: 973

Height: 190
Zindex: |5

Div Name: TEXTBOX

Object Name: Primary Asset G
Object Type: |I".'1edia hd
Top: O
Left: 10
Width: 1003

Sample Edit Template

4.2.3.1.1 Template Name

This value represents the template name used in the template selection listing when a new frame is created.

4.2.3.1.2 Object Name

The name displayed within the text area or asset area to identify the objects to modify.

4.2.3.1.3 Object Type

The object type values include Media, Text, or Question.

Note: This item is not editable after a template has been assigned to a frame.

4.2.3.1.4 Top, Left, Width, Height, Zindex

These values represent the positioning within the HTML page. Empty values can exist for these if using style sheets is
desired (as shown in the sample lessons).

4.2.3.1.5 Div Name
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This value represents the name of the div when exported to an HTML file. If the project setting “Allow Div Name Edits” is
checked and a user has updated the div name for the frame object from the Asset tab, then the updated div name will
be used in the export. If a value was not entered for the frame object div name, then this Div name value is used.

It is recommended to keep the div names consistent between the templates. For example, all primary graphic areas use
the div name “GRAPHICBOX” and primary text areas use the name “TEXTBOX”. Any additional graphic area use
“GRAPHICBOX2, GRAPHICBOX3, etc. The same would apply to text areas. This will allow the objects to transfer to new
templates successfully. For example when a frame changes from a portrait style template to a landscape style template,
IME looks first for a matching div name to migrate to the next template. If a matching div name is not available, the first
object found is used in the transfer.

4.2.3.1.6 Add Object

Objects can be added to templates if the template has not been assigned to any frames. To add an object, type the
object name and then select the Add button.

Object Name:  Primary Asset G
Object Type: |Media v
Top: 0
Left: 10

Width: 1003
Height: 410
Zindex: 5
Div Name: GRAPHICBOX

Object Name: ®)

Add Object Location

4.2.3.1.7 Delete Object

Objects can be deleted from templates if the template has not been assigned to any frames. To remove an object, click
the delete button to the right of the object name.
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Object Name: Primary Asset G
Object Type: |Media w
Top: 0
Left: 10

Width: 1003
Height: 410
Zindex: 5

Div Name: GRAPHICBOX

Object Name: O

Delete Object Location

4.2.3.1.8 Delete Template

A template is available for deletion if it has not been assigned to any frames. A delete button will be available when a
template is selected.

Profile Templates

¥ Full Screen Asset

Template Name:  Full Screen Asset

Delete Template Location

4.2.3.1.9 View Template Listing

The template listing button is available in place of the delete button when a template has been assigned to at least one
frame. Click the log button to toggle the template frame listing.
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¥ Landscape

Open template listing in new window
Template Landscape | Total Rows: 154
Parent Name S5C0O Name Frame Segquence

Crewmaster_1000 C1-02-01 &

Crewmaster_1000 C1-02-01 7

Crewmaster_1000 C1-02-02 28

Crewmaster_1000 C1-02-02 34

Crewmaster_1000 C1-07-04 27

Crewmaster_1000 C1-07-04 28

View Template Listing Location

4.2.4 Profile Listing

The log button is available when a profile is assigned to a SCO. To toggle the profile assignment listing, click the log

button.
Profiles
Crewmaster V| (‘.
Open profile listing in new window
Profile: Crewmaster | Total Rows: 78
Parent Name SCO Name

Crewmaster_1000 C1-01-06

Crewmaster_1000 C1-02-01

Crewmaster_1000 C1-02-02

Crewmaster_1000 C1-04-03

Crewmaster_1000 C1-07-02

View Profile Listing Location

4.2.5 Copy Profile

To copy a profile, click the copy button.

Profiles

Crewmaster

vi H @

Copy Profile Location
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An identical copy of the profile will be copied and then loaded onto the screen.

Profiles

Crewmaster (copy)

v @ &

Profile Settings

Profile Name:
Crewmaster (copy)

ADL SCORM Version:

|ADL SCORM 2004 v

Use Frame ID for HTML Filenames
Export Prompt Text

[] Use Legacy Flash Objects

Export Frame Numbers in Menu
Export All Menu Items

Menu Font List:

gold,yellow,purple,green

Profile Templates

» (Auto-Generated) COI Learning Objectives

v

(Auto-Generated) Test Results
Full Screen Asset

Full Screen Asset (Mo Smart Text)
Full Screen Text

Landscape

Yy ¥ ¥ v v

Landscape (2)
» Portrait
» Self-Check Question

» Test Question

Copy Profile Sample

4.2.6 Delete Profile

When a profile has not been assigned to any SCOs, a delete button will be available.

Profiles

| Crewmaster (copy)

v @ &

Delete Profile Location
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5 IME Folder Structure

The IME folder structure contains all the files that IME uses to run and produce courseware. These folders should not be
accessible to the production team unless specified below.

5.1 IME_Data

The IME_Data folder is the location where IME writes all export data as well as read project specific files. This folder
needs to reside outside of the Inetpub folder and is typically copied to the root of the D drive.

5.1.1 IME_Export

The IME_Export folder resides within the IME_Data folder and stores the following information.

5.1.1.1 adl

The adl folder contains a template file titled “RollUpManifest.txt”. This file is used to generate the manifest.xml file for
SCORM 2004 packages. The adl_root folder contains all the root files necessary to produce a SCORM 2004 package.

5.1.1.2 interfaces

The interfaces folder contains all the interfaces available for the MELD site. A project can contain many different
interfaces depending on SCO type and desired customer settings. Refer to the below section on how to customize the
interfaces.

5.1.1.3 projects

Every project used within IME will contain a unique project folder that is titled the database project_id. Within each
project folder contains the following sub-folders:

adl_packages: Contains all the ADL packages that were generated for the project. This folder can be shared by IT to
allow users to grab multiple packages at once if desired.

e-references: If E-References are setup for the project, they will be posted to this folder within IME.

sco_packages: Contains all the IME packages that were generated for the project. This folder can be shared by IT to
allow users to grab multiple packages at once if desired.

When SCOs are deleted, an IME package is created first before deletion to serve as a backup. The files will be created in
the following format: _archive_[date/timestamp] [SCO name] IME_import_package.zip.

top level parent folder: The export locations for each individual SCO start with the top most SCO parent folder. A folder
is created for each SCQO’s parent until it reaches the SCO folder. The SCO folder contains the executable HTML lesson. All
SCO exports are exported to the SCO folder and all packages are created from the SCO folder.

If an open file system is used for the project, these top level folders will need to be shared to allow access to the
“media” folder for each SCO. The “media” folder is the location to copy assets. In a closed file system, all assets are
posted to the “media” folder for the SCO, and these top level folders will not be shared.
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5.1.1.4 templates

The files located within the templates folder display the template thumbnail within the IME footer. The filename must
match the name of the template exactly and must be jpg file. For different thumbnails per project, a project_id folder
can be created and the thumbnails can be placed within the project_id folder.

5.1.2 IME_Temp

The IME_Temp folder contains all temporary data that the signed in user created. This includes imports and frame
previews. The next time the signed in, user logs the temp folder for that user will be emptied.

6 Walk-through Sample IME Interface (ICW and CAI)

A fresh MELD install will come with the following 5 sample interfaces.

Sample_CAIl_Cappuccino_Lesson
Sample_ICW_Cappuccino_Lesson
Sample_ICW_Cappuccino_Lesson_xAPI
Sample_CAIl_Cappuccino_Lesson_xAPI
Sample_SCO_SCORM_2004

The two sample lessons that are available use the interfaces “Sample_ICW_Cappuccino_Lesson” and
“Sample_CAI_Cappuccino_Lesson”. The interfaces can be copied and modified as desired to support project
functionality.

The xAPl sample cappuccino interfaces were created to support loading into the MELD LMS. These interfaces will also
support SCORM 2004 if the MELD LMS is not detected.

6.1 main_head.htm

The main_head.htm and main_body.htm are used by the export engine to create each individual frame page.

The main_head.htm contains the template for the <head> portion of each exported frame. This will include all the .js
and .css references. The main_head.htm should start with the beginning of the document and close with the </head>
tag.

<!DOCTYPE html>
E <html>
—l<head>

<title></title>

<meta http-eguiv="X-UA-Compatible" content="I1E=edge" />
<meta charset="UTF-8">
<link rel="stylesheet" href="interface/contentl024.css" type="text/cs=">

<zcript language="javascript” arc=”interfaceﬁctix_gcntent.js”><fscript}
H<script language="javaScript">

<BEPLACE WITH SCRIPTS>

F</script>

F</head>




MELD Administrator Guide 3.1

August 1, 2021

Sample main_head.htm

It is recommended to set the compatibility type to IE=edge. This will prevent errors if the user has set a compatibility
mode within their browser. The compatibility type coding is listed below.

<IDOCTYPE html>

H<html>

H<head>

<title></title>

<meta http-equiv="X-UA-Compatible" content="I1E=edge" />

=MmMeTta charsec—"ulr-=og".~»

Compatibility Type Reference

A style sheet reference needs to be added to the main_head.htm. This stylesheet will set the style for all text, graphic,
and question layers. An example of a style sheet reference is shown below.

<|DOCTYPE html>
H<html>

|<head>

<title></title>

<meta http-equiv="X-UA-Compatible" content="IE=edge" />

<meta charzet="UTF-8">

<link rel="stylesheet" hrefs"interface/contentl024.ass" :E'Fc=“textf::55"}

Style Sheét Refe;rence

A content script reference needs to be added to the main_head.htm. This file will include all scripting that
communicates between the SCO frame and the interface.

<! DOCTYPE html>>
l<html>
|<hesad=
<title></title>
<meta http-egquiv="X-UA-Compatible" content="IE=edge" />
<meta charset="UTF-8">

<link rel="stylesheet" href="interface/contentl024.css" t:

)

me="text//css">

<script language="javascript"” src=“interfacefctix_ccntent.js">{f3:ript}

Content Script Reference

The <REPLACE WITH SCRIPTS> text will be replaced with the variables listed in Sample Content Page Export from IME.
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The main_head.htm and main_body.htm are used by the export engine to create each individual frame page.

The main_body.htm contains <body> coding for each exported frame. The main_body.htm should start with the <body>

tag and close with the </html> tag.

An example main_body.htm is shown below.

<div 1d="PENCIL"></div>
H<REPLACE WITH GRAPHICECX LAYERS>
H<REPLACE WITH TEXTBCOX LAYERS>

H<script language="javaScript">
RunWhenLoad() ;

/{onload=

<Replace with onload event>
F</script>

F</body>

F</html>

H<body leftmargin="0" topmargin="0" marginwidth="0" marginheight="0" bgcolor="#222928" <Replace with onunlcad event>>

<script language="javascript" arc=”interface/project_gontent.js”><fscript>

<script :ype=”text/javascript” arc=”interface/ctix content questions.js”><fscript>

Sample main_body.htm

It is recommended to place any onload events as well as the onload placeholder text after your content layers, as shown
in the above example. This prevents any conflicts between the media file loading and the HTML page loading.

Listed below are the placeholders that can be used on this page. Please refer to Sample Content Page Export from IME
and Sample Question Page Export from IME for more details on the variables and functions used on this frame page.

Name

Description

<REPLACE WITH GRAPHICBOX LAYERS>

This text will be replaced with the GRAPHICBOX layers. The inline
styles created within the profile are exported with the layers.

<REPLACE WITH TEXTBOX LAYERS>

This text will be replaced with the TEXTBOX layers. The inline styles
created within the profile are exported with the layers.

<Replace with onsave event>
<Replace with onload event>
<Replace with onunload event>

This text will be replaced with the frame events and handlers created
by the developer within the Scripts Tab. If your main template already
has an event, for example the RunWhenlLoad() is included in the
main_head.htm, therefore the placeholder text will look like:
onload="RunWhenLoad();<Replace with onload event>“. If the main
template does not have an event included, then just include the
placeholder text in your body tag.

6.3 index.htm

placeholder needs to be replaced within the <script> tag and will be replaced with xAPI data the MELD LMS needs to

track the lesson.
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A sample index.htm export showing the xAPI data is shown below:

56 ffxAPT communication (auto—generated from MELD) ———————————————————————————————————————
57 [ function getUrlParameter (name) {

58 name = name.replace(/[%“[]/, [') .xeplace (/[N]]/, "“\1");

39 var regex = new BegExp (' [\\7&]" + name + "=(["&#]*) ") ;

a0 var results = regex.exec(location.search) ;

61 return results == null ? "' : decodeURIComponent (results[l].replace(/\t+/g, " "));
62 F o}

63 var activityURI='c 72/courses/94/lesson/25/";

o4 var endpoint =

65 var seed = getUrlParameter("s==d") ;

66 [ if (top.window.opener) {

67 var actor id = top.window.opener.document.getElementById("lblictorID") ;

&8 var org id = top.window.opener.document.getElementById("lblOrganizationID™) ;

09 var mode_id = top.window.opener.document.getElementById ("1lblMode") ;

70 H if (actor_id && org_id && mode_id) {

71 actor = actor id.innerText;

72 organization = org id.innerText;

73 mode = mode_id.innerText;

74 L3

75 L

76 var lesson name='Sample ICW Lesson';

77 var package name—='How to Make the Perfect Cup of Cappuccino (ICW)';

78 O

6.4 main_objectives.htm and main_summary.htm

The main_objectives.htm and main_summary.htm are used by the export engine to create an objectives and objectives
summary page. An example main_objectives.htm is shown below:
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<html>

<head>

<titlerLesson Objectives</title>

<meta http-eguiv="Content-Type" content="text/html; charset=iso-8859%-1">
< /head>

<body bgoolor="#222928" text="#000000">
<div id="ELO">
<div id="LessonData">
<table width="675" border="0" cellspacing="1" cellpadding="1" align= >
<tr> «<td classz="lheader" width="126"> «div align="right"><strong><em>Delivery
Method:</em></strong></dive</od>
<td width="177"><span class="lheader"><strong><Replace with Delivery Method></strong></span></cd>
<td width="208" clas=="lheader"> «<div zlign="right"><strong><em>Conurseware
Version</em></strong>:</div></cd>
<td width="124"><font color="003366" class="lheader"><strong><Replace with Accepted>»</strong></font></td></cr>
<tr> <td width="126" clazs="lheader"> <div align="right"><strong><em>Classification</em></strong>:</div></cd>
<td width="177" clas=z="lheader"><strong><Replace with Classification></strong></td>
<td width="208" clas=z="lheader"> <div align="right">&nbsp </ /div></td>
<td width="124" clas=z="lheader">&nbsp</td></tr>
<tr> «<td widcth="126" height="25" clas=z="lheader">
«div align="right"><strong»<emrDuration:</emy</strongy»</divs</td>
<td width="177" clas=z="lheader"><strong><Replace with Hours></strong></td>
<td width="209">&nbsp;</td>
<td width="124" class="lheader"r&nbsp:</strong></td>» </tr>
</table><br>
<table width="90%" border="0" align="center" cellpadding="4" cellspacing="0" bordercolor="#FFFFFF">
<tr>» <td width="666" bordercolor="#003366" clasz="text"><strong><em><u>Terminal Objective</u></em></strong></tds</tr>
<tr> <td clasz="text" bordercolor="#003366">
<BlockQuoter<Replace with Terminal Chiective></BlockQuote>
</tdy</tr>
<tr> <td class="text" bordercolor="#003366"><scrong><en><u>Enabling Objectives</ux</em></strong><,/cd></cr>
<tr> <td class="text"><BlockQuote><div id="EO">
<Replace with Enabling Okjectives»</div> </BlockQuotes</td>
<ftr>
</table>
</div>
</div>
</ body>
</html>

Sample main_objectives.htm

Listed below are the placeholders that can be used on this page.

Name
Description

<Replace with Delivery Method> This text will be replaced with the value listed within the “type” drop down from
the Settings Tab.

<Replace with Accepted> This text will be replaced with the last export date.

<Replace with Classification> This text will be replaced with the value listed within the “classification” drop
down from the Settings Tab.

<Replace with Hours> The text will be replaced by the total number of frames * 1.1 converted to hours.

<Replace with Terminal Objective> This text will be replaced with the terminal learning objective in the COI editor.

<Replace with Enabling Objectives> | This text will be replaced with the enabling learning objectives in the COI editor.

The main_objectives.htm and main_summary.htm are optional. If these files are not present in the interface folder, the
export will skip them.
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6.5 main_ig.htm and main_sg.htm

The main_ig.htm and main_sg,htm are used by the export engine to create the instructor and student guides. Examples
of both are shown below:

<LES3ON OBJECTIVES FRAME TITLE: Lesson Cbjectives>
<html>

<head>

<title>INSTRUCTOR LECTURE GUIDE</title>

~UA-Compatible” content="IE=edqge" />

<msta http-equ

<meta charset="UTF-8">
<link rel="stylesheet" href="ig files/igs.css" type="text/css">
</head>
<body cnunload="unleoadIG()">
<table width="100%" border="0" bordercolor="#FFFFFF" cellpadding="8" nign>
<tr>
<td align= class="Classification"><REPLACE WITH CLASSIFICATION></td>
</tr>
<tr>
<td class="Title">INSTRUCTOR LECTURE GUIDE</td>
</tr>
<tr>
<td height="29">
<table width="100%" bgcolor="#CCCCCC">
<tr>
<td width="92%" class="HeaderBar"><REPLACE WITH LESSON TITLE></td>
<td clasa= align= width="8%" ></td>
</tr4
</table>
</td>
</tr>
<tr>
<td align= >CLASS PERIODS: <REPLACE WITH CLASS PERIODS><br>LAB PERIODS: <REPLACE WPIH LAB PERICDS><ER>PA PERIODS: <REPLACE WITH PA PERIODS></td>
</tr>
<REPLACE WITH FRAME CONTENT>
<tr>
<td align= clazs="Classification"><REPLACE WITH CLASSIFICATION></td>
</tr>
</table>
<script>

function unloadIG() {
if (opener) {
if (opener.IG Window) {

opener.IG Window = null;

1]
}
</script>
</body>
</html>

Sample main_ig.htm
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<html>
<head>
<title>INSTRUCTOR LECTURE GUIDE</title>
<meta http-equiv="Y-UA-Compatible" content="IE—edge" />
<meta charset="UTF-8">
<link rel="stylesheet" href="ig files/igs.css" type="text/css">
<script>
Ffunction unloadsc() {
if (opener) {

if (opener.SG Window) {

opener.SG Window = null;
}
H

]

</=script>
<style>
.LOHeader {
FONT-WEIGHT: normal; FONT-STYLE: normal; FONT-SIZE: 15px; COLOR: #000000; FONT-FAMILY: Arial, Helvetica, sans-serif;text-transform: uppercase !important;
i
.Frame {
FONT-SIZE: 10px !important;
i
.Frame:after {
content: " (frame information displayed for MELD review purposes)”
i
@media print
.frame {display:nene;}
¥
</style>
</head>
<body onunload="unloadSG() ">
<table width="100%" border="0" bordercolor="#FFFFFF" cellpadding="8" id="ig">
<tr>
<td height="29">

<table width="100%" bgcolor="#CCCCCC">

<tr>
<td width="92%" class="HeaderBar"><div id="title"><REPLACE WITH LESSON TITLE></div></td>
<td class= align= width="8%" ></td>
<ftr>
</table>
</td>

</er>
<REPLACE WITH FRAME CONTENT>

</table>

<div id='figureTOC'><REPLACE WITH LIST OF FIGURES></div>

</body>

</htm13|

Sample main_sg.htm

Listed below are the placeholders that can be used on these pages.

Name
Description

<LESSON OBJECTIVES FRAME TITLE: | Used to generate the TLOs and ELOs on the frame identified by the frame title, in
Learning Objectives> this example, “Learning Objectives”

<REPLACE WITH CLASSIFICATION> This text will be replaced with the value listed within the “classification” drop
down from the Settings Tab.

<REPLACE WITH LESSON TITLE> The text will be replaced with the Title value listed within the Metadata tag for
the SCO.

<REPLACE WITH LESSON NAME> The text will be replaced with the Folder Name value listed within the Metadata
tag for the SCO.

<REPLACE WITH COI STAGE NAME> | The text will be replaced with the full stage name within the COI Editor.

<REPLACE WITH CLASS PERIODS> This text will be replaced with the value listed within the “Class Periods” text area
from the Settings Tab.

<REPLACE WTIH LAB PERIODS> This text will be replaced with the value listed within the “Lab Periods” text area
from the Settings Tab.
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<REPLACE WITH PA PERIODS> This text will be replaced with the value listed within the “PA Periods” text area
from the Settings Tab.

<REPLACE WITH FRAME CONTENT> | Creates two frame rows per frame. The first frame row contains the frame
sequence and title and the next frame row contains the instructor guide text
from the Content Tab.

<REPLACE WITH FRAME CONTENT - | Produces the same rows as above, but does not export the frame title in the first
NO TITLES> frame row.

<SKIP QUESTION DATA> Does not include any question frames.

<REPLACE WITH LIST OF FIGURES> Produces hyperlinks for each figure added with the FIG Smart Text. This is used to
generate the table of figures in the final merged guide document.

The main_ig.htm and main_sg.htm are optional. If the files are not present in the interface folder, the export will skip
them.

An example igs\ig.htm and sg.htm are displayed below:
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<html>

<head>

<title>INSTRUCTOR LECTURE GUIDE</title>

<meta http-equiv="X-UA-Compatible" content="IE=edge" />

<meta charset="UTF-8">

<link rel="stylesheet" href=”ig_filesfigs.css” type="text/css">

</head>

<body cnunload="unleadIG() ">

<table width="100%" border="0" bordercolor="#FFFFFF" cellpadding="8" id="ig">
<tr>

<td align= clas=="Classification">Unclassified</td>
</tr>
<tr>
<td clas=="Title">INSTRUCTOR LECTURE GUIDE</td>
</tr>
<tr>

<td height="29">
<table width="100%" bgcolor="#CCCCCC">
<tr>
<td width="92%" class="HeaderBar">Al 202 General Familiarization - Interior</td>
<td class= align= width="8%" ></td>
</tr>
</table>
</td>
</tr>
<tr=
<td align= >CLASS PERIODS:1.0<br>LAEB PERIODS:0<br>PA PERIODS:0</td>
</tr>
<tr><td class="Frame"><a name="10739"></a>Frame 1. Lesson Topic</td></tr>
<trr><td>General Familiarization - Interior<br>»<br><EBE><I> Course Title </I></B><br><br>
MH-53E BMCM Fleet Replacement Alrcrew<br><br><BE><I> Course Identification Number
</ I></B>»<br><br>D-080-2723 / Al 202<br><br><B><I> References </I></E><br><br>
A1-H53ME-NFM-000 NATOPS Flight Manual<br>Al-H53BE-GAI-000 General Ajircraft Information
Manual<br><br><B><I> Progress Check </I></B><br><br>Toc be administered during Progress
Test No. 2 (General Familiarization) . é&nbsp;énbsp;The student will cbtain a minimum
grade of 80% to pass the test.<br><br><E><I> Introduction </I></B><br><br><div class=
"b1ltl"> Introduce yourself and give the class a summary of your background and
qualifications. </div><br><div cla==="bltl"> Get Students ready te learn. In this
lesson we will examine the emergency edquipment and interior components of the MH-53E
helicopter. The information in this lesson and the previous lesson, provides the
general background for later study of the major systems in the MH-53E helicopter.
</div><br><div class="bltl"> Direct students to LESSON TOPIC Al 202 in their Student
Workboock. </div><br><B><I> Notice to Instructors </I></B><br><br>The Interactive IG
(IIG) is synced with the onscreen lesson. As you progress through the lesson the IIG

Sample ig.htm
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[Khtml>

[<head>

Ktitle>STUDENT WORKBOOK</title>

Fmeta http-egulv="X-UA-Compatible" content="IE=edge" />

Kmeta charset="UTF-8">

IKlink rel="stylesheet" hrefZ”ig_files/igs.css” type="text/oss">
Kstyle>

.LOHeader {

FONT-WEIGHT: normal; FONT-STYLE: normal; FONT-SIZE: 15px; COLOR: #000000; FONT-FAMILY: Arial, Helwvetica,

s=ans—-serif;text-transform: uppercase !important;
}
.Frame {

FONT-SIZE: 10px !important;
}
.Frame:after {

content: " (frame information displayed for MELD review purposes)"
i
Emedia print {
.frame {display:none;}
i
/style>
K/ head>
l<body cnunload="opener.IG.Window = null">
Ktable width="100%" border="0" bordercolor="#FFFFFF" cellpadding="8" id="ig">
[FTxr>
<td height="29">

<table width="100%">

<tr>
<td width="92%" clazz="HeaderBar"><div id="title">Al1 202 Ceneral Familiarization - Interieor</div></td>
<td class= align= width="8%" ></td>
<ftr>
</table>
</td>
</tr>
<tr><td class="Frame"><a name="10739"></a>Frame 1. Lesson Topic</td></tr>

[Ftr><td> LESSON TOPIC: énbsp;énbsp;Al 202 MH-53E General Familiarization - Interior<br><br>INFORMATION SHEET:
énbsp;énbsp Al 202.1</td></tr>

FKtr><td class="Frame"><a name="3006"></a>Frame 2. Lesson Objectives</td></tr>

Ktr><td class="LOHeader">Terminal Objective:</td></tr>

trr><td>Perform basic lewvel one flight duties onboard the MH-53E helicopter in accordance with applicable
publications.</td></tr>

tr><td class="LOHeader">Enabling Objectives:</td></tr>

F</table>

<div id='figureTOC'><a href='#fig 1 Al 202 figure emergency_ exitsl.]jpg'>Figure 1 Emergency Equipment, Exits, and
Entrances (Sheet 1 of 2)</a><br><a href='#fig 2 Al 202 figure emergency exits2.jpg'>Figure 2 Emergency Equipment,
Exits, and Entrances (Sheet 2 of 2)</a><br><a href='#fig 3 Al 202 figure cockpit arrangement.]jpg'>Figure 3
Cockpit Arrangement</a><br></diwv>

F</body>
< /html>

Sample sg.htm

6.6 Sample Content Page Export from IME

When a SCO is exported from IME, each frame is exported as a single HTML file using the file naming conventions listed
within the Profile Settings as well as the SCO Settings Tab. Listed below is a description of the frame content export file.
A preview for the HTML file name is also displayed within the Scripts tab.
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Every content page is created from the main_head.htm and main_body.htm files included in the interface file folder.

The variables listed below are included in the content export if the placeholder text “<REPLACE WITH SCRIPTS>" appears
in the main_head.htm.

var frame_id
e Aunique identifier for the frame auto-generated within the database. This value is also located within the IME
footer when a frame is selected.

var asset_tag
e Aunique identifier for the asset auto-generated within the database. This value starts as the frame_id value but
remains with the SCO during future imports. This value is also located within the IME footer when a frame is
selected.

var nextPage
e Contains the filename of the next page selected within IME.

var prevPage
e Contains the filename of the previous page selected within IME.

var thisPage
e Contains the filename of the current page.

var graphic_1
e (Contains the asset filenames added to a template object for the frame (does not include additional assets).

var aKeywords
e Contains the asset keywords added to a template object for the frame (does not include additional assets).

var menuTitle
e Contains the frame menu title identified within the Content tab for the SCO.

var frameTitle
e Contains the frame title identified within the Content tab for the SCO.

var sequence
e Contains the frame sequence within the IME treeview.

var totalFrames
e Contains the total number frames within the IME treeview for the SCO.

var manifestName
e Contains the Title identified within the Metadata tab for the SCO.

var instructText
e Contains the instruction text for the frame identified within the Instruction tab. This will only be included with
the export if the “Export Prompt Text” is selected for the SCO profile.
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var templateName
e Contains the template name selected for the frame.

var referenceHTML
e This variable is exported only if an electronic reference manual is attached to the frame. This variable contains
the HTML coding to create a reference popup menu based on the electronic references selected on the E-
Reference tab for the frame.

A sample of these variable exports is listed below.

var frame 1d=165752;

var asset _tag=165752;

var graphic 1="P1 17 06 165752.sw

var aFeywords="EC-13

var remediationPage="";

(98]

var nextPage="1t

var prevPage="1t

1
noLnon

by =
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var thiszPage="1¢

var menuTitle=""
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|
|
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|
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m

var frameTitle="PERF INIT WEIGHT 1/4 Page";
var sequence==t;

var totalFrames=53;

var manilfestName="TCLD Entry";

var instructText="
var templateNams="

var referenceHTML="<span
-

=~/ 3pan-~oDr-sopDr-o~opr-

Sample Variables — Frame HTML Page

The following are exported in the <body> section of the content frame.

Div tags are exported for every media template object within the template selected for the frame. If top, left, width,
height, and Zindex values were set for the template objects within the Profiles Tab these values will be included within
the div tag. If these values are not set, the style sheet will need to handle the placement for the div. For the sample
interfaces, the div names “GRAPHICBOX"” and “TEXTBOX” must be used for the primary objects.

e If the project setting “Allow Div Name Edits” is checked for the profile then a div name entered from the Asset
tab will override the div name entered for the template object. Note: This setting cannot be used with the
sample interface since they rely on the GRAPHICBOX and TEXTBOX div names.

e This div contains the asset selected for each media box within the Asset tab.

e For an HTMLS5 object, the id value is the name of the object listed within the Object Name field from the Asset
Tab. If the object name is not listed, an object name is automatically generated using the using the div name
assigned to the media object from the Profiles Tab. e.g. obj GRAPHICBOX.
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Div tags are exported for every text template object within the template selected for the frame. If top, left, width,
height, and Zindex values were set for the template objects within the Profiles Tab these values will be included within
the div tag. If these values are not set, the project interface’s style sheet will need to handle the placement for the div.
For the sample interfaces, the div names “GRAPHICBOX” and “TEXTBOX” must be used for the primary objects.

This div contains the text entered for the text area within the Content Tab.

A sample body is listed below:

<body leftmargin="0" topmargin="0" marginwidth="0" marginheight="0" bgcolor="#222928">

<div id="PENCIL"></div>

<div id="GRAPHICBOX"><cbject type="text/html" id="cbj_ GRAPHICBOX" data=
"media/SAMPLE-01-33216 cc/SAMPLE-01-33216 cc.html" width="100%" height="100%"></object></div>

<div id="TEXTBOX">/@F Prepare your machine for brewing. énbsp;énbsp;<br><br>{BLT:1:1.}{HT:release|2}Add water to the
machine’s tank and make sure pump pipes are fully submerged.{/HT}{/BLT:1:1}<br>{BLT:1:2.}{HT:releaseIS}Locate the

is power but that the water is not yet heated. { /HT}{/BLT:1:2}<br><br>F@/<br><br></div>

<script language="javaScript">
RunWhenLoad () ;
//onload=

</script>

</body>

<script language="javascript" arc=”interface/project_gontent.js?' + new Date() .getTime() + '"></script>

<script type="text/javascript" src="interface/ctix content questions.js?' + new Date() .getTime() + '"></script>
</html>

power button and turn the machine on to heat the water. énbsp;énbsp;A red indicator lamp should light indicating there

Sample Body — Frame HTML Page

6.6.1 Asset Type Samples

The following samples, demonstrate how certain asset types will appear within the content page after export.

6.6.1.1 HTML5 (Animate oam)

<div 1d="GRAPHICBOX">»<object type="text/html" id="obj GRAPHICBOX" data=
"media/SAMPLE-01-33216 cc/SAMPLE-01-33216 cc.html" width="100%" height="100%"></cbject></div>

6.6.1.2 Still Image (jpg, png, gif, bmp)
<div id="GRAPHICBOX"><img src="media/SAMPLE-01-33217.JPG">
</div>

6.6.1.3 Standalone Video (mpg4)

The video tag is exported with the default playback control shown and the first frame is shown while the video is
loading. If other features are desired for the video file, it is recommended to use Animate to load the video and
customize the output.

<div 1d4d="GRAPHICBOX"><video width="100%" height="100%" controls><source src=

"media/1513530890.mpd” type="video/mpd">¥our browser does not support the wideo
tag.</video></div>
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6.7 Sample Question Page Export from IME

The variables listed in the previous section are exported with an IME question page as well as these additional question
specific variables.

var remediationPage
e The remediation frame entered from the Content tab.

var question_id
e Aunique identifier for the question that is automatically generated from the database.

var topic_title
e The topic title entered from the Content tab.

var question_image
e The image filename entered from the Content tab.

var question_points
e The points value entered from the Content tab. This value represents the total number of points the question is
weighted when scored within the SCO. This value can also be used by an LMS to allow for student grade
changes.

If no value is present for the question points, the following will be used during export:
o Multiple choice / True-False questions: 1 point
o Full screen interactions: 2 points
o Essay questions: 3 points (an essay question is a question containing no distractors)

var random_distractor

e The shuffle distractor selection from the Content tab. If the checkbox is checked the value will be true. If not
selected, the value is false.

var CorrectAnswerl = false;
var CorrectAnswer2= false;
var CorrectAnswer3= false;
var CorrectAnswer4= false;
var CorrectAnswer5= false;
e These variables are initially defined and set to false. These variables are used to grade the question.

CorrectAnswer2 = true;

e The variables containing the correct answer will be set to true. In this example, the second distractor was
correct.

var number_correct
e The total number of correct responses defined within the Content tab.

var distractor_count
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e The total number of distractors entered for the question.

var question_type
e The type of question. These values include “true-false” or “choice”.

var correct_response

e Comma separated values containing the correct response. For true-false questions “t” and “f” are used. For
multiple choice questions, 1, 2, 3, etc. are used.

var Answerl = false;
var Answer2 = false;
var Answer3 = false;
var Answer4 = false;
var Answerb = false;
e These variables are initially defined and set to false. These variables are used to grade the question and store
the student response value.

var feedback
e The question feedback entered from the Content tab

A sample of these variable exports is listed below.
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var frame i1d=83%9;
var asset tag=205670;
var graphic_ 1="";
var aEeywords="";

var remediationPage=

var
var prevPage="§381
var thisPage="
var menuTitle=""
var frameTitle="
var sequence=12;

var totalFrame=s=18;

var manifestName="How to Make the Perfect Cup of Cappuccino (IC 5
var instructText="";

var templateName="T on E

var referenceHTML="No e-reference avalilable<br><br><br>";

var gquestion_id=138;

H
1]
[v1]
]
T

var feedback="Espresso
cappuccino.™;

var topic title="
var random_distractor=félse;

var question_image="SAMPLE-01-33208.JPG";
var guestion points=1;

var Correcthnswerl=false;

var hnswerl=false;

var CorrecthnswerZ=false;

var hnswerZ=false;

var Correcthnswer3=false;

var Answeri=false;

var Correcthnswerd=rfalse;

var Answerd=false;

var CorrecthnswerS=false;

var hnswerS=false;

var Correcthnswerl=true;
var Correcthnswer3=true;
var Correcthnswerd=true;
var number correct=3;
var distractor count=4;
var question type="choic

var correct response="1,

Sample Variables — Question HTML Page

The following are exported in the <body> section of the question frame:

<div id="QuestionWrapper">

The div that contains the entire question (question text, distractors, images, and submit button).

<div id="QuestionFullWrapper">

The div that contains the entire question when a full screen image is used on the frame.

<div id="Question">

The div that contains the question text.
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<div id="Questionimage">
e The div that contains the question text when an image is used on the frame. The image will display above the
question text.
<div id = "QuestionFull">
e The div that contains the question text when a full screen image is displayed on frame. This would typically be
used to hold hidden text and the style would be set to display:none.
<div id="Box1" onclick="AnswerBoxClick(1)"><span>A. Distractor 1</span></div>
<div id="Box2" onclick="AnswerBoxClick(2)"><span>B. Distractor 2</span></div>
<div id="Box3" onclick="AnswerBoxClick(3)"><span>C. Distractor 3</span></div>
<div id="Box4" onclick="AnswerBoxClick(4)"><span>D. Distractor 4</span></div>
e These divs contain the distractor text. The style will need to be created within the stylesheet that defines the
presentation of the question (padding, width, etc.). The position for this style should be listed as relative.

<div id="Submit"> <a href="#" onclick="SubmitAnswer();">SUBMIT</a></div>
e The div that contains the submit button.

A sample of a <body> export is listed below:

é<div id="QuestionWrapper">
<div id="Question">What airspeed and altitude wvariations begin to significantly affect endurance
performance?</div>

<div id="Beoxl" onclick="AnswerBoxClick(l)"><span>A. +/-5 knots and +/-500 feet</span></div>

<div 1d="Box2" onclick="AnswerBoxClick(2)"><span>B. +/-10 knots and +/-1,000 feet</span></div>
<div id="Box3" onclick="AnswerBoxClick(3) "><span>C. +/-15 knots and +/-1,500 feet</span></div>
<div id="Box4" onclick="AnswerBoxClick(4)"><span>D. +/-20 knots and +/-2,000 feet</span></div>
<div id="Submit"> <a href="#" onclick="SubmitAnswer () ;">SUBMIT</a></div>

F</diw>

Sample Body — Frame HTML Page

6.8 Sample Objectives Page Export from IME

If the main_objectives.htm template is located within the interface folder, then an objectives.htm page will be created.
If a main_summary.htm template is located within the interface folder, then an objectives_summary.htm will be
created. These files are created within an objectives sub-folder within the media folder. An example of an objectives
page export is shown below.
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<div id="ELO">
<div id="LessonData">

<table width="675" border="0" cellspacing="1" cellpadding="1" align= >

<tr>
<td class="lheader" width="126"> <div align="right"><strong><em>Delivery
Method:</em></strong></div></td>
<td width="177"><span class="lheader"><strong>CAI</strong></span></td>
<td width="209" class="lheader"> <div align="right"><strong><em>Courseware
Version</em></strong>:</div></td>
<td width="124"><font color="#003366" class="lheader"><strong>7/13/2018</strong></font></td>
</tr>
<tr>
<td width="126" class="lheader"> <div align="right"><strong><em>Classification</em></strong>:</div></td>
<td width="177" class="lheader"><strong>Unclassified</strong></td>
<td width="209" class="lheader"> <div align="right">&nbsp;</div></td>
<td width="124" class="lheader">é&nbsp;</td>
</tr>
<tr>
<td width="126" height="25" class="lheader">
<div align="right"><strong><em>Duration:</em></strong></div></td>
<td width="177" class="lheader"><strong>0.97</strong></td>
<td width="209">&nbsp;</td>
<td width="124" class="lheader">é&nbsp;</strong></td>
</tr>

</table><br>
<div id="EO">
<table width="90%" border="0" align="center" cellpadding="4" cellspacing="0" bordercolor="#FFFFFF">
<tr>
<td width="666" bordercolor="#003366" class="text"><strong><em><u>Terminal Objective</u></em></strong></td>
</tr>
<tr>
<td class="text" bordercolor="#003366">
<BlockQuote>Operate the automatic flight control system in accordance with applicable publications.</BlockQuote>
</ td>
</tr>

<tr>
<td class="text" bordercolor="#003366"><strongr<em><u>Enabling Objectives</u></em></strong></td>
</tr¥<tr> <td class="text"><BlockQuote>
Perform an operational checkout of the Digital Autopilot / Flight Director (DA / FD) system IAW the
procedures in NAVAIR 01-75GAJ-22JG-10-1.</BlockQuote></td>
</tr>

Sample objectives.htm

6.9 Lesson and Online Review Interactions

When being played in Online Review (OLR), the lesson is responsible for indicating to the OLR wrapper each
time the user changes the current frame. This allows the OLR to update the Comments Display section of the
screen to match the current frame and apply any new comments to the correct frame.

In the sample interfaces, the interface the code to trigger the comments display update can be found in
ctix_frame.js within the function RetractTOC(), and it looks similar to this:

if (top.parent.comment area != null) {
//MELD detected
top.parent.CFrame (MAIN.frame id);
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Another possible implementation, for an interface that does not use frames:

if (typeof top.parent.CFrame == 'function') {
//verify the lesson is being played in OLR
top.parent.CFrame (frame id);

}

6.10 Remaining Interface Files

6.10.1 Interface\content1024.css

Contains the styles used for all the content and question frames.

6.10.2 Interface\contentObj1024.css

Contains the styles used for the objectives page.

6.10.3 Interface\ctix_content.js

This document contains the functions that communicate between the interface and the individual frame HTML page. It
also contains the interactions between the lesson and the MELD Online Review (OLR) module.

6.10.4 Interface\ctix_content_questions.js

This document contains the question specific functions that communicate between the interface and the individual
frame HTML page.

6.10.5 Interface\ctix_frame.js

This document contains the interface related functions.

6.10.6 Interface\ctix_frames.htm

This document contains the div tags for all navigation controls for the SCO as well as an iframe to load the individual
frame pages.

6.10.7 Interface\ctix_glossary.css

This document contains the styles used for the MELD created glossary file.

6.10.8 Interface\ctix_interface.css

Contains the styles used for the interface.

6.10.9 Interface\ctix_test _results.js

This document contains the functions required for question data.

6.10.10 Interface\ctix_track_menu_navigation.js

This document contains the functions required to support training track navigation.

6.10.11 Interface\glossary.htm
This document opens the MELD created glossary file that is attached to the SCO.
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6.10.12 Interface\project_content.js
This document contains any project specific functions that are called from the frame HTML page.

6.10.13 Interface\project_frames_include.js
This document contains any project specific functions that are called from the interfaces.

6.10.14 Interface\project_interface.css
This document contains any project specific styles for the interface such as menu images.

6.10.15 utiNAPIWrapper.js
This document contains the required SCORM 2004 API wrapper.

This file is not present within the sample xAPI interfaces.

6.10.16 utiNAPIWrapper_sv1-2.js
This document contains the required SCORM 1.2 API wrapper.

This file is not present within the sample xAPI interfaces.

6.10.16.1 SCORM 1.2 reference

By default, the SCORM 2004 wrapper is attached to these sample interfaces. If SCORM 1.2 is desired, the script
reference within ctix_frames.htm will need to change from APIWrapper.js to APIWrapper_sv1-2.js.

6.10.17 utiNComment.htm

This document contains the commenting window for SCORM or MELD LMS commenting.

6.10.18 util\ctix_LMSAPI.js

This document contains the SCORM and xAPI functions to pass to the APl wrapper.

6.10.19 util\ctix_xAPIFunctions_SCORM_Profile.js

This document contains the functions to build the JSON statements to send an xAPI LMS.

6.10.20 util\ctix_xAPITranslate.js

This document contains functions that will translate a SCORM call to xAPI SCORM Profile format. If xAPI is not available,
then SCORM 2004 is used.

6.10.21 util\xapiwrapper.min.js

This document contains the class to send the JSON statements created within ctix_xAPIFunctions_ SCORM_Profile.js

6.10.22 utiinterface_config.js

This document contains all the settings used within the SCO.

6.10.22.1 SCO Features / Control Buttons On / Off

The below values turn features on / off. To turn on a feature assign the variable to “true”. To turn off the feature assign
the variable to “false”.
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6.10.22.1.1 IS_ShowlG

Setting this value to “true” will show the instructor guide button within the menu window.

A t

Lesson Objective

N Courseware Version: 7/116/2018

; (=% INSTRUCTOR LECTURE GUIDE - Internet Explorer

SRSl | © http://192.168.20.6/MELD/IME/export/projects/11/A1/A1%:20501 /igs/ig.htm=3056

v o

. Lesson Objecti
ML State safety throughout lesson; emphasize all safety statements mentioned in required manuals.
. Cargo Ramp

. Stub Ramp Frame 2. Lesson Objectives

. Cargo Floor
Terminal Objective:

Perform basic level one flight duties onboard the MH-53E helicopter in accordance with applicable
publications.

MULLGCHEE Enabling Objectives:

. 20,000 Pound °

MelelNiHolF X3  Upon completion of this lesson, you will be able to:

. Floor and Ram

. Stowage Box 1. Identify the major components of the cargo compartment.

Cargo Loading 2. List the different cargo tiedown fittings.
. Ramp Control |

o Do 3. List the components of the ramp and door system and their functions.

. Ramp Manifold 4. List the components of the cargo lighting system and their functions.
. Ramp Uplocks
e e Frame 3. Cabin Dimensions

APP / Pylon Se
Nummbnin wurithhin Coiindamé \Manvichanlsr mnm thicm Femman
. Door Locking V==

Instructor Guide Button within Menu

6.10.22.1.2 IS_ShowSG

Setting this value to “true” will show the student guide button within the menu window for MELD review purposes only.
This allows a reviewer to review the individual guide instead of having to load the entire merged guide SCO.
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Frame 3. Personnel Door (frame information displayed for MELD review purposes)

°

. Lesson Topic EAERGENGY
. Lesson Objectives EXIT LIGHT

. Personnel Door

. Personnel Door Jettison

. Emergency Escape Hat PORTABLE FIRE
. Emergency Escape Hat EXTINGUISHER
. Cabin Window

. Cabin Window Jettison

. Cargo Door Window

. HEELS Locations

. Emergency Equipment, |

. Fire Extinguishers and F|

. IFAK kits

. Cockpit Window SRS b oy
. Cockpit Arrangement S & ] (DETACHABLE)
. Right Hand CB Panel

_ Left Hand CB Panel i MERGENCY
. Emergency CB Panel (C = |~ (Et;(Elll-‘k(I:?-lTBLE)
. No. 1 AC Junction Box COPILOT
. No. 2 AC Junction Box SEAT
. No. 3 AC Junction Box

. DC Junction Box

. Bearing Monitor Panel (BMP)

O (

o

EXIT LIGHT
(DETACHABLE)

O O O

O O O O

Show the Student Guide (Available within MELD only)

Student Guide Button within Menu

6.10.22.1.3 IS_ShowGlossary

Setting this value to “true” will show the glossary button within the menu window.
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Glossary

L M NOP QR S§ T U

MOP b
8. MOP ¢

Glossary Button within Menu

6.10.22.1.4 IS_GlossaryFilePath

This variable stores the relative path to the glossary page within the interface folder. This value will most likely remain
unchanged.

6.10.22.1.5 IS_ShowDraw

Setting this value to “true” will show the draw button within the menu window.
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Cabin Dimensiong

. Lesson Topic
. Lesson Objectives
. Cabin Dimensions
. Cargo Ramp
. Stub Ramp
. Cargo Floor
. Tiedown Fittings Location
. 4400 Pound Ramp Snatch Block Fittings
. 5000 Pound Tiedown Fittings
. 9700 Pound Tiedown Fittings
. 10,000 Pound Tiedown Fittings
. 20,000 Pound Tiedown Fittings
. CONE OF ACTION
. Floor and Ramp Strength Limits
. Stowage Box
Cargo Loading Panel
. Ramp Control Handle
. Cargo Door
Ramp Manifold
Ramp Uplocks
. Ramp Manifold
. APP / Pylon Selector Valve and Handpump
Door Locking Valve

»- - 14 s 4

STA 362 - STA 422 STA 422 STA 422 -STA 522

Draw Button within Menu

6.10.22.1.6 IS_ShowSkip

Setting this value to “true” will show the skip button within the menu window. The skip button will allow an instructor to
skip certain frames that are not applicable to the discussion.

Note: If this feature is used in the SCO, then manual frame navigation cannot be set within IME.
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Courseware Version: 7/17/20

Definitions and Terms
Mechanical Design Features
. JPT & RPM Limiting
. DECS
5. NATOPS Performance Calculations
. Hover Performance Chart
. Sample Problem
. Performance Calculations

trol system in accordance with applicable

t of the Digital Autopilot / Flight Director (DA / FD)
AVAIR 01-75GAJ-22JG-10-1.

. Hover Weight
. STO Speed
. VLDry
. VL Wet
. Flight Walk Through
4. Real World Applications

A3 g

. Hot Weather Operations

. High Elevation Operations
_ High Winds
3. High Descent Rates

. Engine Mishandling

. FOD

. Perfect Scenario

o

o
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(o]

. Rules to Live By

B
m
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|
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|
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53]
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B
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33. Conclusion

Skip Button within Menu

6.10.22.1.7 IS_ClickNext

This value allows a screen click to advance to the next frame (note: For external media objects, requires an external
interface call from the object to the function: BackgroundClick)

6.10.22.1.8 IS_ShowlInlineWcnButtons

This value set to "true" will always show inline warning, caution, and notes buttons in frame text. The warning, caution,
and notes will not initially load when navigating to the screen. Once the button is selected the warning, caution, or note
will appear within the WCAN review list button located on the control bar.
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6.10.22.2 Track Navigation

The track navigation feature was developed for the AV-8B platform to enable multiple training tracks to support training
for the existing software as well as the new released software. These values will most likely show as empty values for all
but the AV-8B platform.

6.10.22.2.1 IS_Trackl

This variable sets the prefix used in the frame and menu titles for track specific frames for the existing software.

6.10.22.2.2 IS Track 2

This variable sets the prefix used in the frame and menu titles for track specific frames for the new software.

6.10.22.2.3 IS_Trackdev

This variable is reserved for future development track. Not typically used.

6.10.22.2.4 IS_TrackResetOnEntry

This variable is set to true if we should reset the toggle control when each frame loads.

6.10.22.3 SCO Display Settings

6.10.22.3.1 IS_FrameTitle_Display

Definitions and Terms

Sample Frame Title within IME Exported Frame

Possible choices for this variable are "section", "menu", and "frame".

Section: changes the frame title header bar only when navigating to a new section title. A section title is identified within
the Content tab by setting the Menu Title Font to either "section" or "segment".
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|:1n5|:rul:linn :l |: E—Referencej IZAssetzl |:5r.:ripl'_-

~| Frame Title: Endurance Performan|

Menu Title:

Menu Title Font:
segment

section

Sample Menu Title Font Drop down

Menu: changes the frame title header bar for each frame displaying the menu title.

Frame: changes the frame title header bar for each frame displaying the frame title.

6.10.22.3.2 IS_ClassificationBanner
This value displays the classification banners within the title bar and control bar. Set to “true” if the classification banner
should display.
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Background

* Evolution of the 408

= The evolution of the Pegasus is
similar to the evolution of other
mechanical devices

= The 408 we use today produces
almost three times the thrust of
the first Harrier engine

* Fallacy
= Hollywood Harrier
- "True Lies"
- Air shows
= Great public relations

Classification Banner Location

6.10.22.3.3 IS_ClassificationDefault

This variable sets the default text used for the classification banner. The classification value can also be changed per
frame via smart text. The “IS_ClassificationBanner” variable must be set to “true” in order to set the default banner text.

6.10.22.3.4 IS_Muliple_Resolution

If this variable is set to “true”, supports 1024 and 1280 resolutions. If false, default resolution will be 1024. The following
files are used to display the 1024 and 1280 resolution versions.

ctix_interface1024.css
ctix_interface1280.css
content1024.css
content1280.css
contentObj1024.css
contentObj1280.css
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6.10.22.3.5 IS_Exam

If this variable is set to “true”, the interface recognizes the SCO as a single exam SCO and does not present functionality
necessary for a lesson SCO.

6.10.22.3.6 IS_ShowAddlInfoOnLoad

If this variable is set to “true”, the Additional Information popup will automatically display on frame entry, matching the
behavior of the Warning, Caution, and Notes. If the variable is set to “false” the Additional Information popup is only
available from clicking the button within the control bar.

ADDITIONAL INFORMATION

Operational procedures for the five types of Vibration
Monitoring and Diagnostic Checks are similar. This lesson
will only cover the Cabin Signatures Health Check.

Additional Information Popup on Frame Entry

Additional Information Popup from Additional Information Button

6.10.22.3.7 IS_WcnMenu

If this variable is set to “true”, a popup menu will appear after the WCAN button is selected within the control bar when
more than 1 WCAN is added to the frame. If this value is set to “false”, all WCANS will display in sequential order when
the WCAN button is selected within the control bar.
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+ Warning
+ Note
4 Caution

Open all popups

WCAN Menu

6.10.22.4 Menu and Navigation

6.10.22.4.1 IS_StopMenuAtFrame

This variable stops the menu from displaying any frames after this title. If all frames are expected to show in menu, set
the value to "". Partial frame titles are not supported.

This setting is used to prevent the lesson tests from displaying within the menu.

For example, var IS_StopMenuAtFrame = “Conclusion”, will not display the Lesson Test frames that appear in IME after
the “Conclusion” frame.

Self-Check 11
Summary
Conclusion
Lesson Test 1
Lesson Test 2
Lesson Test 3
Lesson Test 4
Lesson Test 5
Lesson Test 6
Lesson Test 7
Lesson Test 8
Lesso

Lesson Test 10

Test Results
Sample IME Treeview
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. Oceanic Position Reports

. Post-Waypoint MARK

. Post-Waypoint Plot

. 30 Minutes Prior to ETP

. Flight Plan Changes and Diversions

. En Route Monitoring

. Deliberate Course Deviations

. Navigation Errors

. Navigation Malfunctions

. Avoiding Gross Navigation Errors
. ADIZ /FIR

. Landfall Procedures

. Post-Mission Considerations

. Aircraft Commander Responsibilities
. Pilot Flying Responsibilities

. Pilot Monitoring Responsibilities

. Crewmaster Responsibilities

. Self-Check 8

. Self-Check 9

. Self-Check 10

. Self-Check 11

. Summary

64. Conclusion

Sample Exported Menu Stopping at Conclusion

6.10.22.4.2 IS_UseArraysForNavigation

If this variable is set to “true”, the interface will use the aFramelD array to determine next / previous navigation. If this
value is set to “false”, the MAIN.nextPage and MAIN.prevPage are used. This value is typically set to “false” unless the
arrays are manipulated at runtime (i.e. AV-8B track navigation).

Note: If IS_ShowSkip is set to true, then the interface will override this value to “true”. In other words, if the show skip
feature is used in the SCO, then manual navigation cannot be set within IME.

6.10.22.5 IME Self-Check and End of SCO Test Values

6.10.22.5.1 IS_Question_Title

This value represents the frame title used to display end of lesson tests / quizzes. No menu titles should be entered in
IME for these frames.
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When entering a test frame, the next and back navigation is disabled and a feedback window is suppressed when the
“Submit” button is selected.

In this example, var IS_Question_Title = “Lesson Test”, the question is treated as an end of lesson graded question when
navigating to frame titled “Lesson Test”.

Note: This value can be a partial frame title. For example, ,var IS_Question_Title = “Lesson Test” would identify frames
titled “Lesson Test”, “Lesson Test 1”7, and “Lesson Test 2” as an end of lesson graded question frame.

Lesson Test

What is the dry corrected hover weight for the following conditions: RHOV = 2.5, RJPT = -25, OAT
= 35° C (408B engine)? Open the electronic reference to view the applicable chart.

A. 19,200 Ibs
B. 20,800 Ibs
C. 21,000 Ibs
D. 21,300 Ibs

Sample Graded Question

6.10.22.5.2 Remediation Count

This value represents the number of remediation tests within the SCO. Possible values are 0, 1, and 2.

6.10.22.5.3 IS_Remediation_Question_Title

This value represents the frame title used to display a single remediation end of SCO test / quiz. This value can be a
partial frame title. No menu titles should be entered in IME for these frames.

6.10.22.5.4 IS_Remediation_Question_Title_1
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This value represents the frame title used to display the first remediation end of SCO test / quiz. This value can be a
partial frame title. No menu titles should be entered in IME for these frames.

6.10.22.5.5 IS_Remediation_Question_Title_2

This value represents the frame title used to display the second remediation end of SCO test / quiz. This value can be a
partial frame title. No menu titles should be entered in IME for these frames.

6.10.22.5.6 IS _Test Results Title

This value represents the frame title used to display the test results page. This value can be a partial frame title. No
menu titles should be entered in IME for these frames.

In the below example, IS_Test_Results_Title = “Test Results”, and the auto generated Test Results is displayed when
navigating to the frame titled “Test Results”.

Note: The Test Results frame must appear immediately after the test within IME.

Test Results

Click a topic title to review the question

Score: 33 % Total Time: 00:00:47.85
Pass/Fail: incomplete

Performance Calculations Incorrect
Performance Calculations Incorrect
Definitions and Terms Correct

To complete this lesson you will need to take the
Remediation Test.

Re-ingestion Correct
JPT/ RPM Relationship Correct
Engine Mishandling Incorrect
Engine Mishandling Incorrect
High Descent Rates Incorrect
Engine Mishandling Incorrect

W W N s WN =

SELECT A QUESTION FOR REVIEW IF DESIRED. SELECT NEXT TO PROCEED TO THE REMEDIATION TEST

Sample Test Results Exported Frame

6.10.22.5.7 IS_Leaving_Test_Title

This value represents the frame title used to display when the student leaves the test.
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Note: If using a leaving test frame, the frame must appear right after the test within IME.

In this example, var IS_Leaving_Test_Title = “Leaving Progress Test”, displays the auto generated frame when navigating
to the frame titled “Leaving Progress Test”.

Systems

Leaving Progress Test

LEAVING PROGRESS TEST AREA

You may review your test answers before submitting. Once
you click "SUBMIT" you will receive your test results.

Are you ready to submit your final answers?

| REVIEW | SUBMIT

6.10.22.5.8 IS_Entering_Test_Title

This value represents the frame title used to display when the student enters the test.
Note: If using an entering test frame, the entering test frame must appear right before the test within IME.

In this example, var IS_Entering_Test_Title = “Entering Progress Check”, displays the auto generated frame when
navigating to the frame titled “Entering Progress Check”.
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Entering Progress Check

ENTERING PROGRESS CHECK AREA

This Progress Check will require you to respond to 16
questions. Once you begin, you should complete the entire
Progress Check before exiting the lesson.

A correct answer will bring up the next test item.

An incorrect response will take you to the lesson materials
supporting the test item. After you have reviewed the lesson
materials, select the Return button to return to the question.

Select the Forward button to enter the Progress Check. Select the Menu button to review the lesson.

Sample Entering Test Frame

6.10.22.5.9 IS_SelfCheck_Title

This value represents the frame title or menu title used to identify self-checks throughout the courseware. These are
guestions that would not be counted in the overall score for the SCO.

When entering a self-check frame, the next navigation is disabled and a feedback window will display immediately after
the student selects the “Submit” button. If a remediation frame was identified for the self-check in IME, a Review button
will be available within the feedback window.

In this example, var IS_SelfCheck_Title = “Self- Check”, the question is treated as a self-check question when navigating
to frame titled “Self-Check 1”.

Note: This value can be a partial frame or title. For example, , var IS_SelfCheck_Title = “Self- Check”, would identify
frames with menu or frames titled “Self-Check”, “Self-Check 1”, and “Self-Check 2” as a self-check question.
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Self-Check 1

What is the purpose of the ground evacuation emergency procedure?

A. Ensures safety of ground emergency crews

B. Prevents loss of equipment and cargo
C. Provides quick and safe aircraft evacuation

D. Reduces aircraft damage and down time

Sample Self-Check Incorrect Response
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Self-Check 1

What is the purpose of the ground evacuation emergency procedure?

A. Ensures safety of ground emergency crews

B. Prevents loss of equipment and cargo
C. Provides quick and safe aircraft evacuation

D. Reduces aircraft damage and down time

| Continue |

Sample Self-Check Correct Response

6.10.22.5.10 IS _Menu_Available_Testing

If this value is set to “true”, the menu button will be available during the test. This allows a student to review and re-take
the test if necessary.
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Lesson Test 1

S osson ik tin he purpose of the ground evacuation emergency procedure.
Lesson Objectives
ne urvival
. Purpose and Procedure
5. Ground Evacuation Emergency Signal in-critical steps in sequence
6. Prepare for Evacuation
. Evacuate Aircraft
8. Secure Aircraft After Evacuation
9. Self-Check 1 o
i ous conditions
. Self-Check 3
Self-Check 4 m

Summary

Menu Available During Testing

6.10.22.5.11 IS_Force_Remediation

If this value is set to “true”, any test question (this does not apply to self-check questions) will not move forward to the
next screen until it was correctly answered. A feedback form and a Review button will be presented to the student. This
setting will also submit a score of 100% for the SCO, which may not be ideal for reporting purposes.

Note: A remediation frame must be selected for each question frame within the IME Content Tab.
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Progress Check

What is the minimum restraining capacity, in pounds, of each deck tiedown fitting?
A. 5,000

B. 10,000
C. 3,450
D. 9,700

Force Remediation during Test

6.10.22.5.12 IS_Learning_Objectives_Title

This value represents the frame title used to identify the learning objectives frame. When using this feature, a COl lesson
must be linked to the SCO within the IME settings tab.

In this example, var IS_Learning_Objectives_Title = “Lesson Objectives”, displays the auto generated frame when
navigating to the frame titled “Lesson Objectives”.

Note: Partial titles are supported for this value. For example, 1S_Learning_Obijectives_Title = “Objectives”, would identify
frames with the title “Lesson Objectives” and “Objectives” as a learning objectives frame.
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Courseware Version: 7/16/2018

Terminal Objective

Perform basic level one flight duties onboard the MH-53E helicopter in accordance with applicable
publications.

Enabling Objectives
Upon completion of this lesson, you will be able to:

1. Identify the major components of the cargo compartment.
2. List the different cargo tiedown fittings.

3. List the components of the ramp and door system and their functions.
4. List the components of the cargo lighting system and their functions.

Sample Lesson Objectives Frame

6.10.22.5.13 IS_Objectives_ Summary_Title

This value represents the frame title used to identify the learning objectives summary frame. When using this feature, a
COl lesson must be linked to the SCO within the IME settings tab.

Note: Partial titles are supported for this value. For example, IS_Objectives_Summary = “Summary” would identify
frames with the title “Lesson Summary” and “Summary” as a learning objectives summary frame.

6.10.22.5.14  IS_ShowSkipFlag

Setting this value to “true” will display a menu above the frame navigation that will allow a user to skip or mark a
guestion while taking a test.

» P %K

Skip Question / Mark Question
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6.10.22.6 SCORM / xAPI (MELD LMS)

6.10.22.6.1 IS_Scorm_Version

This value sets the SCORM version used when running within a SCORM LMS. In most cases, this version will be left at
2004. Values include “1.2” and “2004”.

This value is not present within the xAPI sample interfaces. The xAPI sample interfaces will support SCORM 2004 if
uploaded to a SCORM LMS or xAPI if uploaded to MELD LMS.

6.10.22.6.2 IS_CompleteAtLaunch

Setting this value to “true”, will automatically set the SCO to complete at launch. This value is used for MCALMS SCORM
1.2 proctored lessons to support the instructor submitting student attendance. If not using MCALMS proctored testing,
the recommended setting for this value is “false”.

6.10.22.6.3 IS_Submitlnteractions

Setting this value to “true”, will submit interaction data to the SCORM LMS or MELD LMS for all graded questions. The
interaction data passed to the LMS include question type, correct answer, student response, and result: correct /
incorrect.

The ability to pull question analysis data is the responsibility of the LMS.

6.10.22.6.4 IS_UseGUID

This value represents the first 8 digits for an interaction id used to pass interaction data to the LMS. This value is
required for MCALMS proctored testing. Leave the value blank if not using MCALMS proctored testing.

This value is not present within the xAPI sample interfaces.

6.10.22.6.5 IS_MCALMS_Reference

If this value is set to “true” and a SCORM LMS is detected, any menu links within the e-reference menu will open the
MCALMS reference center. If the setting IS_CoDE_References is set to “false”, then the reference button within the
control bar will launch the MCALMS Reference Center.

This value is not present within the xAPI sample interfaces.
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Aircraft Survival Kit

REFERENCE CENTER Topic: [AV-8B Pilot Training v
Reforoners Keywords: | | [AlWords /] [ Search |

References are industry-specific files of various media, which includes articles, surveys, and
reports. To search for content, complete the search criteria, then click Search. From the
resulting list of References, click the information icon for details or click the title to view the

content in a new window.

2 records found.

@ NATOPS General Flight and Operating Instructions

@ Naval Aviation Technical Information Publications

(NATIP)

https://secure.mcalms.com/kc/library/references_srch.asp

MCALMS Reference Center

6.10.22.6.6 IS_Commenting

If this value is set to “true” and a SCORM LMS is detected, the comments button will display a standard commenting
form. This value is not present within the xAPI sample interfaces.

When reviewing within MELD Online Review, the comment button will display a CMATT change request form.

MCALMS does not support this standard commenting form. SHARP and other LMS projects should use this setting.

The ability to pull comment data is the responsibility of the LMS.
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Lesson

Courseware Version: 8/22/2017

Without t{/E submit Dscrepancy “Tnternet Explorer B viedge of the
primary
Enabling j Discrepancy:

Frame #: 1>Lesson Objectives>

6.10.22.6.7 IS_MCALMS_Commenting

If this value is set to “true” and a SCORM LMS is detected, the comment button within the control bar will open a
MCALMS commenting form. This allows students and instructors an opportunity to submit change requests for the
courseware. The comments are then pulled from MCALMS and sent to the project’s production manager.

When reviewing within MELD Online Review, the comment button will display a CMATT change request form.

Only use this setting if the courseware will be running with MCALMS.

This value is not present within the xAPl sample interfaces.
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XML Comment Manager Cancel & Return to Course/Test
Add New Comment

Directions

The "Add New Comment" form is displayed below. The XML Comment Manager
automatically inserts the "Lesson/Test Title", "Frame Title", and "Comment Initiator Name".
To create a new comment, enter the "Comment Title" and "Body" text for the new comment.
To cancel adding a new comment, simply select the "Cancel & Return to Course/Test" link
above or the "Cancel Comment" button below.

(o 111~ I (oo i [ -l A\/-8B Survival Equipment
(02301 VA 0 L H AV-8B Survival Equipment
Frame Title: Conclusion - Frame #: 24
L e ~vEightB Uploadacct
t Titl
I

e: |

Com
Com

men
men

Safety Related O

MCALMS Comment Button

6.10.22.6.8 IS_LastFrame_Complete

Setting this value to “true” and when a SCORM LMS or MELD LMS is detected, visiting the last frame marks the lesson as
completed. A score of 100% will be submitted.

Note: This setting must be set to “false” for SCOs that will contain a graded test. This setting is used for instructor-led
SCOs or self-paced SCOs that do not contain a graded test to allow bookmarking until the lecture is complete.

6.10.22.6.9 IS ICW_NoTest FrameTitle

This value represents the frame title of the LAST frame in a self-paced SCO when a test IS NOT present. This ensures a
score of 100% is sent to the LMS for this frame, and that the SCO does not remain in an incomplete status once
complete. This allows the same interface to be used for SCOs containing graded tests and those that do not. Partial
frame titles are not supported.
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6.10.22.6.10 IS_RedirectFullScreen

Setting this value to “true” will support loading a new window in full screen mode. This setting is not recommended for
the SHARP LMS since it already supports full screen viewing.

This value is not present within the xAPIl sample interfaces.

6.10.22.6.11 IS_ShowFullScreenPressLabel

Setting this value to “true” shows the yellow label "Press F11 to view in FULL SCREEN mode" within the title bar while
running within an LMS. The label will disappear once the student selects the F11 key.

This value is not present within the xAPI sample interfaces.

FLIGHT ESSENTIA :

F11 View Full Screen Label

6.10.22.6.12 IS_SubmitSelfChecklInteractions

Setting this value to “true” will submit interaction data to the MELD LMS for self-check questions.
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This value is only present within the xAPI interfaces.

6.10.22.6.13 IS_Generate_ Random_Test Default

Setting this value to “true” will present a random test any time the end of lesson test is taken unless taken within IME or
Online Review. The instructor does have the capability to override this value from the MELD LMS for monitored
curriculum packages.

This value is only present within the xAPI sample interfaces.

6.10.22.6.14 IS_AllowOfflinelnteractions

Setting this value to “true” will display a “Save” button within the interface while the lesson is taken offline. This will
allow a user to save their interaction data (notes, comments, and test questions) to a file that can be later uploaded to
the MELD LMS.

This value is only present within the xAPI sample interfaces.

6.10.22.7 Media

6.10.22.7.1 IS_HyperText_Default

This setting, when Smart Text is used, represents the default color for hypertext.

For example, setting var IS_HyperText_Default="#ffff00” will display all hyperlinks in yellow.
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Servicing Steps

Check oil level in oil tanks as follows:
. Gain access to oil tank
. Check oil level on sight gauge

. If oil level is above ADD OIL mark, no further
maintenance is required. If oil level is at or below
ADD OIL mark, add more oil

Fill oil tank as follows:
4. Remove filler cap from oil tank

5. Using a suitable replenishment device, add
engine oil until level on sight gauge is at FULL
mark

6. Install filler cap on oil tank. Ensure lock is fully
engaged.

Select each hypertext item to learn more.

Hyperlinks

6.10.22.7.2 IS _HyperText_Visited

This setting, when Smart Text is used, represents the default color for visited hyperlinks. A visited hyperlink includes any
hyperlinks that have been clicked or moused over.

For example, setting var IS_HyperText_Visited= "#000000" will display all visited links in black. In this example the first
two hyperlinks have been visited.
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Servicing Steps

Check oil level in oil tanks as follows:

3. If oil level is above ADD OIL mark, no further
maintenance is required. If oil level is at or below
ADD OIL mark, add more oil

Fill oil tank as follows:
4. Remove filler cap from oil tank

5. Using a suitable replenishment device, add
engine oil until level on sight gauge is at FULL
mark

6. Install filler cap on oil tank. Ensure lock is fully
engaged.

Select each hypertext item to learn more.

Visited Hyperlinks

6.10.22.7.3 IS_EnableNextHyperlinks

This value, when set to “true” and when Smart Text is used, enables navigation after all hyperlinks have been visited on
the frame. A visited hyperlink includes any hyperlinks that have been clicked or moused over.

A frame would benefit from this setting if navigation was initially disabled on frame entry.

As you can see in the previous examples, the next button is disabled. In the example below, all hyperlinks have been
visited and you can see the navigation is now enabled.
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Servicing Steps

Check oil level in oil tanks as follows:

Select each hypertext item to learn more.

Navigation Enabled

7 Walk-through Sample IME Interface (Merged Guide)

The sample merged guide that is available uses the interface “Sample_Merged_Guide”. This interface can be copied and
modified as desired to support project functionality.

The main_guide.htm, main_item.htm, main_toc.htm, main_toc_item.htm, and main_tof_item.htm contain the coding to
build the final merged guide SCO.

7.1 Main_guide.htm
The main_guide.htm contains the main assembling code for the guide. The <REPLACE WITH MAIN ITEM> placeholder
will replace with the coding for each guide selected for this merged guide SCO.

An example main_guide.htm is shown below.
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K!DOCTYPE html>
Fhtml>
kscript>
window.onload = function() {
hidePreloader() ;
if(!'window.location.hash) {
window.location = window.location + "floaded';
window.location.reload() ;
} else {
if (top.parent.comment_area != null) {
//MELD detected
top.parent.CFrame (S<REPLACE WITH FRAME ID>) ;

function showPreloader () {
document .getElementById('preloader"') .style.display = "";
1
function hidePreloader() {
document .getElementById('preloader') .style.display = "n

H

function showContents (frameCbject, divName) {

var HTMLLoc = frameObject.contentDocument.location.toString();
HTMLLoc = HTMLLoc.replace (/igs\/ig\.htm/gi,"m=dia");
HTMILoc = HTMLLoc.replace (/igs\/=sg\.htm/gi, "media") ;

document.getElementById (divName) . innerHTML = frameCbject.contentDocument.body.innerHTML.replace (/\..\/media/gi, HTMLLoc) ;

var divFigures = frameCbject.contentDocument.getElementById (" £1
var divTitle =
//append to master figures div

if (divFigures && divTitle) {

var divFigName = divName.replace("D","FIG") ;

var divMasterFigures = document.getElementById(divFigName) ;

if (divMasterFigures) {

if (divFigures.innerText != "") {
divMasterFigures.innerHTML = '<div class=f >' + divTitle.innerHTML + '</div>' + divFigures.innerHTML;
} else { divMasterFigures.style.display = ""; }
}
}
i
l</script>

klink rel="stylesheet"” href=”interface/merged_igs.css” type="text/css">
<div class="modal" id="preloader" style="display:none">
<div class="center" >
<img src="media/loader.gif" />
</div>
</div>
kscript>
EhowPreloadex () ;
l</script>
FEEPLACE WITH MATN ITEM>
</html>

Sample main_guide.htm

7.2 Main_toc.htm

The main_guide.htm contains all the front matter for the guide and the tables to store the table of contents and table of
figures. The placeholders “<REPLACE WITH TOC ITEM>" and “<REPLACE WITH TOF ITEM>" will be replaced with the table
of contents and table of figures items.

An example main_toc.htm is shown below.
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<table class="report-container">

<tbody class="report-content">

<tr>
<td class="report-content-cell" align= >
<h5 align= >SAMPLE MERGED GUIDE</hS>
<hl align= ><u><REPLACE WITH MASTER GUIDE TITLE></u></hl>
<img arc=”mediafsample_;ogo.jpg”}
<h5 align= >Prepared For<br>

MELD SUPPORT<br>
Prepared On <script®» document.write (mnew Date () .toLocaleDateString()); </script>
</h5>

</td>

</tr>

</tbody>
</table>
<table class="report-container" align= >

<tbody class="report-content">

<tr>
<td class="report-content-cell" align= ><a name="TOC"></a>
“div 1d="toc container">

<p claszs="toc title">Table of Contents</p>
<REFLACE WITH TCOC ITEM>
</div>
</td>
< tr>
</thody>
</table>
<table class="report-container" align= >
<tbody class="report-content">
<tr>
<td clas=="report-content-cell" align= ><a name="TOF"></a>
<div id="toc container">
<p class="toc title">Table of Figures</p>
<REFPLACE WITH TCF ITEM>
</div>
</td>
</ tr>
</tbody>
</table>

Sample main_toc.htm

7.3 Main_toc_item.htm

The main_toc_item.htm is used to generate the table of contents for each individual guide within the merged guide
document.

An example main_toc_item.htm is shown below.

'{a href="#A<KREPLACE WITH CURRICULUM ID>" <REPLACE WITH STYLE>>» <REPLACE WITH GUIDE TITLE> </a><br>
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Sample main_toc_item.htm

7.4 Main_tof _item.htm

The main_tof _item.htm is used to generate the table of figures for each individual guide within the merged guide

document.

An example main_tof_item.htm is shown below.

<div id="FIG<REPLACE WITH CURRICULUM ID>"> </div>

Sample main_toc_item.htm

7.5 Main_item.htm

The main_item.htm is used to create the headers and footers and inserts for each individual guide making up the

merged guide document.

An example main_item.htm is shown below.

<table class="report-container">
<thead class="report-header">
<tr>
<th class="report-header-cell">
<div class="header-info">

()); </script> </div>
</div>
</th>
</tr>
</thead>
<tfoot class="report-footer">
<tr>
<td claszs="report-footer-cell">
</td>
</tr>

</tfoot>
<tbody class="report-content">
<tr>
<td class="report—content-cell">

</td>
</tr>
</tbody>
</table>

<REPLACE WITH MASTER GUIDE TITLE><br>
<REPLACE WITH GUIDE TITLE> <div class= ><script> document.write (mew Date () .toLocaleDateString

<a name="ALREPLACE WITH CURRICULUM ID>"></a><div 1d="D<REPLACE WITH CURRICULUM ID>"></div>

<iframe i1d="F<REPLACE WITH CURRICULUM ID>" src="<REPLACE WITH PATH TO GUIDE>" cnload=
"showContents (this, 'DELREPLACE WITH CURRICULUM ID>') ;"»></iframe>

Sample main_toc_item.htm

Name

Description
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<REPLACE WITH MASTER GUIDE TITLE> This text will be replaced with the SCO Title for the merged guide SCO.

<REPLACE WITH GUIDE TITLE> This text will be replaced with the title entered for the individual guide
within the Merge Guides tab. If a title was not entered within the
Merge Guides tab then the title for the selected SCO is used.

<REPLACE WITH PATH TO GUIDE> This text will be replaced with the relative path to the individual guide
from the merged guides SCO.

8 Organization of SCO Source Material

8.1 General Guidelines

Asset organization does not mean simply creating more folders.

Asset folders must be named to match the frame asset identically.

There must be a source file present for each and every linked asset in a SCO.

Primary assets should not be sorted into folders by file type.

Use of primary assets sharing instances over multiple SCOs is prohibited.

Secondary assets must be saved within the same asset folder as the primary asset.

SCO level assets can be sorted into folders by file type.

Standards for naming project level assets may be determined by the project team.
Reference materials can be saved in the SCO folder structure, but it is not required.
Additional folder structure can be created within the described folder structure as needed.

8.2 Assets and Organization

Data storage must be organized in a way that is logical and efficient. Development of production materials must be
performed with future revision and maintenance in mind. This protects both the maintainer’s investment and the
customer’s.

8.2.1 Hierarchy of assets

Source files created for courseware development represent a huge investment of time and labor. In describing the
organization of file structure, we first need to establish a vocabulary for talking about a thing that is often taken for
granted. It is simplest to look at the issue from the perspective of a newly hired artist coming to work. How would we
make sure that a new employee had access to everything needed to edit courseware assets? Looking at the problem this
way outlines a rough hierarchy of production assets. Numbered below are five basic classes of assets from highest
importance, from the perspective of editing courseware, to lowest.

1. Primary Assets refer to assets and associated source files which are physically linked into courseware frames.

2. Secondary Assets refer to companion files used expressly to create unique frame assets linked into courseware,
such as bitmaps rendered from 3ds Max files, or simple .png files imported into Animate frames.

3. SCO (Lesson) Level Assets are raw files (digital photos, videos, max files) used for production over an entire SCO.

4. Project Level Assets are raw files, typically stored in media libraries (digital photos, videos, max models), that
are used for multiple SCOs within a project.
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5. Reference Materials refer to files such as PowerPoints, Word documents, and other non-graphical sources used
to map out courseware frame asset production.

The diagram below shows the relationship between assets in the hierarchy.

Lesson Level
Assets

AR seREsEsAzersssssssresssasssersansanraannnny .

Courseware

Frames
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8.2.2 Primary Assets

Most important to production are the assets and associated source files that are directly linked into the courseware
frames themselves. Under each designated SCO folder, a folder titled “Source” will be added to house the source asset
folders. Linked assets, their source files, and source asset folders will share identical naming conventions. Asset folders
housed in the “Source” folder should not be sorted out by file type.

[ ST
- o — - - -
@uv| . @ Courseware_Development » Scurce_Data » fam » 2m0d » Source » v|¢¢| Search Source ,D'
Organize * Burn Mew folder -+ Ol i@l
-0 Favorites ? 2m044404 ﬁL 2m044408
BE Desktop E File folder X File folder e
4 Downloads =
:_-J Recent Places 'iL‘ 2m044411 L:l: 2m44413
1 File folder t File folder
.~ Libraries
j it 2m044414 \L.. 2mi44419
s Documents f,: File folder !‘ File folder
,J". Music ' J
| Pictures ‘L 2m044421 ‘L 2m044422
B videos ! File folder [ File folder
- - e - [ PAAATA . Ne_NAAANS e
30 items Offline status: Online
I Offline availability: Mot available
k. - Ll rE_____________ _ _ = — _m

Primary Assets

If it is desirable to re-use a frame asset in multiple SCOs, whatever the process of doing so, it must include copying and
renaming the source asset from one SCO source directory to another. It is required there be a source file present for
each and every linked asset in a SCO, with appropriate naming convention applied. All frame-linked assets will be named
using the conventions described in the next section Asset File Naming Conventions.
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8.2.3 Secondary Assets

In addition to linked assets, there may be any number of renders, photos, or video clips used to produce those
completed assets. These companion files effectively become secondary assets. It is not a requirement that these
secondary assets share the standard asset ID naming convention. It is, however, recommended that media used
exclusively in the manufacture of a unique courseware frame asset, share that asset tag with a numerical addendum
(i.e., assetTag -01, assetTag -02) to differentiate primary from secondary asset. The example below shows this
convention. In this case, the Animate file is the primary asset.

¢ oo bge -
@U?| . # Courseware_Development » Source_Data » fam » 2m0d » Source » 2m044411
Organize - Burn Mew folder

- Favorites *  Mame Date modified
Bl Desktop TH 2m044411 13 4/8/2016 1:59 PM
4 Downloads = ¥ 2m044411-1.png 4/8/2016 1:54 PM
| Recent Places * 2m044411-1.psd 4/8/2016 1:54 PM
#- 2m044411-2.png 4/8/2016 1:57 PM
ol Libraries e 2mD44411-2.psd 4/8/2016 1:57 PM

Secondary Assets

Companion files to a primary asset should be stored within the asset folders under “Source”. Use of asset tags in
association with files like these will make locating all of the source material used in the creation of an asset easily
identifiable.

8.2.4 SCO (Lesson) Level Assets

A folder may be created at the SCO level to house files that are used in the production of multiple SCO frame assets. It is
important to differentiate between these and secondary assets. SCO level organization should be reserved for 3ds Max
or raw video files that are large enough that saving multiple copies becomes too draining to network resources. These
folders can be named and organized according to file type or other obvious division.

@l\._,/”?' . % Courseware_Development » Source_Data » fam » 2m04 »

Organize = Burn Mew folder

J" Music i MName
k=| Pictures

E Videos

. Graphic_References
. MAX Files
. Source

M Computer e
, Media

&L, Local Disk (C:)

SCO Level Assets
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8.2.5 Reference Materials

Reference materials provided by SMEs or other parties that are used as instructions for the production of frame assets
can be saved in the SCO folder structure, but it is not required. Due to the ever evolving nature of R&M production, it is
not critical that these types of materials be saved directly within the SCO folder structure.

@-uﬂﬂ €« Courseware_Development » Source Data » fam » 2m04 »

Organize = Burn Mew folder
‘. Music i MName
| Pictures
- ] Graphic_References
H videos .
PAK Files
) Source
‘M Computer e
. edia
= Local Disk (C:)

Reference Materials

Reference files are rarely regarded as customer deliverables and, once used to create an asset, become obsolete the
moment that asset is modified. Separating these files from the actual graphical assets they are associated with allows
cross-discipline data sharing without creating additional opportunities for human error (i.e., accidental deletion of assets
or folders). A reference folder can be created to house this material wherever it is most convenient for a production
team. The production team may determine for themselves the value placed upon this material as a record of origin for
an asset.

8.2.6 Media Folder

The media folder is the location to store all finished assets that are ready to post to the revised frame within IME. A
media folder is required for a closed file system within IME. Projects using an open file system can choose not to include
a media folder within their source location. All files within the media folder and source folder should follow the same
naming conventions that will allow any member of production to identify what source and finished files belong together.

@-uﬂﬂ €« Courseware_Development » Source Data » fam » 2m04 »

Organize = Burn Mew folder

@ Music a Mame
k=| Pictures

E Videos

Graphic_References
MAX Files
Source

‘M Computer —
edia

&L, Local Disk (C2)

Finished Asset Location
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8.2.7 Project Level Assets

Obviously, asset naming standards need not be applied to raw materials used to create courseware at the project level.
This might include 3ds Max models, raw digital photos, or lengthy videos which are stored in digital libraries for the
overall project. Standards for naming project level assets may be determined by the project team.

It is recommended that file naming for project level assets be as detailed as possible. An effort should be made to
handle these files in an organized way that makes it easy to maintain path configuration for Max files as well as search
ability. Location consolidation is recommended where possible but must be determined by availability of storage
resources.

» Computer » Photo_Repository »
Organize = Mew folder
=1 Recent Places T MName ’ Date modified Type
AV-8B 4/13/2016 7:11 AM File folder
o Libraries | -
EA-GE 1/22/201 ! f
#| Documents . R —_—
: . - KC-130J 1/22/2016 8:33 PM File folder
@' Music
b= Pictures
E Videos

Project Level Assets

8.2.8 Additional Folders

Additional folders are permissible within the folder structure described by this document. Within a SCO level folder like
the MAX Files folder, any number of folders may be used to sort out files and organize resources. Reference materials
for a SCO may be sorted into folders by asset tag (in the case of new production, this is highly recommended). Additional
folders are also permissible within individual asset folders, but should be limited to an as-needed basis.

8.2.9 Storage Resources

Compromises to file organization should not be made without first seeking additional storage resources.

8.2.10 Compromise

It is understood that the organization of materials described in this section is not the only way possible to do business.
Efforts to standardize production and organization across sites and projects are difficult and require effort on the part of
every team member. The benefits of making that effort, however, are immeasurable.

The purpose for these recommendations is to create a standardized structure across platforms which will give personnel
maximum access to resources by making the location of those resources predictable. Less time will be wasted due to
maintainers trying to navigate an unfamiliar environment. Frustration will be avoided and communication made clearer.
This increased efficiency benefits everyone.
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8.3 Asset File Naming Conventions

Asset naming conventions are among the most important guidelines one must address in the process of increasing
efficiency in courseware production across multiple teams and projects. In the interest of maintaining a consistent
naming process for creating files across projects, specific file naming conventions must be observed by every graphic
artist. Any creation of new courseware graphic files, or conversion of existing graphic files into new graphic files that are
added to courseware frames, must use the conventions described in this section. Adhering to the conventions described
in this section will make maintenance of courseware assets a simpler and more organized process for both onsite and
offsite personnel.

During the course of graphics production and maintenance, a courseware frame and associated assets may be revisited
numerous times by various personnel and disciplines. In order to ensure predictable results throughout this process, it is
necessary to ensure that modifying a frame asset only affects the desired frame of courseware. Therefore, the use of a
unique asset on each courseware frame is a requirement. The use of multiple instances of an asset in multiple frames of
a SCO is only recommended if the asset is clearly tagged as a shared file. See the section Shared Assets for specific
guidance on the use of shared graphics files.

8.3.1 General Guidelines

e Standard file naming conventions must be applied to any graphic that is added to a frame within IME.

e Each graphic used within a courseware frame must be unique to that SCO frame alone, unless specifically tagged
as a shared asset.

e When naming unique graphic assets linked to courseware frames, file names must use the asset tag generated

by IME in conjunction with a SCO identifier.

Spaces in graphic file names are not permissible, but may be replaced with underscores.

Additional layers of identifiers in file names must be applied only as needed.

Shared assets must be named using a SCO identifier in conjunction with the shared asset identifier.

Use of asset instances shared across multiple SCOs is prohibited without exception.

The shared asset identifier must be used only when necessary.

These standards must be applied to both media assets and the associated source assets.

8.3.2 Description of Naming Convention

IME assigns a unique Asset Tag identifier to each IME frame. The Asset Tag is located in the IME footer, as seen in the
below image. The standardized file naming convention for all projects will use a SCO identifier in conjunction with the
Asset Tag. For example, the asset filename for the graphic linked to the IME frame in the reference image is
“C1_01_06_175816.jpg”. In this instance, C1_01_06 is the SCO ID. The number 175816 is the Asset Tag generated by
IME.



MELD Administrator Guide 3.1

August 1, 2021

Filename Template Object Object Name 3

Ci_01_06 175816 jpg Primary Asset GRAPHICH

Open in new window

ID: 175816 Back:
Sequence: 15 Asset Tag: 175816 Next:

Asset Tag
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8.3.2.1 Spaces in File names

No spaces should appear in any asset file name associated with an asset used within the courseware. In any case where
a space is required, an underscore will be permissible. For instance, in our previous example, if a shared asset were used
on the frame, the asset ID would become “C1_01_06_shared” with the underscore replacing the space between
identifiers. The use of an additional layer of identifiers is only necessary in a case where the SCO and frame identifiers
are not sufficient to achieve a unique asset identity. Layers of identifiers should be kept to a minimum.

8.3.2.2 Shared Assets

In some instances, a single asset may be used over the course of multiple frames within a SCO. Transition graphics, for
instance, may be re-used on multiple frames. In these instances, it is permissible to use shared assets. As shared assets
are shared across multiple frames within a SCO and are not created for a specific frame, they will have their own unique
identifiers.

Assets that are shared across multiple frames in a single SCO will use the standard SCO ID, but will add the suffix

“ shared” in place of using the Asset Tag. So, taken from the previous example, a shared asset in this SCO would be
titled “C1_01_06_shared”. If multiple shared assets are used within a SCO, a numeric identifier may be used between
the SCO ID and the shared asset identifier.

One example of this would be titling shared assets in numeric order, in which case each additional shared asset could be
named using 01, 02, etc. For example, “C1_01_06_001_shared”. Please note, however, that the numeric identifier is not
required to progress in a particular order. The numeric ID could thus be used as a serial number if maintaining a record
of shared assets across a project were desirable.

Use of the shared asset suffix will clearly identify an asset as affecting multiple frames in a SCO to anyone, onsite or
offsite, who needs to modify the file. If there is any doubt about whether changing multiple frames in a single instance is
desirable, a GA will know that the question needs to be asked. There will be no limit on how many shared assets are
permissible within a single SCO, but this identifier should only be used when clearly appropriate.

8.3.2.3 Application of Standards

The standards described are for both the final export of the assets that are added directly into courseware frames and
the asset source graphics that are associated with these files. Final exports would include files such as .jpgs, .pngs, .htm,
or .wmvs which physically appear in the actual courseware. Source files would include .psds, .flas, or .mpegs that would
comprise the source of the SCO content.

Obviously, these standards need not be applied to raw materials used to create courseware. This might include 3ds Max
models, raw digital photos, or lengthy videos which are broken down into multiple pieces to create video segments.

Itis, however, recommended that media used exclusively in the manufacture of a unique courseware frame asset share
that asset ID. 3ds Max animations often fall into this category. Use of asset IDs in association with files like these will
make locating all of the source material used in the creation of an asset easily identifiable.



